Compaq Visual Fortran
Installing and Getting Started

Order Number: AA-R2PYF-TH

August 2001

This guide describes how to install Compaq Visual Fortran (formerly DIGITAL Visual Fortran), provides overview information about it, and shows how to use it with the Microsoft Visual C++ development environment (also known as Microsoft Developer Studio).

Revision/Update Information: This revised document supersedes the Version 6.5 Compaq Visual Fortran Installing and Getting Started.


Software Version: Compaq Visual Fortran Version 6.6 (or subsequent minor releases), all editions

Compaq Computer Corporation
Contents

Read Me First ix

Chapter 1 Summary of Visual Fortran Software Components and Packaging 1-1
  1.1 Visual Fortran Software Components ........................................................... 1-1
  1.1.1 Components in All Three Editions ............................................................ 1-1
  1.1.2 Additional Components in the Professional and Enterprise Editions .......... 1-2
  1.1.3 Additional Components in the Enterprise Edition .................................... 1-3
  1.1.4 Components in Table Format ...................................................................... 1-3
  1.2 Visual Fortran Packaging ................................................................................ 1-4
    1.2.1 CD–ROMs for Standard Edition ................................................................. 1-4
    1.2.2 CD–ROMs for Professional Edition ............................................................ 1-5
    1.2.3 CD–ROMs for Enterprise Edition ................................................................. 1-5

Chapter 2 Prerequisites for Installing Visual Fortran 2-1
  2.1 System Requirements for the Three Editions ............................................. 2-1
  2.2 Release Notes ................................................................................................. 2-3
  2.3 Registration Number ...................................................................................... 2-3
  2.4 Optional Software .......................................................................................... 2-4
  2.5 Considerations for Installing with Visual Studio Products ......................... 2-4
  2.6 Considerations for Installing with Visual Fortran Version 5 ....................... 2-6
  2.7 Considerations for Installing with Visual Fortran Version 6.0, 6.1, or 6.5 .... 2-6
  2.8 Multiple-User License Considerations .......................................................... 2-7
  2.9 Concurrent-Use License Considerations ...................................................... 2-8

Chapter 3 How to Install Visual Fortran 3-1
  3.1 Starting the Installation .................................................................................. 3-1
  3.2 Activating the Visual Fortran Master Setup Window ..................................... 3-2
  3.3 Using the Visual Fortran Master Setup Window .......................................... 3-3
  3.4 Installing Visual Fortran ................................................................................. 3-4
    3.4.1 How to Display the Setup Install Type Dialog Box .................................... 3-4
    3.4.2 Specifying Installation Options and Destination Directories .................. 3-6
    3.4.3 Installing Service Pack 3 (Windows NT Systems Only) ......................... 3-9
    3.4.4 Installing Internet Explorer ...................................................................... 3-10
  3.5 Installing Array Viewer (Standard Edition) .................................................. 3-10
  3.6 Installing Array Visualizer (Professional and Enterprise Editions) .......... 3-12
  3.7 Installing Enterprise Toolkit and TPE Components (Enterprise Edition) .... 3-14
  3.8 Registering Visual Fortran With Compaq ...................................................... 3-15
  3.9 Running Visual Fortran All or Partially from CD–ROM ............................... 3-15
  3.10 Visual Fortran Program Folder Contents .................................................... 3-16
    3.10.1 Array Visualizer Program Folder Contents ........................................... 3-18
  3.11 After Installation: Must-Do Task ................................................................. 3-18

Chapter 4 Postinstallation Tasks 4-1
  4.1 Applying the Visual Fortran Per-User Setup Option ...................................... 4-1
Chapter 7  Product Highlights  7-1
7.1 Using the Sample Programs ........................................... 7-1
7.2 Compaq Fortran Language .............................................. 7-3
7.3 Using the Command-Line Interface .................................... 7-4
7.4 Using Compaq Extended Math Library (CXML) ....................... 7-4
7.5 Mixed-Language Programming Support with Visual C++ and Visual Basic . 7-6
7.6 Viewing Online Documentation in the HTML Help Viewer .......... 7-7
7.7 Using the Array Visualizer ............................................. 7-7
7.7.1 Array Viewer ........................................................ 7-8
7.7.2 Aview Routines Library ............................................ 7-8
7.7.3 Avis2D and AvisGrid ActiveX (OCX) Controls ................. 7-9
7.7.4 Enhancements to the Visual Development Environment ........... 7-9
7.7.5 Array Visualizer Samples ........................................ 7-9
7.7.6 Installing Array Visualizer ...................................... 7-9
7.7.7 Starting Array Viewer ............................................ 7-9
7.7.8 Information about Array Visualizer ............................ 7-9
7.8 Using the IMSL Libraries (Professional and Enterprise Editions) . . 7-10
7.9 Using 190SQL-lite ....................................................... 7-11
7.10 Using Enterprise Toolkit and Technical Programming Extensions (Enterprise Edition) . 7-12
7.11 Support for COM and Automation Objects: Fortran Module Wizard ...... 7-12
7.12 Support for Creating COM Servers (Professional and Enterprise Editions) 7-13
7.13 Interface Definitions for Routines ................................... 7-13
7.13.1 Visual Fortran and Array Visualizer Library Routines .......... 7-13
7.13.2 CXML and IMSL Routines ....................................... 7-14
7.13.3 Win32 Platform SDK Routines .................................. 7-14

Chapter 8  Documentation Road Map: Where to Find What You Need  8-1
8.1 Printed (Hardcopy) Documentation .................................... 8-1
8.1.1 Compaq Fortran Online Bookstore ................................ 8-2
8.2 Documentation Available in HTML Help Viewer Format .......... 8-2
8.2.1 Programmer's Guide .............................................. 8-3
8.2.2 Language Reference ............................................. 8-4
8.2.3 Error Messages ................................................. 8-5
8.2.5 Compaq Array Visualizer Documentation ........................ 8-5
8.2.6 Platform SDK and SDK Documentation ........................ 8-5
8.2.7 Additional HTML Help for the Enterprise Edition ............. 8-5
8.3 Documentation Available in HTML Format .......................... 8-6
8.4 Documentation Available in PDF Format ............................ 8-6
8.4.1 Viewing PDF Files ............................................. 8-7
8.4.2 Location of Installing and Getting Started PDF File .......... 8-7
8.4.3 Location of CXML PDF File .................................... 8-7
8.4.4 Location of IMSL PDF Files .................................... 8-7
8.4.5 Location of FLEXlm PDF File .................................. 8-8
Figures

3-1 Compaq Visual Fortran Master Setup Window .......................................................... 3-3
3-2 Setup Install Type Dialog Box (Visual Fortran) ........................................................ 3-5
3-3 Select Folder Dialog Box ....................................................................................... 3-8
3-4 Setup Install Type Dialog Box (Array Visualizer) ..................................................... 3-13
5-1 LMTOOLS Initial Window ....................................................................................... 5-4
5-2 Configure Services Tab in LMTOOLS ..................................................................... 5-5
5-3 FLEXim License Finder Dialog Box ......................................................................... 5-6
6-1 Visual Development Environment Window ............................................................ 6-5
6-2 Setting the Initial Breakpoint in the Debugger ....................................................... 6-10
6-3 Starting the Debugger ........................................................................................... 6-10
6-4 Using Step Over in the Debugger .......................................................................... 6-11
6-5 Viewing the Value of a Variable in the Debugger .................................................... 6-12
6-6 New Project Type Dialog Box ................................................................................. 6-13
7-1 Compaq Array Viewer Window .............................................................................. 7-8
9-1 HTML Help Viewer ................................................................................................. 9-2
9-2 HTML Help Viewer Toolbar .................................................................................. 9-2
9-3 HTML Help Viewer Window with Contents Displayed ............................................. 9-4
11-1 VF Reporter User Information Dialog Box ............................................................. 11-2
## Tables

1-1 Components of the Visual Fortran Editions .......................... 1-3  
3-1 Visual Fortran Installation Components and Subcomponents .................. 3-6  
6-1 Visual Fortran Main Project Types .................................. 6-4  
6-2 Additional Features of the Debugger .................................. 6-12  
7-1 Location of Visual Fortran Sample Programs .......................... 7-2  
7-2 IMSL Libraries Provided by the Professional and Enterprise Editions .......................... 7-10  
8-1 Where to Find Information About Particular Topics .................. 8-9  
9-1 Buttons in the HTML Help Viewer Toolbar .......................... 9-2  
9-2 How to Use the Contents Pane .................................. 9-5  
9-3 How to Use Wildcards with the Basic Search Syntax .................. 9-7
This guide introduces you to Compaq Visual Fortran Version 6.6 and shows you how to install and use the three editions of the product:

- Standard Edition
- Professional Edition
- Enterprise Edition

**Shortcut to Important Information in This Guide**

The most important information you need to know to install Visual Fortran is contained in these sections in this guide:

- **System Requirements**
  See Section 2.1, System Requirements for the Three Editions.

- **Reading the Release Notes**
  The release notes contain important last-minute information. See Section 2.2, Release Notes.

- **Registering Visual Fortran**
  To install Visual Fortran, you need your registration number. See Section 2.3, Registration Number, and Section 3.8, Registering Visual Fortran With Compaq.

- **Installing Visual Fortran**
  Visual Fortran provides three installation options: *Typical*, *Custom*, and *Run From CD-ROM*.

  If you are using a Windows 2000 or Windows NT system, you must log into an account with Administrator privilege to install Visual Fortran.

  Complete installation details are provided in Chapter 3, How to Install Visual Fortran.

- **Must-Do Postinstallation Task**
  After installation, every user must apply the Per-User Setup option. See Section 4.1, Applying the Visual Fortran Per-User Setup Option. You can also read about other important postinstallation tasks in Chapter 4, Postinstallation Tasks.

- **Using the Visual Development Environment**
  If you have not previously used the Microsoft visual development environment (Developer Studio), do the following:
• Read Chapter 6, Using Visual Fortran.
• Use the Visual Fortran sample programs. See Section 7.1, Using the Sample Programs.

Using Online Documentation

Much of the Visual Fortran documentation is provided online in HTML Help Viewer form. See Section 7.6, Viewing Online Documentation in the HTML Help Viewer.

Some documentation is provided in PDF format, to be read using the Adobe Acrobat Reader Version 4.0 or later. See Section 8.4, Documentation Available in PDF Format.

• Technical Support

Several types of technical support are available from Compaq. If you encounter problems using Visual Fortran, see Chapter 10, Visual Fortran Technical Support.

Compaq Fortran Web Site

With an Internet browser, you can view the Compaq Fortran home page at:

http://www.compaq.com/fortran

This Web site contains information about software update patch kits, example programs, and additional product information.

Chapters in This Guide

This guide contains the following chapters:
• Chapter 1, Summary of Visual Fortran Software Components and Packaging
  Describes the software components and packaging of the three Visual Fortran editions.
• Chapter 2, Prerequisites for Installing Visual Fortran
  Describes the system requirements for installing Visual Fortran and provides information you need to read before installing.
• Chapter 3, How to Install Visual Fortran
  Describes the installation procedures for installing Visual Fortran.
• Chapter 4, Postinstallation Tasks
  Describes postinstallation tasks required to use Visual Fortran.
• Chapter 5, Using a Concurrent-Use License
Describes how to install and use the license manager software for sites that purchased a concurrent-use license.

- Chapter 6, Using Visual Fortran
  Shows how to use the Microsoft visual development environment.
- Chapter 7, Product Highlights
  Describes the major Visual Fortran software components.
- Chapter 8, Documentation Road Map: Where to Find What You Need
  Describes the printed and online documentation available with Visual Fortran.
- Chapter 9, Using the HTML Help Viewer
  Shows how to use the Microsoft HTML Help Viewer to access the Visual Fortran documentation.
- Chapter 10, Visual Fortran Technical Support
  Describes the technical support options available for Visual Fortran.
- Chapter 11, Using the VF Reporter Tool
  Describes how to use the Visual Fortran Reporter (VF Reporter) to report suspected problems or send suggestions to the Visual Fortran team.

**Associated Documentation**

See Chapter 8, Documentation Road Map: Where to Find What You Need, for information about all the documentation available with Visual Fortran.

**Sending Compaq Your Comments on This Guide**

Compaq welcomes your comments on this or any other Compaq Fortran manual. You can send comments by e-mail to:

fortran@compaq.com

If you have suggestions for improving particular sections or find any errors, please indicate the title, order number, and section numbers. Compaq also welcomes general comments.
Summary of Visual Fortran Software Components and Packaging

This chapter contains the following sections:
• 1.1, Visual Fortran Software Components
• 1.2, Visual Fortran Packaging

1.1 Visual Fortran Software Components

Compaq Visual Fortran is available in three editions:
• Standard Edition
• Professional Edition
• Enterprise Edition

1.1.1 Components in All Three Editions

All three editions contain the following software components:
• Compaq Visual Fortran compiler (Fortran 95/90 language) and run-time system.
  For more information, see Section 7.2, Compaq Fortran Language.
• Compaq Visual Fortran library routines.
  For more information, see Section 7.13.1, Visual Fortran and Array Visualizer Library Routines.
• Microsoft visual development environment and integrated set of tools.
  For more information, see Chapter 6, Using Visual Fortran.
• Visual Fortran command-line interface.
For more information, see Section 7.3, Using the Command-Line Interface.

- Compaq Extended Math Library (CXML), which consists of a group of math libraries for use in many different types of scientific and engineering applications.
  For more information, see Section 7.4, Using Compaq Extended Math Library (CXML).

  For more information, see Section 7.5, Mixed-Language Programming Support with Visual C++ and Visual Basic.

- Fortran Module Wizard to simplify the use of functionality available with Component Object Module (COM) and Automation (OLE Automation) objects.
  For more information, see Section 7.11, Support for COM and Automation Objects: Fortran Module Wizard.

- HTML Help Viewer to let you view a complete set of online documentation, providing help for every stage of the code development process.
  For more information, see Chapter 9, Using the HTML Help Viewer.

- VF Reporter, an automated, simple, e-mail mechanism for reporting suspected problems or sending suggestions to the Visual Fortran team.
  For more information, see Chapter 11, Using the VF Reporter Tool.

- Array Viewer, a demo subset of the Compaq Array Visualizer that lets you view array files.
  For more information, see Section 7.7, Using the Array Visualizer.

- f90SQL-lite from Canaima Software. f90SQL is a library that makes it possible for Fortran applications to directly read and write data stored in databases that are compliant with the Open Database Connectivity (ODBC) API such as Excel, Microsoft Access, and Oracle.
  For more information, see Section 7.9, Using f90SQL-lite.

Note: These are the major components of Visual Fortran. For a more complete list of features, see Chapter 7, Product Highlights.

1.1.2 Additional Components in the Professional and Enterprise Editions

The Professional Edition and Enterprise Edition contain the following additional components:

- Compaq Array Visualizer, which lets you view array data and graph it in one of multiple views. The Array Visualizer includes two ActiveX controls, Array
Visualizer library routines, and the ability to view arrays with Array Viewer in the debugger.

For more information, see Section 7.7, Using the Array Visualizer.

- IMSL Libraries for Visual Fortran, which include the IMSL Fortran 90 MP Library and the IMSL FORTRAN 77 Mathematical and Statistical Libraries. The IMSL libraries are from Visual Numerics.

For more information, see Section 7.8, Using the IMSL Libraries (Professional and Enterprise Editions).

- Fortran COM server wizard, which allows you to create COM servers in Fortran.

For more information, see Section 7.12, Support for Creating COM Servers (Professional and Enterprise Editions).

### 1.1.3 Additional Components in the Enterprise Edition

The Enterprise Edition contains the following additional components:

- Enterprise Toolkit, a suite of tools that extends the reach of the Visual Fortran visual development environment to let you code, build, and debug applications on Compaq Tru64™ UNIX and other UNIX and Linux systems.

For more information, see Section 7.10, Using Enterprise Toolkit and Technical Programming Extensions (Enterprise Edition).

- Technical Programming Extensions (TPE), which enhances the Enterprise Toolkit to make the job of developing Fortran applications easier.

For more information, see Section 7.10, Using Enterprise Toolkit and Technical Programming Extensions (Enterprise Edition).

### 1.1.4 Components in Table Format

Table 1-1 shows the Visual Fortran components and their availability in table format.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Compaq Visual Fortran compiler (Fortran 95/90 language) and run-time system, see Section 7.2.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Compaq Visual Fortran library routines, see Section 7.13.1</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft visual development environment, see Chapter 6.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Visual Fortran command-line interface, see Section 7.3.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Compaq Extended Math Library (CXML) routines, see Section 7.4.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 1-1  Components of the Visual Fortran Editions

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mixed-language programming with Visual C++ and Visual Basic, see Section 7.5.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Fortran Module Wizard, see Section 7.11</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>HTML Help Viewer for online documentation, see Chapter 9.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>VF Reporter, see Chapter 11.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Array Viewer demo subset of the Array Visualizer, see Section 7.7.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>f90SQL from Canaima Software, see Section 7.9</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Array Visualizer, see Section 7.7</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>IMSL libraries from Visual Numerics, see Section 7.8.</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Fortran COM server wizard, see Section 7.12.</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Enterprise Toolkit, see Section 7.10.</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Technical Programming Extensions, see Section 7.10.</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

For system requirements for the three editions, see Section 2.1, System Requirements for the Three Editions.

1.2 Visual Fortran Packaging

Your Visual Fortran kit contains the printed *Compaq Fortran Language Reference Manual*, this guide in printed form, the license letter, and certain CD–ROMs.

The CD–ROMs you receive depends on which edition you have purchased:

- Standard Edition, see Section 1.2.1, CD–ROMs for Standard Edition
- Professional Edition, see Section 1.2.2, CD–ROMs for Professional Edition
- Enterprise Edition, see Section 1.2.3, CD–ROMs for Enterprise Edition

For information about the printed manuals, see Section 8.1, Printed (Hardcopy) Documentation.

The Compaq Visual Fortran Software Product Description (SPD) is available on the CD–ROM in the root directory. The file is named `Cvf_spd_66.txt`.

If you have questions about your kit or problems using your CD–ROMs, you can contact Visual Fortran technical support. See Chapter 10, Visual Fortran Technical Support.

1.2.1 CD–ROMs for Standard Edition

The Visual Fortran Standard Edition contains the following CD–ROM:
• Compaq Visual Fortran Standard Edition CD–ROM
  This CD–ROM lets you install Visual Fortran on a system running the Windows 2000, Windows NT 4, Windows Me, Windows 98, or Windows 95 operating system.
  This CD–ROM contains all the software you need for the installation of the Standard Edition, including Internet Explorer Version 4 Service Pack 1 and Windows NT Version 4 Service Pack 3 if you don't already have them. It also contains the server software for the FLEXlm software license manager, to be used if you purchased a concurrent-use license.

1.2.2 CD–ROMs for Professional Edition

The Visual Fortran Professional Edition contains the following CD–ROMs:

• Compaq Visual Fortran Professional Edition
  This CD–ROM lets you install Visual Fortran on a system running the Windows 2000, Windows NT 4, Windows Me, Windows 98, or Windows 95 operating system.
  This CD–ROM contains additional software you need for the installation of the Professional Edition, in particular Internet Explorer Version 4 Service Pack 1 and Windows NT Version 4 Service Pack 3 if you don't already have them. It also contains the server software for the FLEXlm software license manager, to be used if you purchased a concurrent-use license.

• Compaq Array Visualizer
  This CD–ROM lets you install the Array Visualizer on a system running the Windows 2000, Windows NT 4, Windows Me, Windows 98, or Windows 95 operating system.

1.2.3 CD–ROMs for Enterprise Edition

The Visual Fortran Enterprise Edition includes the same three CD–ROMs provided in the Professional Edition described in Section 1.2.2, CD–ROMs for Professional Edition. Note that these CD–ROMs are the exact same CD–ROMs and have the same name (called the Professional Edition).

The Enterprise Edition contains two additional CD–ROMs:

• Enterprise Toolkit
• Technical Programming Extensions

For more information, see Section 7.10, Using Enterprise Toolkit and Technical Programming Extensions (Enterprise Edition)
This chapter contains the following sections:

- 2.1, System Requirements for the Three Editions
- 2.2, Release Notes
- 2.3, Registration Number
- 2.4, Optional Software
- 2.5, Considerations for Installing with Visual Studio Products
- 2.6, Considerations for Installing with Visual Fortran Version 5
- 2.7, Considerations for Installing with Visual Fortran Version 6.0, 6.1, or 6.5
- 2.8, Multiple-User License Considerations
- 2.9, Concurrent-Use License Considerations

### 2.1 System Requirements for the Three Editions

To run the Standard, Professional, or Enterprise Edition of Visual Fortran, you need a PC with an Intel Pentium series (or 100% compatible) or higher processor (Intel Pentium 90 or higher recommended) running either:

- Microsoft Windows NT Version 4 operating system with Service Pack 3 or later installed. (SP3 is provided on the Visual Fortran CD-ROM.)
- Microsoft Windows 2000, Windows Me, Windows 98, or Windows 95 operating system.

In addition, for the Enterprise Edition there are specific system requirements for the Enterprise Toolkit and Technical Programming Extensions components (see the
Installation Guide in the Enterprise Toolkit folder). For example, more hard disk space is needed for these components as well as a Compaq Tru64 UNIX system running the Compaq Fortran compiler.

You also need:

- Sufficient memory, as follows:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Memory Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000, Windows NT 4, Windows Me, Windows 98, Windows 95</td>
<td>32 megabytes (MB) of available memory (64 MB or more recommended)</td>
</tr>
</tbody>
</table>

- CD–ROM drive. Your system should have 32-bit CD–ROM drivers installed.

- Hard disk with enough disk space to install the options you need:

<table>
<thead>
<tr>
<th>Edition</th>
<th>Hard Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Requires 32 MB to run from CD–ROM and up to 340 MB to install all components. Installing Microsoft Internet Explorer Version 4 requires an additional 48 MB.</td>
</tr>
<tr>
<td>Professional</td>
<td>Requires 34 MB to run from CD–ROM and up to 400 MB to install all components. Installing Microsoft Internet Explorer Version 4 requires an additional 48 MB. Installing the Array Visualizer requires from 8 to 20 MB.</td>
</tr>
<tr>
<td>Enterprise</td>
<td>Same as Professional Edition, plus additional disk space for Enterprise Toolkit PC components and Technical Programming Extensions on the PC (approximately 160 to 200 MB) and storage on a Compaq Tru64 UNIX system for Enterprise Toolkit server components and Technical Programming Extensions (approximately 90 MB).</td>
</tr>
</tbody>
</table>

The Visual Fortran setup process lets you select installation options and provides you with the disk space requirements for the options you select. It then checks to make sure you have enough space before copying files.

- VGA monitor (17-inch SVGA monitor recommended).

- Mouse or compatible pointing device.

- Microsoft Internet Explorer Version 4 Service Pack 1 (SP1) or later, to view the online documentation in the HTML Help Viewer. IE Version 4 SP1 is provided on the Visual Fortran CD–ROM for all editions.

- On a Windows 2000 or Windows NT 4 system, an Administrator account. You must install Visual Fortran and Internet Explorer from an account with Administrator privilege.
2.2 Release Notes

Before installing, you should read the Visual Fortran release notes, which are available in text format to be opened in an editor and HTML format to be opened in a Web browser.

You can read the release notes by opening the Relnotes.txt file or the Relnotes.htm file located in the root directory of the Visual Fortran CD–ROM. (Or use the Compaq Visual Fortran Master Setup Window, described in Section 3.3, Using the Visual Fortran Master Setup Window.)

After installation, look at the Release Notes item in the Compaq Visual Fortran 6 program folder. Or you can read the Relnotes.txt file or the Relnotes.htm file installed in:

\Program Files\Microsoft Visual Studio\Df98

2.3 Registration Number

Your registration number (installation number) is located on the Visual Fortran CD–ROM clear sleeve and also on your license letter. With multiple-user license kits, use the registration number on the license letter.

**Note:** Keep your registration number (or a copy of it) in a safe place.

You will need your registration number:

- During installation (at first installation and any subsequent reinstallation).
- To register Visual Fortran with Compaq.
- If you later purchase a product upgrade kit (such as to upgrade Visual Fortran between major versions). The installation procedure asks for both the old and the new registration numbers.
- When you need technical support.

Registering Visual Fortran with Compaq confirms that you are a legally registered user and allows you to receive:

- Special offers from Compaq related to Visual Fortran upgrades and related products
- Information about Visual Fortran product use
- A free copy of the Visual Fortran electronic newsletter

To register your product with Compaq, use the procedure provided after you install Visual Fortran components. See Section 3.8, Registering Visual Fortran With Compaq.

With the Visual Fortran Enterprise Edition, use the registration number on the Visual Fortran Professional Edition folder (or license letter) to install Visual Fortran and Array
Visualizer. To install the Enterprise Toolkit components, see Section 3.7, Installing Enterprise Toolkit and TPE Components (Enterprise Edition).

For information on available technical support, see Chapter 10, Visual Fortran Technical Support.

2.4 Optional Software

You can extend the capabilities of Visual Fortran by using it with the following software products not included with the Visual Fortran product:

- Microsoft Excel to graph your data. For example, the Autodice Sample shows how you can use Automation to export Fortran data to Excel. See Section 7.1, Using the Sample Programs.
  
  For more information, see the Excel Web site at:
  
  http://www.microsoft.com/office/excel

- Microsoft Visual SourceSafe for managing project source files, including version control.
  
  For more information, see the Visual SourceSafe Web site at:
  
  http://msdn.microsoft.com/ssafe/

Users of the Visual Fortran Standard Edition might want to use the following software provided only in the Professional and Enterprise Editions:

- Compaq Array Visualizer, which lets you view array data and graph it in one of multiple views.
  
- IMSL Libraries for Visual Fortran, which include the IMSL Fortran 90 MP Library and the IMSL Mathematical and Statistical libraries.
  
- Fortran COM server wizard, which allows you to create COM servers in Fortran.

For information on how to upgrade from the Standard Edition, See the Visual Fortran Web page at:

http://www.compaq.com/fortran

2.5 Considerations for Installing with Visual Studio Products


Once you install Visual Fortran, you can run it within the Microsoft Developer Studio visual development environment.
Before you install Visual Fortran on a system where Microsoft Visual Studio products are installed, you need to be aware of the following:

- **Visual Fortran Version 6.6 uses the same development environment as Visual Fortran Versions 6.0, 6.1, and 6.5 and Microsoft Visual C++ Version 6.0. This allows you to easily create applications that include code from both languages. Visual Studio products of the same version are designed to work together and should be installed in the same directory. By default, Visual Fortran will be installed into the same directory as your other Visual Studio products. Problems can arise if you choose to install in different directories.**

- **If you attempt to use Visual Fortran with other Visual Studio tools of a different version of Visual Studio that are installed in the same directory location, you may encounter unexpected run-time errors and other problems. For example, you cannot install Visual Fortran Version 6 in the same directory where Visual C++ Version 5 is installed.**

With Visual Fortran Version 5, the default installation directories are:

- `\Program Files\DevStudio`
- `\Program Files\DevStudio\Df`
- `\Program Files\DevStudio\Vc`

With Visual Fortran Version 6, the default installation directories are:

- `\Program Files\Microsoft Visual Studio\Common`
- `\Program Files\Microsoft Visual Studio\Df98`
- `\Program Files\Microsoft Visual Studio\Vc98`

- **When you install Visual Fortran and a compatible version of Visual C++ with the Microsoft MSDN online documentation, the current collection of HTML Help titles is used when you use the search, index, or contents functions. To change the current online documentation collection in use by the HTML Help Viewer, see Section 9.11, Other HTML Help Viewer Features.**

- **If you need to use language products that use a different version of the Microsoft visual development environment (or a different development environment) than Visual Fortran, you cannot use the Visual Studio environment to create all parts of the mixed-language application.**

When other languages in a mixed-language application use a different version of Microsoft's visual development environment, you can copy object files into your project workspace, add them to your project, and use the visual development environment to link them into your application.
2.6 Considerations for Installing with Visual Fortran Version 5

Before you install Visual Fortran Version 6.6 on a system where Visual Fortran Version 5 is installed, you need to be aware of the following:

- You must not install Visual Fortran Version 6.6 in the same directory used for Visual Fortran Version 5.

  With Visual Fortran Version 5, the default installation directories are:

  \Program Files\DevStudio
  \Program Files\DevStudio\Df
  \Program Files\DevStudio\Vc

  With Visual Fortran Version 6.6, the default installation directories are:

  \Program Files\Microsoft Visual Studio\Common
  \Program Files\Microsoft Visual Studio\Df98
  \Program Files\Microsoft Visual Studio\Vc98

- If you might use Visual Fortran Version 5 and Version 6.6 for the same projects, consider making a copy of each project directory and its files. The project file formats differ between Version 5 and Version 6.6. Visual Fortran will ask you whether you want to convert the project to the Version 6 format.

  For more information, see Section 4.4, Copying Visual Fortran Project Files.

- You can remove Visual Fortran Version 5 before or after you install Version 6.6. However, if you remove Visual Fortran Version 5 after you install Version 6.6, you need to reinstall Visual Fortran Version 6.6 with the same options as the current installation to reset the registry entries that are removed when you remove Visual Fortran Version 5.

  To remove Visual Fortran Version 5, follow the procedure in Section 4.11, Removing Visual Fortran Version 5.

- When you installed Visual Fortran Version 5, if you allowed the setup process to update your environment variables, you need to remove these changes manually. See Section 4.14, Checking for and Removing Old Environment Variable Definitions.

2.7 Considerations for Installing with Visual Fortran Version 6.0, 6.1, or 6.5

Visual Fortran Version 6.6 is considered an update to Version 6 and not a major version release. There are no released versions of Visual Fortran numbered 6.2, 6.3, or 6.4.

Visual Fortran Version 6.6 must be installed in the same directory tree as any previous installation of Version 6.0, 6.1, or 6.5, unless you remove the previous installation from the system. Version 6.0, 6.1, 6.5, and 6.6 cannot coexist on the same system.
You can do either of the following:

- Install Version 6.6 in the same directory location as Version 6.0, 6.1, or 6.5, which will overwrite the previous installation.
- Install Version 6.6 in another directory location after removing Version 6.0, 6.1, or 6.5 from the system. For information, see Section 4.10, Removing Visual Fortran Version 6 (6.0, 6.1, 6.5, 6.5A, or 6.6).

### 2.8 Multiple-User License Considerations

If you purchased a multiple-user license, you receive a single Visual Fortran kit and one license letter which grants permission to install on up to the indicated number of PCs. Use the same registration number on each PC.

Purchasing the multiple-user license allows you to install Visual Fortran in a dedicated networked environment from a server to conserve disk space. To install Visual Fortran in a dedicated networked environment from a server:

2. Make the copied Visual Fortran CD–ROM root directory a share on the server, accessible to licensed PCs on which Visual Fortran will be installed.
3. For each system on which you will install Visual Fortran, map a network drive to the server. Install Visual Fortran from that mapped network drive as if it were the Visual Fortran CD–ROM (click setup.exe). You can select the Run from CD–ROM installation option to conserve local hard disk space. Alternatively, you can select a Custom installation and minimize the disk space used by not selecting software components that can be run from CD–ROM. See Section 3.9, Running Visual Fortran All or Partially from CD–ROM.

Instead of requiring that the CD–ROM be mounted for certain tasks (such as opening Platform SDK online documentation), Visual Fortran accesses the mapped network drive from which installation occurred.

Depending on the locations of systems and network availability, the users of the multiple-user license can include a mixture of network installations from the server and traditional (local disk) installations.

For example, if a user’s system is located where dedicated network access is not available (for example, only dial-up networking is available), you should perform a traditional single-user Visual Fortran installation. In this case, select a Custom installation and consider installing all components on the local hard disk because neither the shared CD–ROM nor the networked drive will always be available for the Run from CD–ROM installation option.
With the Professional and Enterprise Editions, Array Visualizer should be installed as usual on each local system's hard disk, because Array Visualizer does not support the Run from CD–ROM option.

Regardless of how it is installed, when the Visual Fortran installation asks for your registration number, use the separate registration numbers provided on each license letter for each system.

If you have any license-related questions, please carefully read your license letter, or contact Compaq technical support. See Chapter 10, Visual Fortran Technical Support.

**2.9 Concurrent-Use License Considerations**

If you purchased a concurrent-use (network) license, you will receive a single Visual Fortran kit and a single license.

For details, see Chapter 5, Using a Concurrent-Use License.
Chapter 3: How to Install Visual Fortran

This chapter contains the following sections:

- 3.1, Starting the Installation
- 3.2, Activating the Visual Fortran Master Setup Window
- 3.3, Using the Visual Fortran Master Setup Window
- 3.4, Installing Visual Fortran
- 3.5, Installing Array Viewer (Standard Edition)
- 3.6, Installing Array Visualizer (Professional and Enterprise Editions)
- 3.7, Installing Enterprise Toolkit and TPE Components (Enterprise Edition)
- 3.8, Registering Visual Fortran With Compaq
- 3.9, Running Visual Fortran All or Partially from CD–ROM
- 3.10, Visual Fortran Program Folder Contents
- 3.11, After Installation: Must-Do Task

Note: Before you begin installing, be sure to read the relevant information in Chapter 2, Prerequisites for Installing Visual Fortran, particularly sections about the registration number and considerations for installing with Visual Studio and with previous versions of Visual Fortran.

3.1 Starting the Installation

To install any edition (Standard, Professional, or Enterprise) of Visual Fortran, do the following:

1. Start Microsoft Windows 2000, Windows NT 4, Windows Me, Windows 98, or Windows 95. If your system is already started, close all applications currently in use.
2 If you are using a Windows 2000 or Windows NT 4 system, log into an account with Administrator privilege.

3 Locate the Visual Fortran CD–ROM in your kit and insert it into your system's CD–ROM drive.

4 Use the Compaq Visual Fortran Master Setup Window to continue the installation. The Visual Fortran Master Setup Window appears if the version of Visual Fortran on the Visual Fortran CD–ROM has not been previously installed on your system. Go to Section 3.3, Using the Visual Fortran Master Setup Window and continue the setup process.

The Visual Fortran Master Setup Window does not appear if the same version of Visual Fortran has been previously installed; this allows use of the Run from CD–ROM option (described in Section 3.9, Running Visual Fortran All or Partially from CD–ROM).

If the Visual Fortran Master Setup Window does not appear, go to Section 3.2, Activating the Visual Fortran Master Setup Window and follow the instructions.

### 3.2 Activating the Visual Fortran Master Setup Window

To activate the Visual Fortran Master Setup Window, you can use the Control Panel, the My Computer icon, or the Run menu item:

Using the Control Panel:

1. From the Start menu, move the pointer to Settings.
2. Click Control Panel; the Control Panel window appears.
3. Click Add/Remove Programs; a dialog box appears.
4. Click the Install button (in the Install/Uninstall tab).
5. After inserting the Visual Fortran CD–ROM, click the Next> button.
6. Click Finish.

Using the My Computer icon:

1. In My Computer, double-click the CD–ROM drive to display the contents of the Visual Fortran CD–ROM.
2. Double-click the Setup icon to start the setup process.

Using the Run menu item:

1. From the Start menu, click Run.
2. Enter the drive letter followed by a colon and \setup.exe. For example, if your CD–ROM drive is your D drive, enter: d:\setup.exe
3 Click Enter.

After the Visual Fortran Master Setup Window appears, go to Section 3.3, Using the Visual Fortran Master Setup Window and follow the instructions.

3.3 Using the Visual Fortran Master Setup Window

Figure 3-1 shows the Visual Fortran Master Setup window.

Figure 3-1  Compaq Visual Fortran Master Setup Window

The Master Setup window lets you select one of the following options:

- **Install Visual Fortran**
  
  Click this button to begin installing Compaq Visual Fortran.

- **View Release Notes**
  
  Click this button to view the Visual Fortran release notes. The release notes are displayed in the Notepad or Wordpad text editor.

  After installation, you can read the release notes online by using the Visual Fortran program folder (click Start, then Programs, then Compaq Visual Fortran 6, then Release Notes) or by viewing the Relnotes.txt file or the Relnotes.htm file in the following directory:

  \Program Files\Microsoft Visual Studio\Df98

- **Exit**
  
  Click this button to exit the setup process.
3.4 Installing Visual Fortran

If you have not done so already, activate the Compaq Visual Fortran Master Setup window. (See Section 3.2, Activating the Visual Fortran Master Setup Window.)

These sections describe the two basic steps for installing Visual Fortran:

- 3.4.1, How to Display the Setup Install Type Dialog Box
- 3.4.2, Specifying Installation Options and Destination Directories

3.4.1 How to Display the Setup Install Type Dialog Box

Follow these steps to bring up the Setup Install Type dialog box:

1. The setup process asks if you want to view the Readme file. If you click Yes, the file is displayed in the Notepad or Wordpad text editor. After you read the file, close the text editor.

2. The Welcome dialog box requests that you discontinue using other applications during the setup process. (You can minimize the Master Setup window to access the other applications.)

   After closing other applications, click the Next> button to proceed.

3. The setup process checks to see if required software is installed and, if not, installs it.

   Windows NT systems only: The setup process checks to see whether Service Pack 3 (or a later service pack) has been installed. If SP3 (or later) is not installed, a dialog box appears asking whether you want to install it now. You must install SP3 to continue with the installation. See Section 3.4.3, Installing Service Pack 3 (Windows NT Systems Only).

   All systems: The setup process checks to see whether Microsoft Internet Explorer Version 4 (or later) is installed. If it is not installed, a dialog box appears asking whether you want to install it now. It is highly recommended that you install it now. See Section 3.4.4, Installing Internet Explorer.

4. If the setup process detects that Service Pack 3 is installed for Windows NT systems and that Internet Explorer is installed, the License Terms dialog box appears.

   The License Terms dialog box requests that you view the terms of the Visual Fortran license. If you accept the terms, Click the I Accept button.

5. The Registration dialog box appears.

   Enter your name and your company's name.

   Carefully enter your registration number into the four fields displayed. Your registration is on the front of the Visual Fortran folder and also on your license letter.
For a multiple-user license kit, see Section 2.8, Multiple-User License Considerations.

If you purchased a product upgrade kit (such as to upgrade Visual Fortran between major versions), the setup process may ask for both the old and the new registration numbers.

As you enter the number, the cursor moves to the next field. If you need to make a correction, you can move the cursor to a different field:

- To return to a previous field, either click on that field or press the Shift+Tab keys (hold down Shift and press the Tab key).
- To move to the next field, either click on the field or click the Tab key.

Click on one of the following buttons:

- Click the Next> button to proceed with the next screen.
- Click the <Back button to return to the previous dialog box.
- Click the Cancel button to exit the Visual Fortran setup process.

6 The Registration Confirmation dialog box appears. Click Yes or No as appropriate. If you click No, the Registration dialog box reappears to let you enter the correct information.

7 The setup process searches for installed components and displays the Setup Install Type dialog box, as shown in Figure 3-2. This dialog box lets you specify installation options and destination directories.

Figure 3-2 Setup Install Type Dialog Box (Visual Fortran)
3.4.2 Specifying Installation Options and Destination Directories

Installation Options

The options are:
- The Typical option installs the most common Visual Fortran components and subcomponents.

Table 3-1 lists the installation components and subcomponents and shows which ones are included in a Typical installation.

Table 3-1 Visual Fortran Installation Components and Subcomponents

<table>
<thead>
<tr>
<th>Component and Subcomponent Name</th>
<th>Included in Typical Installation?</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMSL Numerical Libraries</td>
<td></td>
</tr>
<tr>
<td>(Professional and Enterprise Editions only)</td>
<td></td>
</tr>
<tr>
<td>IMSL Modules, Libraries, Includes and Messages</td>
<td>Yes</td>
</tr>
<tr>
<td>IMSL Online Help</td>
<td>Yes</td>
</tr>
<tr>
<td>IMSL Sample Programs</td>
<td>No</td>
</tr>
<tr>
<td>CXML Libraries</td>
<td>No</td>
</tr>
<tr>
<td>Sample Programs</td>
<td>No</td>
</tr>
<tr>
<td>Books Online</td>
<td></td>
</tr>
<tr>
<td>Documentation Viewer and Indices</td>
<td>Yes</td>
</tr>
<tr>
<td>Visual Fortran Books Online</td>
<td>Yes</td>
</tr>
<tr>
<td>Developer Studio Books Online</td>
<td>Yes</td>
</tr>
<tr>
<td>Win32 SDK Books Online</td>
<td>Yes</td>
</tr>
<tr>
<td>Supplemental Tools</td>
<td></td>
</tr>
<tr>
<td>Profiler</td>
<td>Yes</td>
</tr>
<tr>
<td>Process Viewer</td>
<td>Yes</td>
</tr>
<tr>
<td>WinDiff</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Tools</td>
<td>Yes</td>
</tr>
<tr>
<td>Ole Tools</td>
<td>Yes</td>
</tr>
<tr>
<td>Fortran Compiler, Tools, and Libraries(^1)</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Developer Studio(^1)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

1. To view all the items during a Custom installation, use the horizontal scroll bar.

If you choose the Typical installation option and later want to add additional components, you can perform a Custom installation without removing Visual Fortran. See Section 4.5, Changing Installation Options or Reinstalling Visual Fortran.
The Custom option lets you select each component and subcomponent separately. If you choose Custom and click Next, the Custom Options Selection dialog box appears. This dialog box lets you scroll the list of available components and select the check box for each component you want installed. It also displays:

- The estimated disk space required by each component
- The total size required by the selected components
- The disk space available on the specified drive

If you are installing Visual Fortran components on multiple drives, the Space Available number applies only to the drive on which the files for the Microsoft Developer Studio component are to be installed.

In the Custom Options Selection dialog box, when you turn on certain components, such as Books Online, you can click the Change button to view the sizes and check each subcomponent you want to install. When you turn on a component that does not have any subcomponents, the Change button is dimmed.

The Run From CD-ROM option installs a minimal set of shared Visual Studio files on the hard disk, but components will be run from the Visual Fortran CD-ROM. The CD-ROM must be mounted to use Visual Fortran components. See Section 3.9, Running Visual Fortran All or Partially from CD-ROM.

To determine the disk space available for the current destination directory, select the Custom option, view the disk space available, and then click the <Back button to allow you to select one of the three installation options.

The displayed disk space numbers are calculated conservatively as if none of the files exist in the destination directories. For example, if you are installing a newer version of Visual Fortran Version 6 in the same location as an older version of Version 6 (such as Version 6.0), the actual disk space required will be less than the calculated disk space displayed.

Destination Directories

The Destination Directories box (lower part of screen) shows the default destination directories.

If you are installing a new version of Visual Fortran, the default directories will be placed on your system disk (shown below as C:), as follows:

```
C:\Program Files\Microsoft Visual Studio\Common
C:\Program Files\Microsoft Visual Studio\Df98
C:\Program Files\Microsoft Visual Studio\VC98
```

If you are installing a version of Visual Fortran on a system where Microsoft Visual Studio products are installed (such as Visual C++), the directories will be where the
Visual Studio components were installed. Be sure to read Section 2.5, Considerations for Installing with Visual Studio Products, before you install Visual Fortran.

If you are installing a version of Visual Fortran on a dual-boot system (such as Windows 98 and Windows NT), you need to specify different directories (or disks) for the installation of Visual Fortran under each operating system.

To change disk devices, click the top Directory button and select a different disk device from the drop-down list. On whichever disk device you select, Compaq recommends that you specify the top-level directory as:

\Program Files\Microsoft Visual Studio\Common

To specify a different directory, click the appropriate Directory button.

If you are installing a newer version of Version 6 or reinstalling Visual Fortran, the setup process will replace (install over the location of) the existing version by default. For more information on changing installation options or reinstalling Visual Fortran, see Section 4.5, Changing Installation Options or Reinstalling Visual Fortran.

Continue the installation, following the steps below. You can use the <Back and Next> buttons to move through the installation selections.

1. When you have selected the installation option and destination directories in the Setup Install Type dialog box, click the Next> button. Then, if you chose the Custom option, click Next> in the Custom Options Selection dialog box.

2. The Select Folder dialog box appears, as shown in Figure 3-3 for a Windows NT system.

Figure 3-3 Select Folder Dialog Box

The Select Folder dialog box asks you to:

- View and optionally change the Program Folder name.
3.4.3 Installing Service Pack 3 (Windows NT Systems Only)

If Service Pack 3 is not installed, the setup process requests that you install it.

To install SP3:

For the folder name, use the same set of characters allowed for file names.

- On a Windows 2000 or Windows NT 4 system, choose whether you want Visual Fortran installed:
  - As a personal folder available only to the account being used for installation
  - In a common folder available to other users

3 Make your selection and click the Next> button.

Note: When you click the Next> button in the Select Folder dialog box, installation begins.

4 After you click the Next> button, the setup process displays the message ‘Setup is checking space requirements’ while it determines the exact amount of disk space needed. A message is displayed if you do not have enough disk space.

The setup process copies files to the destination directories, updates registry entries, and creates Program Folder entries and icons.

5 The Environment Variable Update dialog box appears, asking whether you want to update certain environment variables for use with an MS-DOS command prompt.

This environment variable update is not necessary if you use the Visual Fortran command prompt for any command-line use of Visual Fortran. It is also not necessary if you use Visual Fortran only from the visual development environment. Note that the Visual Fortran command prompt is installed automatically during the setup process. See Section 7.3, Using the Command-Line Interface.

If you decide to allow your environment variables to be updated, on Windows 98 or Windows 95 systems, Visual Fortran modifies your AUTOEXEC.BAT file to insert a CALL command that executes the DFVars.bat file. On Windows 2000, Windows Me, and Windows NT 4 systems, the installation sets system-side environment variables, as described in Section 4.14, Checking for and Removing Old Environment Variable Definitions.

6 The setup process asks if you want to register your product now. See Section 3.8, Registering Visual Fortran With Compaq.

If you are installing the Standard Edition, continue the installation by going to Section 3.5, Installing Array Viewer (Standard Edition).

If you are installing the Professional or Enterprise Edition, continue the installation by going to Section 3.6, Installing Array Visualizer (Professional and Enterprise Editions).
1 Click the Yes button to begin installation of SP3. The Welcome to Service Pack Setup window appears.

2 Follow the displayed instructions.
Your system will reboot after SP3 is installed.

After the reboot, resume installing Visual Fortran, as described in Section 3.4.1, How to Display the Setup Install Type Dialog Box.

### 3.4.4 Installing Internet Explorer

If Internet Explorer Version 4 Service Pack 1 or later is not installed, the setup process requests that you install it. Internet Explorer Version 4 is provided on the Visual Fortran CD–ROM.

**Note:** To view Visual Fortran online documentation in the HTML Help Viewer, you must install Internet Explorer before you install Visual Fortran. On a Windows 2000 or Windows NT 4 system, you must install Internet Explorer from an account with Administrator privilege.

If you choose not to install Internet Explorer when prompted, you will need to install Internet Explorer and then reinstall Visual Fortran later to be able to view Visual Fortran online documentation in the HTML Help Viewer.

To install Internet Explorer:

1 Click the Yes button to begin installation of Internet Explorer. The Internet Explorer 4.01 SP1 Active Setup window appears.

2 View and accept the Internet Explorer license agreement. A minimum installation is sufficient to view HTML Help online documentation.

3 Files are copied to your system disk. Follow the displayed instructions.
Your system will reboot after Internet Explorer is installed.

After the reboot, resume installing Visual Fortran, as described in Section 3.4.1, How to Display the Setup Install Type Dialog Box.

### 3.5 Installing Array Viewer (Standard Edition)

If you are installing the Standard Edition, as the final step in the installation, the setup process asks you whether you want to install the Compaq Array Viewer, a subset of the Compaq Array Visualizer.

Follow these steps to install the Array Viewer:
1 The Welcome dialog box requests that you discontinue using other applications during the setup process. (You can minimize the setup window to access the other applications.)

After closing other applications (if any), click the Next> button to proceed.

2 The Choose Destination Path dialog box asks you to specify the Destination Path, or click the Browse button to specify the correct directory location. The default location is: C:\Program Files\ArrayVisualizer

If you are installing the Array Viewer on a dual-boot system (such as Windows 98 and Windows NT), you need to specify different directories (or disks) for the installation of Array Viewer or Array Visualizer under each operating system.

3 The License Terms dialog box requests that you view the terms of the Array Viewer license. If you accept the terms, click the I Accept button.

4 The Select Folder dialog box appears, asking you to:
   • View and optionally change the Program Folder name.
     For the folder name, use the same set of characters allowed for file names.
   • On a Windows 2000 or Windows NT 4 system, choose whether you want the Array Viewer installed:
     – As a personal folder available only to the account being used for installation
     – In a common folder available to other users

   **Note:** When you click the Next> button in the Select Folder dialog box, installation begins.

   After you click the Next> button, the setup process displays the message ‘Setup is checking space requirements’ while it determines the exact amount of disk space needed. A message is displayed if you do not have enough disk space.

   The setup process copies files to the destination directories, updates registry entries, and creates a Program Folder entries and icons. The program folder item is called Compaq Array Visualizer.

5 If it appears, the Restart Windows dialog box asks whether you want to reboot Windows now or later.

6 The Setup Complete dialog box asks you to register Visual Fortran. See Section 3.8, Registering Visual Fortran With Compaq.

**Note:** To install the Compaq Array Viewer at a later time after you have completed the installation of Visual Fortran, on the Visual Fortran Standard Edition CD–ROM double-click the following file: \X86\Arrview\Setup.exe

After installation, perform certain postinstallation tasks described in Chapter 4, Postinstallation Tasks.
3.6 Installing Array Visualizer (Professional and Enterprise Editions)

If you are installing the Professional or Enterprise Editions, after you install the Visual Fortran CD–ROM, the setup process asks you whether you want to install the Compaq Array Visualizer.

If you reply Yes, the Array Visualizer Kit Location dialog box appears.

Insert the Compaq Array Visualizer CD–ROM into your system's CD–ROM drive and click Next>.

Follow these steps to install the Array Visualizer:

1 The Welcome dialog box requests that you discontinue using other applications during the setup process. (You can minimize the setup window to access the other applications.)
   After closing other applications (if any), click the Next> button to proceed.

2 The License Terms dialog box requests that you view the terms of the Array Visualizer license. If you accept the terms, click the I Accept button.

3 The Registration dialog box appears. Your information will probably be displayed. If not, see Section 3.4.1, How to Display the Setup Install Type Dialog Box, for details about how to enter your registration number. Click Next> to continue.

4 The Registration Confirmation dialog box appears. Click Yes or No as appropriate. If you click No, the Registration dialog box reappears to let you enter the correct information.

4 The Setup Install Type dialog box appears, as shown in Figure 3-4.
This dialog box lets you specify the type of installation and destination directory. The types are:

- **Typical** installs all components except Array Visualizer Samples.
- **Run-time** installs only run-time components, which includes the Array Viewer.
- **Complete** installs all components.

Choose the default Destination Directory or click the **Browse** button to specify another location.

If you are installing the Array Visualizer on a dual-boot system (such as Windows 98 and Windows NT), you need to specify different directories (or disks) for the installation of Array Visualizer under each operating system.

Click one of the following buttons:

- **Next** to proceed with the next screen.
- **<Back** to return to the previous dialog box.
- **Cancel** to exit the Visual Fortran setup process.

5 The Select Folder dialog box appears and asks you to:

- View and optionally change the Program Folder name.
  
  For the folder name, use the same set of characters allowed for file names.

- On a Windows 2000 or Windows NT 4 system, choose whether you want Array Visualizer installed:
  
  - As a personal folder available only to the account being used for installation
  - In a common folder available to other users
3-14  Compaq Visual Fortran Installing and Getting Started

3.7 Installing Enterprise Toolkit and TPE Components (Enterprise Edition)

For information about the CD–ROMs provided with the Enterprise Edition, see Section 1.2, Visual Fortran Packaging.

You install the Enterprise Toolkit components for the Enterprise Edition after you have completed the Visual Fortran and Array Visualizer installations.

With the Enterprise Edition, some components are installed on the PC and some components are installed on the UNIX server system.

To install the Enterprise Toolkit and Technical Programming Extensions (TPE):

1  Read the instructions in the Installation Guides provided in the Enterprise Toolkit and TPE CD–ROM folders.

2  Use the CD–ROMs provided in the two folders.

3  Use the Registration numbers provided on the back of the two folders during the installation.

4  At the end of the Enterprise Toolkit installation, you’ll be asked if you want to proceed with the TPE installation. You can choose to install TPE immediately or decline and install it later.

After installation, perform certain postinstallation tasks described in Chapter 4, Postinstallation Tasks.
3.8 Registering Visual Fortran With Compaq

After you install Visual Fortran and its associated software components, the Setup Complete dialog box appears. Click OK to register Visual Fortran online (this requires Internet access).

It is important that you register your purchase of Compaq Visual Fortran and also keep your registration information (such as your e-mail address) up-to-date. Registration entitles you to exclusive benefits, such as the Visual Fortran Newsletter, and provides a record of your serial number should you misplace it.

Concurrent licensing users need to perform a separate registration to obtain the license key (see Chapter 5, Using a Concurrent-Use License), but concurrent licensing users should also register their Visual Fortran purchase.

Use a Web browser to access the following Web site and follow the displayed instructions:
http://www.compaq.com/fortran/register

Note that you can use this Web site to update your registration information later (for example, to change your e-mail address).

For more information, see Section 2.3, Registration Number.

For information about registering your license for concurrent use, see Chapter 5, Using a Concurrent-Use License.

The Restart Windows dialog box may appear to ask whether you want to reboot Windows now or later.

3.9 Running Visual Fortran All or Partially from CD–ROM

When you install Visual Fortran to run from CD–ROM, you do not have to install all components on your local hard disk. If you want, you can use the files that make up these components directly from the CD–ROM when you need them.

Although this can save you hard disk space, there is usually a performance penalty for the component involved (although the amount of slowdown depends on the speed of your CD–ROM drive). To determine if a particular component can run from CD–ROM, during a Custom installation, the component's description in the options selection ends with the following words: ‘This component can be used directly from the CD–ROM.’.

You can run certain components from the Visual Fortran CD–ROM if they are not installed on your disk. For example, you can:

- Select certain HTML Help Viewer Books Online titles (from the Contents window) that have not been installed. The system will request that you mount the Visual Fortran CD–ROM.
Select certain Supplementary Tools (by clicking on their icon) that have not been installed. The system will request that you mount the Visual Fortran CD–ROM.

View, copy, or print the Samples and Release Notes files directly from the Visual Fortran CD–ROM at any time. The various Samples are in the `\info\Df\Samples` directory on the Visual Fortran CD–ROM. You can read the Visual Fortran release notes by using the Compaq Visual Fortran Master Setup Window.

With multiple-user license server installations, the contents of the Visual Fortran CD–ROM as copied to the hard disk location are used instead of the actual CD–ROM.

For information, see Section 2.8, Multiple-User License Considerations.

You also can choose to run Visual Fortran directly from the CD–ROM by selecting the Run from CD–ROM option during the setup process. If you select this option, a minimum of local hard disk space will be used. However, the Visual Fortran CD–ROM must be inserted into your CD–ROM drive to use any component of Visual Fortran.

For more information, see Section 4.5, Changing Installation Options or Reinstalling Visual Fortran.

### 3.10 Visual Fortran Program Folder Contents

After installation, a Visual Fortran program folder appears. To see the items in the folder:

1. From the Start menu, click Programs.
2. Click Compaq Visual Fortran 6 to display the items you have installed.

Depending on the Visual Fortran edition you installed and the installation options you chose, the items are:

- **Dependency Walker**
  
  A Windows tool for analyzing executable and dynamic-link library (DLL) files.

- **Developer Studio**
  
  Starts the visual development environment. See Chapter 6, Using Visual Fortran.

- **Error Lookup**
  
  A Windows tool for viewing error message text.

- **Fortran Command Prompt**
  
  Brings up a command-line window with the appropriate Visual Fortran environment variables already executed. See Section 7.3, Using the Command-Line Interface.

- **Fortran Module Wizard**
Helps you develop Fortran clients for COM and automation servers. See Section 7.11, Support for COM and Automation Objects: Fortran Module Wizard.

- **Help Workshop**
  Windows tool to let you create WinHelp (HLP) files for user-developed applications.

- **IMSL Fortran 90 MP Library Help**
  The online documentation for IMSL. See Section 7.8, Using the IMSL Libraries (Professional and Enterprise Editions) and Section 8.4, Documentation Available in PDF Format. (Note: Available in Professional and Enterprise Editions only.)

- **IMSL Fortran 90 MP Library Read Me**
  The *readme* file for IMSL. See Section 7.8, Using the IMSL Libraries (Professional and Enterprise Editions). (Note: Available in Professional and Enterprise Editions only.)

- **OLE-COM Object Viewer**
  A Windows tool that displays details about an OLE or COM object.

- **Online Documentation**
  Brings up the HTML Help Viewer to display the Visual Fortran online documentation without displaying Developer Studio. See Chapter 9, Using the HTML Help Viewer.

- **Online Registration**
  Helps you register your Visual Fortran product. See Section 3.8, Registering Visual Fortran With Compaq.

- **Per-User Setup**
  Needs to be applied once for each user after installation. See Section 4.1, Applying the Visual Fortran Per-User Setup Option.

- **Process Viewer**
  A Windows tool that displays information about your PC and its system processes.

- **Read Me**
  Displays the Visual Fortran *readme* file.

- **Release Notes**
  Displays the Visual Fortran release notes. See Section 2.2, Release Notes.

- **Spy++**
  A Windows tool that gives you a graphical view of the system’s processes, threads, windows, and window messages.

- **VF Reporter**
A tool for reporting suspected problems or sending suggestions to the Visual Fortran team. See Chapter 11, Using the VF Reporter Tool.

- **WinDiff**
  A Windows tool that lets you compare and modify the contents of files and directories.

### 3.10.1 Array Visualizer Program Folder Contents

If you installed the Array Visualizer, an Array Visualizer program folder appears. To see the items in the folder:

1. From the Start menu, click Programs.
2. Click Compaq Array Visualizer to display the items you have installed.

The items are:

- Array Viewer
- Array Visualizer Documentation (in HTML Help Viewer format)
- Array Visualizer Readme
- Array Visualizer Release Notes

### 3.11 After Installation: Must-Do Task

After installation, every user needs to apply the Per-User Setup option before using Visual Fortran. This must be done no matter what operating system is in use or what type of license you purchased. See Section 4.1, Applying the Visual Fortran Per-User Setup Option.

**Note:** To start Visual Fortran, see Section 6.2, How to Start the Visual Development Environment.
This chapter contains the following sections:

- 4.1, Applying the Visual Fortran Per-User Setup Option
- 4.2, Specifying the COM Server Wizard as a Developer Studio Add-in (Professional and Enterprise Editions Only)
- 4.3, Performing Compilations with a Concurrent-Use License
- 4.4, Copying Visual Fortran Project Files
- 4.5, Changing Installation Options or Reinstalling Visual Fortran
- 4.6, Setting Up Visual Fortran Online Documentation
- 4.7, Redistributing Visual Fortran Files
- 4.8, Increasing the Stack Size for Programs That Use Large Data Arrays
- 4.9, Installing Visual Fortran Service Update Kits
- 4.10, Removing Visual Fortran Version 6 (6.0, 6.1, 6.5, 6.5A, or 6.6)
- 4.11, Removing Visual Fortran Version 5
- 4.12, Removing Internet Explorer
- 4.13, Removing Array Visualizer
- 4.14, Checking for and Removing Old Environment Variable Definitions
- 4.15, Updating Include and Library Paths After Installing Visual C++
- 4.16, Installing f90SQL-lite

4.1 Applying the Visual Fortran Per-User Setup Option

After installation, every user needs to apply the Per-User Setup option before using Visual Fortran. This must be done no matter what type of license you purchased.
To apply the Per-User Setup option, select it from the Compaq Visual Fortran program folder. If you are not sure the Per-User Setup option was previously applied, it is safe to apply it multiple times for the same account.

After installing (or reinstalling) Visual Fortran, if you do not apply the Per-User Setup option, you might encounter difficulties locating the Visual Fortran driver image `DF.EXE` and viewing Fortran data in the visual development environment debugger. For example, you might have trouble compiling Visual Fortran programs or might not be able to view the contents of arrays within the debugger.

4.2 Specifying the COM Server Wizard as a Developer Studio Add-in (Professional and Enterprise Editions Only)

The Visual Fortran COM server wizard is implemented as a Developer Studio add-in. (An add-in lets you automate routine tasks in the Developer Studio environment.) After you install Visual Fortran, you need to register and load the COM server wizard on your system.

If you have not already done so, do the following:

1. In the Developer Studio Tools menu, click Customize.
2. Click the Add-ins and Macro Files tab.
3. Turn on the checkbox for the Fortran COM server wizard if it is displayed in the list.
4. If it is not displayed, click the Browse button and find the `CSAddin.dll` file in the following directory:
   \Microsoft Visual Studio\Common\MSDev98\Addins\Df98\`
5. Click the Close button.

You only need to perform this procedure once on your system.

4.3 Performing Compilations with a Concurrent-Use License

For sites that purchased a concurrent-use license, the FLEXlm software license manager must be installed on a license server, as described in Chapter 5, Using a Concurrent-Use License.

The first time a user runs Visual Fortran, a short procedure must be followed. See Section 5.5, Running Visual Fortran for the First Time.
4.4 Copying Visual Fortran Project Files

When you create a project, you can specify where the project folder is created. If you accepted the default directory both during installation and when creating the project, the new project is created in a directory under:

\Program Files\Microsoft Visual Studio\My Projects

You should make backup copies of your project folders periodically.

The project files for Visual Fortran Version 5 and Version 6 are different. If you open a Visual Fortran project that was created using Visual Fortran Version 5, a Visual Fortran dialog box asks you whether you want to convert the project files to Version 6 format.

If your development environment requires that you use both Version 5 and Version 6, copy the Version 5 project directory and its files to another location first, before converting the project to Version 6.

For more information, see Section 6.3, Visual Fortran Projects and the Copying Projects topic in the online Programmer’s Guide.

4.5 Changing Installation Options or Reinstalling Visual Fortran

If you need to install additional components of the same Visual Fortran version, do not remove Visual Fortran. For example, if you previously performed a Typical installation and need to install additional components by using a Custom installation, perform the Custom installation without removing Visual Fortran.

You should remove Visual Fortran before reinstalling it if any of the following apply:

- You need to remove previously installed Visual Fortran components.
- You need to install Visual Fortran on a different disk drive.
- You are having certain problems with Visual Fortran or the Microsoft visual development environment (such as disk errors) that might be fixed by reinstalling Visual Fortran files.

When reinstalling Visual Fortran, accept the previous location unless you need to install Visual Fortran on a different drive.

If you need to install Visual Fortran on a different drive, specify a different disk location using the Directory buttons. Before reinstalling Visual Fortran, you can remove Visual Fortran from the last directory locations, but you will need to copy your source and other project-related files to the corresponding directories if you specify a new location.

To remove Visual Fortran Version 6, see Section 4.10, Removing Visual Fortran Version 6 (6.0, 6.1, 6.5, 6.5A, or 6.6).
To remove Visual Fortran Version 5, see Section 4.11, Removing Visual Fortran Version 5.

To run the Visual Fortran installation procedure, see Section 3.4, Installing Visual Fortran.

4.6 Setting Up Visual Fortran Online Documentation

If you have the Microsoft MSDN online documentation installed (such as for a Microsoft Visual Studio product or subscription), the MSDN Library might be the default online documentation that you see when you run Visual Fortran.

If this is the case, you can change your default online documentation collection to be Visual Fortran.

For details on how to do this, see Section 9.9, Changing the Current Collection.

For details on using the HTML Help Viewer, see Chapter 9, Using the HTML Help Viewer.

4.7 Redistributing Visual Fortran Files

You might need to redistribute files. This means that you might need to send your Visual Fortran application files to a system that does not have your version (or a later version) of Visual Fortran installed.

Visual Fortran provides a run-time redistributables kit that you can download from the Compaq Fortran Web site to help with this redistribution. It is strongly recommended that you download this kit if you need to redistribute files. See Section 4.7.2, Using the Run-Time Redistributables Kit to Redistribute Files for details.

A separate kit is provided for applications that use Array Visualizer components. See Section 4.7.2.1, Array Viewer Run-Time Redistributables Package.

4.7.1 Which Files Might Need to be Redistributed?

If your application does not use dynamic-link libraries (it links only against static libraries), does not use the Fortran QuickWin or Fortran Standard Graphics project type, and does not use ActiveX controls in a dialog box, you do not need to redistribute any files.

If your application uses the Fortran QuickWin or Fortran Standard Graphics project type, you need only one redistribution file: FQWIN.HLP. See Section 4.7.3, Files in the Redistribution Folders. (These two project types do not use dynamic-link libraries.)
If your application uses dynamic-link libraries, you will need to redistribute certain DLLs. See Section 4.7.4, Redistributing Dynamic-Link Libraries (DLLs).

The following files may be redistributed without permission:

- The files in the various Redist redistribution folders on the Visual Fortran and Array Visualizer CD-ROMs. (These files are contained in the two run-time redistributables kits.)

- Any application that calls the CXML libraries. CXML libraries are provided in static form at /X86/DF/CXML/Lib/Cxml.lib and in dynamic-link library form at /X86/DF/CXML/Redist/Cxml.dll.

- Any application that calls the IMSL libraries, subject to the terms and conditions of the Visual Numerics License Agreement Form. IMSL libraries are provided in static form.

Other files from the Visual Fortran kit may not be redistributed.

4.7.2 Using the Run-Time Redistributables Kit to Redistribute Files

A run-time redistributables kit (also known as VFRUNxx, where xx is the version number) is provided by Visual Fortran to help you redistribute files. This kit installs redistributable run-time components.

The main advantages of using this kit rather than copying files manually are that it:

- Installs all the redistribution files that you might need.
- Registers all the DLLs that need to be registered.
- Properly handles system files such as MFC42.DLL and MSVCRT.DLL that you might have trouble copying (because they are always in use).

It is strongly recommended that you download this kit and run the executable if you need to redistribute any files.

To download the kit and run the executable:

1. Open the Fortran home page at:
   
   http://www.compaq.com/fortran

2. Click on Downloads and Updates in the left margin.

3. Click on Run-Time Redistributables Kit under the Compaq Visual Fortran heading.

4. Download the appropriate self-installing executable for your system and run it.

For applications that use the Array Visualizer, see Section 4.7.2.1, Array Viewer Run-Time Redistributables Package.
4.7.2.1 Array Viewer Run-Time Redistributables Package

A separate run-time redistributables package is provided for applications that use Array Visualizer components.

To download the kit and run the executable:

1. Open the Fortran home page at:
   http://www.compaq.com/fortran

2. Click on Downloads and Updates in the left margin.

3. Click on Compaq Array Viewer Demo and Redistributables Kit under the Compaq Visual Fortran heading.

4. Download the appropriate self-installing executable for your system and run it.

4.7.3 Files in the Redistribution Folders

Some of the files in the Redist folders that you can redistribute are:

- **DFORRT.DLL** is needed for any single-threaded Visual Fortran application.
  Because **DFORRT.DLL references MSVCRT.DLL** (in \VC\Redist), you would need to copy **DFORRT.DLL** and **MSVCRT.DLL** (as well as any other DLL files referenced) to the target system. (This is done automatically by the run-time redistributables kit.)

- **DFORMD.DLL** is needed for any multithreaded Visual Fortran application.
  Because **DFORMD.DLL references MSVCRT.DLL** (in \VC\Redist), you would need to copy **DFORMD.DLL** and **MSVCRT.DLL** (as well as any other DLL files referenced) to the target system. (This is done automatically by the run-time redistributables kit.)

- **DFDLG100.DLL** is needed for any Visual Fortran application that uses ActiveX controls in dialog boxes.
  Because **DFDLG100.DLL references MSVCRT.DLL** (in \VC\Redist), you would need to copy **DFDLG100.DLL** and **MSVCRT.DLL** (as well as any other DLL files referenced) to the target system. Also, **DFDLG100.DLL** must be registered on the target system. (This is done automatically by the run-time redistributables kit.)

- **FQWIN.HLP** allows a user running a Fortran QuickWin or Fortran Standard Graphics application to access the Help menu.
  This should be redistributed only with applications using the Fortran QuickWin or Fortran Standard Graphics project types. (This file is contained in the run-time redistributables kit.)
4.7.3.1 Redistribution Files for Array Visualizer Applications

If your application uses the Array Visualizer, you might need to redistribute the following files in the Redist folders. Note that the Array Viewer run-time distributables package (described in Section 4.7.2.1, Array Viewer Run-Time Redistributables Package) contains these files:

- **AVIEWnnn.DLL** (**AVIEW160.DLL** for Array Visualizer Version 1.6) should be redistributed with your application if it calls the Array Visualizer library routines.

- **Avis2D.OCX** and **AvisGrid.OCX** should be redistributed with your application if it uses these ActiveX interfaces to the Array Visualizer. Also, these OCX files must be registered on the target system.

If the target system does not have Visual Fortran installed, the target system will need to download and install the demo file containing the Array Viewer executable.

To download the Array Viewer demo and run it:

1. Open the Fortran home page at:
   
   http://www.compaq.com/fortran

2. Click on Downloads and Updates in the left margin.

3. Click on Compaq Array Viewer Demo and Redistributables Kit under the Compaq Visual Fortran heading.

4. Download the appropriate self-installing executable for your system and run it.

4.7.4 Redistributing Dynamic-Link Libraries (DLLs)

If you move an application to another system that uses Fortran DLLs, the required DLL (and any DLLs it references) must be placed on the target system before running the application.

The Fortran DLLs are used by an application (either by the .EXE or another DLL) when either of the following is true:

- On the command line, the /libs=dll option is specified.
- In the visual development environment, in the Project Settings window, in the Fortran tab, in the Libraries category, in the Use run-time library field, you have selected any DLL library from the displayed list.

For example, if you run your application on the target system that uses a Fortran DLL (such as DFORRT.DLL) without copying DFORRT.DLL, the following message appears:

The dynamic link library DFORRT.dll could not be found in the specified path

To view whether a DLL references other DLLs:
1 Run Windows Explorer.
2 Locate the CD–ROM drive that contains the Visual Fortran CD–ROM.
3 Locate the appropriate directory (such as \Df\Redist or \VC\Redist or \x86\Redist).
4 Select one of the DLLs you might redistribute (such as DFORRT.DLL).
5 In the File menu, click Quick View.
6 Scroll the displayed text to look under Import Table for information about imported DLLs.

### 4.7.5 Redistributing Files by Hand

If you do not use the run-time redistributables kit described in Section 4.7.2, Using the Run-Time Redistributables Kit to Redistribute Files, you can manually copy the necessary files.

Copy files from the appropriate Redist directory on the Visual Fortran CD–ROM to one of the following directories on the target system:

- The same directory where the executable is placed
- The system DLL area, such as \WINNT\SYSTEM32 on Windows 2000 or Windows NT 4 systems
- A directory specified by the PATH environment variable

For information about the DLL directory search order, see the CreateProcess Win32 API routine. When copying the DLL to the target system, make sure that you are not replacing a newer DLL with an older version.

For files that need to be registered, use the REGSVR32 utility from the Windows system directory.

For applications that use Array Visualizer components, if you do not use the run-time distributables kit described in Section 4.7.2.1, Array Viewer Run-Time Redistributables Package, see Section 4.7.3.1, Redistribution Files for Array Visualizer Applications for Array Visualizer Applications.

To develop an installation procedure for your Visual Fortran application, see File Installation Library in the Platform SDK online title in the HTML Help Viewer.
4.8 Increasing the Stack Size for Programs That Use Large Data Arrays

Certain programs use large amounts of data. In particular, with those programs that use large allocatable arrays (dynamically allocated at run time), certain tasks must be performed to provide enough stack space for the program to run.

Many kinds of variables and expressions can be allocated on the stack. If you are using array intrinsics or expressions, these can use large amounts of stack-allocated temporary storage (temporaries), even if the original variable is static or dynamically allocated.

The default stack size is 1 MB. You can increase this by specifying the linker option /stack:nnnnn, where $n$ is the number of bytes (in decimal) you want for the stack. In Developer Studio, choose the Project menu Settings item, select the Link tab, and add the option switch to the list of Project Options. This switch can also be specified on the DF command line.

To change the stack size of an already-linked executable, use the EDITBIN command, /stack:nnnnn option.

Certain large programs may run into larger limits imposed by the operating system. For example, Windows NT Version 4 Service Pack 3 (or later) and Windows 98 extend the addressable range of static storage. See the Visual Fortran release notes, described in Section 2.2, Release Notes.

4.9 Installing Visual Fortran Service Update Kits

Visual Fortran service update kits provide fixes to problems discovered since the release of Visual Fortran for a particular version. For information on service update kits, see the Compaq Fortran home page at:

http://www.compaq.com/fortran

The service update kits need to be downloaded and carefully applied. For example:

- Do not attempt to install a Version 5 service update kit to Visual Fortran Version 6.
- Do not attempt to install a service update kit until previous service update kits required by that service update kit have already been installed.

Read and follow the directions in the download area carefully.

4.10 Removing Visual Fortran Version 6 (6.0, 6.1, 6.5, 6.5A, or 6.6)

If any of the following apply, you should remove Visual Fortran before reinstalling it:
• You need to remove (deinstall) previously installed Visual Fortran components.
• You need to install Visual Fortran on a different disk drive.
• You are having certain problems with Visual Fortran or the Microsoft visual development environment (such as disk errors) that might be fixed by reinstalling Visual Fortran files.

To remove Visual Fortran Version 6 (Version 6.0, 6.1, 6.5, 6.5A, or 6.6), do the following:
1 If you are using a Windows 2000 or Windows NT 4 system, log into an account with Administrator privilege.
2 Click the Start menu.
3 Move the pointer to Settings, then click Control Panel.
4 Double-click Add/Remove Programs.
5 Within the displayed list, click Visual Fortran 6.n.
6 Click the Add/Remove button.

This procedure removes files created by the Visual Fortran installation program and installed during the previous Visual Fortran installation. It does not remove files created by the visual development environment, such as the \Common\MSDev98\Gallery folder, as long as you installed the visual development environment files before you installed Visual Fortran.

After you remove Visual Fortran, you may also need to check and remove old environment variable definitions. See Section 4.14, Checking for and Removing Old Environment Variable Definitions.

4.11 Removing Visual Fortran Version 5

To remove Visual Fortran Version 5 from its last directory location, do the following:
1 If you are using a Windows 2000 or Windows NT 4 system, log into an account with Administrator privilege.
2 Click the Start menu.
3 Move the pointer to Settings, then click Control Panel.
4 Double-click Add/Remove Programs.
5 Within the displayed list, click Visual Fortran Version 5.
6 Click the Add/Remove button.
This Add/Remove Programs procedure removes files created only by the Visual Fortran Version 5 installation procedure. For example, it does not remove files created by Visual Studio Version 5 products, such as the \SharedIDE\Gallery folder.

**Note:** If you have other Visual Studio Version 5 tools installed when you remove Visual Fortran Version 5, they may need to be reinstalled.

After you remove Visual Fortran, you may also need to check and remove old environment variable definitions. See Section 4.14, Checking for and Removing Old Environment Variable Definitions.

If you installed Visual Fortran Version 5 multiple times without removing Visual Fortran Version 5 before an installation, you can use the `uninst` command to complete the removal of additional Visual Fortran files. This extra step is no longer needed for Version 6 installations.

For example, if you originally did a Typical installation and added some Visual Fortran Version 5 components with a Custom installation, there will be multiple `DeIsLn.isu` files in the Visual Fortran installation folder, where `n` is an integer value.

If you are using a dual-boot system, before using the following procedure, use the Control Panel Add/Remove program procedure on both operating systems to remove Visual Fortran registry entries and most of the files.

To remove additional Visual Fortran Version 5 files and delete the specified `DeIsLn.isu` file:

1. On a Windows 2000 or Windows NT 4 system, log into an account with Administrator privilege.
2. Locate the correct `DeIsLn.isu` file in: `\Program Files\DevStudio\DF`
   Use Windows Explorer or My Computer to look in your installation directory (by default subfolders under `\Program Files\DevStudio`) for files with the name `DeIsLn.isu`. (Each time Visual Fortran is installed, a file with this name is created using a value `n`. The first Visual Fortran installation creates `DeIsL1.isu`, the second creates `DeIsL2.isu`, and so on.)
   If there are multiple `DeIsLn.isu` files, note the file with the greatest value of `n`.
3. From a command window or the Run prompt, enter the following `uninst` command, replacing `C:` with the actual device letter, `\Program Files\DevStudio` with the actual directory path, and `n` with the highest number of the `DeIsLn.isu` file:
   ```
   uninst -f "C:\Program Files\DevStudio\DeIsLn.isu"
   ```
   **Note:** If there is only one `DeIsLn.isu` file and you have not yet used the Add/Remove Programs procedure, you should not use the `uninst` command.
   **Note:** Do not enter `uninstall`; enter the command as `uninst`.
   Repeat the `uninst` command multiple times for each `DeIsLn.isu` file, always using the `DeIsLn.isu` file with the greatest value of `n` on the command line.
If you remove Visual Fortran Version 5 after you install Version 6, you need to reinstall Visual Fortran Version 6 with the same options as the current installation to reset the registry entries that are removed when you remove Visual Fortran Version 5.

4.12 Removing Internet Explorer

If you are using a Windows 2000 or Windows NT 4 system, log into an account with Administrator privilege.

If Internet Explorer was provided with your operating system (such as Windows 2000, Windows Me, or Windows 98), consult your operating system documentation about whether you can remove Internet Explorer.

To remove Internet Explorer from the last directory location:

1. Click the Start menu.
2. Move the pointer to Settings, then click Control Panel.
3. Double-click Add/Remove Programs.
4. Within the displayed list, click Microsoft Internet Explorer.
5. Click the Add/Remove button.

For information about installing Internet Explorer, see Section 3.4.4, Installing Internet Explorer.

4.13 Removing Array Visualizer

To remove the Array Visualizer (included with the Professional and Enterprise Editions):

If you are using a Windows 2000 or Windows NT 4 system, log into an account with Administrator privilege.

1. Click the Start menu.
2. Move the pointer to Settings, then click Control Panel.
3. Double-click Add/Remove Programs.
4. Within the displayed list, click Compaq Array Visualizer.
5. Click the Add/Remove button.
4.14 Checking for and Removing Old Environment Variable Definitions

When you installed Visual Fortran, if you allowed the setup process to update your environment variables, you need to remove these changes manually.

For example, if you have installed Visual Fortran Version 6 on a system where Visual Fortran Version 5 was previously installed, you need to check the environment variables. If you no longer need to use Version 5, you can safely remove the old Version 5 directory paths (listed in Section 2.6, Considerations for Installing with Visual Fortran Version 5). Removing unneeded Version 5 directory paths can improve Visual Fortran build performance and can eliminate the cause of certain unexpected errors.

4.14.1 Removing Environment Variable Definitions on Windows 98 and Windows 95 Systems

On Windows 98 and Windows 95 systems, make a backup copy of your AUTOEXEC.BAT file and then carefully edit the AUTOEXEC.BAT file in the root directory of your system disk:

1. Locate lines that contain the following:
   
   ```
   rem - lines added by Visual Fortran x.x.x on MM-DD-YYYY
   call x:\dirname\...\DFVARS.BAT AUTOEXEC
   rem - end of lines added by Visual Fortran x.x.x Setup
   ```

   For example, environment variables defined by Visual Fortran Version 5 when the default installation directory was used might contain:

   ```
   rem - lines added by Visual Fortran 5.0.0 on MM-DD-YYYY
   call C:\Program Files\DevStudio\Df\DFVARS.BAT AUTOEXEC
   rem - end of lines added by Visual Fortran 5.0.0 Setup
   ```

2. Carefully remove each set of old lines for previous versions of Visual Fortran from this file.

3. Save the AUTOEXEC.BAT file before you exit the editor.

4.14.2 Removing Environment Variable Definitions on Windows 2000 and Windows NT 4 Systems

On Windows 2000 and Windows NT 4 systems:

1. Log into an account with Administrator privilege.
2 Click the Start menu, then click Settings.
3 Click Control Panel.
4 Click System.
5 Windows 2000 systems: Click the Advanced tab and then click the Environment Variables button.
   Windows NT 4 systems: Click the Environment tab.
6 View the displayed environment variables.
   For example, in the System Variables, check the definitions of the Path variable, which is used by Visual Fortran and other products:
   • Double-click the Path variable.
   • Near the bottom of the window, the variable Path and its full definition appear.
   • Check the device and directory definitions of the Path variable. If an older directory path exists, remove it. Directory path names are delimited by semicolons (;) and the last path name might contain %SystemRoot%.
   Check the INCLUDE and LIB variables (used by Visual Fortran and other program development products).
   With the Professional and Enterprise Editions, check the LINK_F90 and VNI_F90_MSG environment variables.
7 To have the environment variable changes take effect immediately, click Apply.
8 Click OK (to allow changes to be made) or Cancel (to not allow changes to be made.

4.14.3 Removing Environment Variable Definitions on Windows Me Systems

On Windows Me systems:
1 Click the Start menu, then click Run.
2 Enter MSCONFIG in the Open field, then click OK. The System Configuration utility window appears.
3 Click the Environment tab.
4 Follow the instructions starting at Step 6 in Section 4.14.2, Removing Environment Variable Definitions on Windows 2000 and Windows NT 4 Systems.
4.15 Updating Include and Library Paths After Installing Visual C++

**Note:** The information in this section applies only to sites that installed Visual C++ Version 6.0 after installing Visual Fortran Version 6.6.

If you install Visual C++ V6.0 after Visual Fortran, the Visual C++ installation does not update the Include and Library paths used by Developer Studio to include the MFC and ATL paths. You can add these yourself as follows:

1. Select the Options entry from the Developer Studio Tools menu.
2. Select the Directories tab.
3. In the Show directories for: box, choose the type of path you wish to modify (in this case, Include files).
4. Double-click on the last (empty) entry, and use the ellipsis button to browse for the MFC\INCLUDE and ATL\INCLUDE directories and add them to the list.

Use a similar procedure to add the MFC\LIB directory to the Library Files list.

4.16 Installing f90SQL-lite

f90SQL-lite from Canaima Software is a library that makes it possible for Fortran applications to directly read and write data stored in databases that are compliant with the Open Database Connectivity (ODBC) API such as Microsoft Excel, Microsoft Access, and Oracle.

To install f90SQL-lite, insert the Visual Fortran CD–ROM and run the \<cd>: F90_SQL\setup.exe file, where \<cd> is the drive letter of the CD drive that contains the CD–ROM.

**Note** Before you perform the installation, see the \F90_SQL\readme.txt file on the CD–ROM, which contains installation notes.

To remove f90SQL-lite, use Add/Remove Programs in the Control Panel.

For more information about f90SQL-lite, see Section 7.9, Using f90SQL-lite.
This chapter contains the following sections:

- 5.1, What is the License Manager?
- 5.2, Installing the License Manager
- 5.3, Obtaining the License Key File
- 5.4, Configuring the License Manager
- 5.5, Running Visual Fortran for the First Time
- 5.6, How the License Manager Works

Note: This chapter applies only to sites that purchased a concurrent-use license.

5.1 What is the License Manager?

If you purchased a concurrent-use license, you will receive a single Visual Fortran kit and a single license letter.

Visual Fortran uses the FLEXlm software license manager from GLOBE trotter, Inc. to limit the number of concurrent users to the specified number of uses (compilations) that you purchased.

To use the concurrent-use license at your site, the following steps must be completed:

1. The license manager software needs to be installed. See Section 5.2, Installing the License Manager.
2. You must obtain the license key file from Compaq. See Section 5.3, Obtaining the License Key File.
3. The license manager software needs to be configured. See Section 5.4, Configuring the License Manager.
The *FLEXlm End Users Manual*, with information for both the administrator and end user, is provided in PDF format and is copied to the directory where you install the software.

### 5.2 Installing the License Manager

The license manager software must be installed and configured on a server node that is accessible by TCP/IP from all client PCs that will be using Visual Fortran.

This server node must be running Windows 2000, Windows NT 4, Windows Me, Windows 98, or Windows 95. It need not have Visual Fortran installed on it.


To install the server components, run `CVF-Network-License-Server.exe` on the server node. It will use the `C:\FLEXLM` folder as the default location for the installed files, but you can specify another location. If you already have the FLEXlm license manager software running on the server node, choose the location of the existing files.

The files unpacked into the license manager folder are:

- `enduser.pdf`: *The FLEXlm End Users Manual* from GLOBE trotter, Inc.
- `lmgrd.exe`: Common license manager service
- `compaq.exe`: Compaq-specific license manager service (daemon)
- `lmtools.exe`: Windows interface configuration utility
- `lmutil.exe`: Command-line interface configuration utility

Now see Section 5.3, Obtaining the License Key File.

### 5.3 Obtaining the License Key File

The license key file is a text file that you can obtain from Compaq in several ways:

- Over the Web
- By e-mail
- By fax
- By telephone

To obtain the license key file, follow the instructions provided on a separate sheet enclosed with your Visual Fortran kit.

**Note:** Enter the word ANY into the first HostID box and leave the others blank.
Save the license key file to the license manager folder as a file called FORTRAN.LIC. If you receive it by e-mail, you can simply save the complete e-mail message, because the e-mail headers are ignored.

When saving, be sure to select *Files of type: All files (*.*)* in the Save As dialog box. If you don’t, Windows will likely append .TXT to the file name. This is especially a problem if your system is left in the default state where registered file types are hidden from the display of file names.

A license key file will look something like this:

SERVER this_host Any 7166
DAEMON COMPAQ
INCREMENT VisFortran COMPAQ 6.6 1-jan-0001 10 1234567890AB DUP_GROUP=UH
INCREMENT VisFortranPro COMPAQ 6.6 1-jan-0001 10 BA0987654321 DUP_GROUP=UH

For a description of the license key file format, read the *FLEXlm End Users Manual* installed into the license manager directory.

A Standard Edition license will not contain the second INCREMENT line.

There might be additional fields in the INCREMENT lines.

The 1-jan-0001 date in the INCREMENT line indicates a permanent (non-expiring) license.

The 7166 on the SERVER line is the TCP/IP port number to be used by the license manager. The license you receive might have a different port number. You can edit this if needed, but users at your site will need to know the port number.

Do not edit other fields except where specified by the *FLEXlm End Users Manual*.  
Note: Compaq does not currently use Host IDs, as discussed in the manual.

Once the license key file has been saved as FORTRAN.LIC in the license manager folder, you are ready to see Section 5.4, Configuring the License Manager.

### 5.4 Configuring the License Manager

You need to configure the license manager to read the license file and make licenses available to the network.

To configure the license manager:

1. Run lmtools.exe from the license manager folder. You will see an initial window that looks like Figure 5-1:
2 Click on the *Configuration using Services* radio button.

3 Click on the Configure Services tab.

   In the *Service Name* field, enter Compaq.

   For *Path to the lmgrd.exe file*, enter the complete path to lmgrd.exe in the license manager folder or click *Browse* to browse to that file and select it.

   For *Path to the license file*, enter or browse to the complete path to the saved FORTRAN.LIC file.

   For *Path to the debug log file*, enter the complete path for a file where log records will be written. This would typically be debug.log in the license manager folder. The *Start server at power up* and *Use Services* buttons will automatically be enabled.

   The window should now look like Figure 5-2:
Figure 5-2  Configure Services Tab in LMTOOLS

4  Click Save Service and then Yes to confirm saving the new Compaq service.
5  Click on the Start/Stop/Reread tab.
6  Click on Start Server. The license manager is now running and will restart automatically whenever the system reboots.

   You can confirm that the manager is running by clicking on the Server Status tab and then the Perform Status Enquiry button. Exit the configuration utility using File: Exit.

   Inform the users of Visual Fortran at your site of the port number and node name of the server where the license manager software resides.

5.5 Running Visual Fortran for the First Time

   The first time a user runs Visual Fortran, the FLEXlm License Finder dialog box will appear, as shown in Figure 5-3:
The following steps are necessary only the first time the compiler is run on each system:

1. Making sure that the *Specify the License Server* radio button is selected, click *Next*.

2. Enter the port number and node name of the license server in the form `port@node`, for example, `7166@servernode.ourcorp.com`. Click *Next*. A message should appear saying ‘The FLEXlm license finder has completed.’.

3. Click *Finish* to continue.

### 5.6 How the License Manager Works

When an individual user does a compilation, a license is acquired from the server. If none is available, the request is queued and the compiler will wait for up to five minutes. (This can be set or changed by a registry entry. For details, see the Visual Fortran release notes described in Section 2.2, Release Notes.)

If the request times out, an error message is displayed. Once a particular user has finished a compilation, that user, on the same system, has the license reserved for an additional five minutes (this cannot be changed). The additional five minutes allows for multiple compilations to be performed in sequence without the risk of losing the license in midstream.
CHAPTER 6

Using Visual Fortran

This chapter contains the following sections:

- 6.1, What is the Visual Development Environment?
- 6.2, How to Start the Visual Development Environment
- 6.3, Visual Fortran Projects
- 6.4, Visual Development Environment Windows
- 6.5, Getting Online Help
- 6.6, Project Configurations and Settings
- 6.7, How to Build an Existing Visual Fortran Project (Celsius)
- 6.8, How to Edit a Source File
- 6.9, How to Debug a Source File
- 6.10, How to Create a New Project Based on Existing Source Files
- 6.11, Customizing the Visual Development Environment
- 6.12, Using the Text Editor
- 6.13, Using the Source Browser
- 6.14, Using the Resource Editors
- 6.15, Using the Debugger

Note: This chapter provides a brief introduction to the Microsoft visual development environment. For a more comprehensive understanding, you will need to use the Microsoft documentation.
6.1 What is the Visual Development Environment?

The Microsoft visual development environment is a graphical, user-friendly interface allowing you to manipulate your Visual Fortran files.

**Note:** You can also use Visual Fortran from the command line. See Section 7.3, Using the Command-Line Interface.

Using the visual development environment, you can:

- Examine your Fortran source code and make changes and additions to it
- Create input data files and modify the input data
- Compile and link your program
- Debug the errors associated with compiling and linking your program
- Debug logic errors in your program
- Examine your program’s output files
- Create Fortran programs using dialog boxes, windows, and other graphics to receive data and display results

The visual development environment includes:

- A project manager to let you automate application builds according to your specifications and tools settings (see Section 6.3, Visual Fortran Projects, and Section 6.6, Project Configurations and Settings)
- A text editor (see Section 6.12, Using the Text Editor)
- A source code browse window (see Section 6.13, Using the Source Browser)
- Resource editors (see Section 6.14, Using the Resource Editors)
- A debugger (see Section 6.15, Using the Debugger)
- A *linker* supporting incremental linking for faster builds following small changes to the source file
- A profiler for determining the execution frequency of various code paths

Because these tools run under Windows 2000, Windows NT 4, Windows Me, Windows 98, and Windows 95, you can use a variety of Windows features to work faster and more efficiently. For example:

- You can select a variable name in an editor window while debugging, drag that name into the Watch window, and drop it there. The debugger then evaluates the variable and displays the result in the Watch window.
- You can select a control from the toolbar in the dialog box editor and drop it onto a dialog box you are creating. You can then size and position the control as required for your application.
The visual development environment includes toolbars that allow you to quickly invoke commands by clicking a button. You can customize the default toolbar to suit your needs, or you can create your own toolbars. To see a brief description of a toolbar button, you can position the mouse pointer over the button for a second or two (without clicking).

6.2 How to Start the Visual Development Environment

To start Visual Fortran:

1. From the Start menu, click Programs.
2. Click Compaq Visual Fortran 6 to display the contents of the program folder.
3. Click Developer Studio.

The Microsoft visual development environment appears.

To quit Visual Fortran, choose Exit from the File menu.

6.3 Visual Fortran Projects

In Visual Fortran, development is organized into projects consisting of the source files required to build an application. To set up a project, you need to define the project and set options for it. Then, using the source files, you can build the binary executable or library file. The output of building the application becomes part of the project. A project is stored in a project folder on your hard drive.

Every Visual Fortran project must be one of the following project types:

- Fortran Console application.
- Fortran QuickWin application.
- Fortran Standard Graphics application.
- Fortran Windows application.
- Fortran COM Server application. A Fortran COM Server project is a special-purpose project that lets you create COM servers or dual-interface servers using the Fortran COM server wizard. (Available only with the Professional and Enterprise Editions.)
- Fortran Static Library application (file extension .LIB). A static library is a set of routines that can be called from procedures that are loaded into your application at link time.
- Fortran Dynamic-Link Library (DLL) application (file extension .DLL). A DLL is a set of routines that can be called from procedures that are loaded into your application at run time.
Projects are contained in a *workspace*. A workspace can contain multiple projects. For example, if you have several Fortran applications that do different calculations but are related to the same research application you’re working on, you can store all the individual projects in a workspace. A workspace file has the file extension `.dsw`.

You need to create a separate project for each binary executable or library file to be created. For example, the main Fortran program and a Fortran dynamic-link library could each reside as:

- Separate projects in the same workspace
- Separate projects in separate workspaces

Table 6-1 describes some project types.

<table>
<thead>
<tr>
<th>Project Type</th>
<th>Typical Appearance, Programming Complexity, and Location of Online Samples</th>
</tr>
</thead>
</table>
| Fortran Console application      | Appearance: One character-cell terminal window.  
Complexity: Simple, resembles character-cell applications.  
Location: As described in Section 6.7, see:  
\Microsoft Visual Studio\Common\MSDev98\My Projects\Celsius                                                                 |
| Fortran Standard Graphics or     | Appearance: One window (Standard Graphics) or multiple windows (QuickWin) with graphics such as menus, charts, and icons.  
Complexity: Simple to moderate, depending on the graphics and user interaction used.  
Location: See folders such as Qwpiano or Qwpaint in:  
\Microsoft Visual Studio\Common\DF98\Samples\Quickwin                                                                 |
| Fortran QuickWin application      |                                                                                                                                  |
| Fortran Windows application      | Appearance: Multiple windows using full graphics interface and Win32 API functions.  
Complexity: Advanced, requires programming expertise for Win32 API.  
Location: See folders such as Platform or Polydraw in:  
\Microsoft Visual Studio\Common\DF98\Samples\Advanced\Win32                                                                 |

You can convert a Fortran Console or Fortran Standard Graphics application to a Fortran QuickWin application by creating the Fortran QuickWin project as a new project, setting the same Project settings, and adding files to the Fortran QuickWin project.

For an example of a multiple project, see the SPLINE mixed-language sample program. This sample contains multiple projects in one workspace, including a Fortran dynamic-link library called either by the main Fortran QuickWin program or the main Visual C++ program. See Section 7.1, Using the Sample Programs.

### 6.4 Visual Development Environment Windows

Figure 6-1 shows an example of the visual development environment.
The left pane contains a FileView tab and may contain a ClassView or ResourceView tab:
- **FileView**: Shows each project and their files associated with the workspace.
- **ClassView**: Appears only if Visual C++ is installed. ClassView is used by Visual C++ for mixed-language programming and is not used by Visual Fortran.
- **ResourceView**: Appears if the workspace uses Resources. (A *Resource* is binary data added to an application's executable file. Examples are dialog boxes and icons.)

After you open a workspace, the FileView tab shows the files associated with that workspace. In the FileView pane of Figure 6-1, there are two files: *calendar.f90* and *calnmod.f90*.

The file *calnmod.f90* defines a Fortran 90 module file (a post-compiled binary file with an extension of *.mod*) that is used by *calendar.f90*. Because *calendar.f90* is dependent on the *calnmod.mod* file being present, it is listed under External Dependencies.

In the right pane of Figure 6-1, the file *calendar.f90* is shown in the default language-sensitive visual development environment editor, which uses different colors to identify the following:
- Source comments (green)
- Fortran standard language elements (blue)
- Other language text (black)
To edit a file listed on the FileView pane, either double-click its file name or use the Open item in the File menu.

The output pane appears in the bottom of Figure 6-1, showing text displayed from building the project. The output pane has multiple tabs. The output pane Build tab is selected after you open a workspace and compile one or more project files or build the project. To display the output pane, select Output from the View menu.

### 6.4.1 Floating Windows and Docking Windows

A *floating window* can be moved and has a title bar. To move a floating window, drag its title bar.

A *docking window* is docked (attached) along an edge of the visual development environment window and does not have a title bar.

To allow a docking window to float (not be docked) or to allow a floating window to dock along an edge, do one of the following:

- Right-click the appropriate window.
- Select the Window menu option Docking View.

To specify which visual development environment windows will be docked windows and which will be floating windows:

1. In the Tools menu, select Options.
2. Click the Workspace tab.
3. In the Docking View list, click the checkbox for each window to be displayed with a docking view. Unchecked boxes indicate floating windows.

To cycle through your floating windows in the visual development environment, hold down the Ctrl key and click Tab.

### 6.5 Getting Online Help

You might need help while you are working in the visual development environment. To display information about an option in a dialog box, for example, do either of the following:

- Click the ? (Help) button and click the item you want help on.
- Move your pointer to the item you want help on and click F1.

For more information, see:

- Section 7.6, Viewing Online Documentation in the HTML Help Viewer
- Chapter 9, Using the HTML Help Viewer
6.6 Project Configurations and Settings

Each project can specify one or more configurations to build from its source files. A configuration specifies such things as the type of application to build, target platform, and the settings to use when building, such as compiler and linker options.

When you create a project, a Debug and a Release configuration are automatically created:

- A **Debug configuration** contains full symbolic debugging information that can be used by the debugger. Typically, no optimization or minimal optimization is used.
- A **Release configuration** does not contain any symbolic debugging information. It contains default optimizations, or your selected optimizations if you have overridden the defaults.

Having multiple configurations lets you extend the scope of a project but still maintain a consistent source code base from which to work.

To specify the current configuration, from the Build menu select Set Active Configuration. When you build your project, the currently selected configuration is built.

Within a project, you can create groups or folders that contain related files. FileView displays the folders and files contained in the project as a graph so you can quickly see the relationships among files.

From the Project menu, select Settings to specify settings for the entire project, for certain configurations, or for certain files. For instance, you can specify certain kinds of compiler optimizations for your project in general, but turn them off for certain configurations or certain files.

Once you have specified the files in your project, the configurations that you want your project to build, and the settings for those configurations, you can build the project with the commands on the Build menu.

For more information about projects:

- Open the sample project Celsius. See Section 6.7, How to Build an Existing Visual Fortran Project (Celsius).
- See Building Programs and Libraries in the online *Programmer’s Guide* described in Section 8.2, Documentation Available in HTML Help Viewer Format.

6.7 How to Build an Existing Visual Fortran Project (Celsius)

For information about Visual Fortran projects, see Section 6.3, Visual Fortran Projects.

To open and execute the sample project workspace file, **Celsius.dsw**:
1 Start Developer Studio (see Section 6.2, How to Start the Visual Development Environment).

2 From the File menu, choose Open Workspace.

   The Open Workspace dialog box appears, displaying the default projects directory. The default installation location for the Celsius project workspace is the folder \Program Files\Microsoft Visual Studio\Common\MSDEV98\My Projects.

3 In the list of files and directories within the My Projects folder, double-click the Celsius folder.

   The files and directories list now displays the Celsius workspace file.

4 Select the Celsius workspace file, Celsius.dsw.

5 Click the Open button.

   The visual development environment displays the contents of the Celsius project in the FileView pane. You can click the plus sign (+) next to the Celsius folder to see the contents of the project. In this case, there is only one file, CELSIUS.FOR.

6 From the Build menu, choose Build Celsius.exe.

   The status of the build is displayed in the Build pane at the bottom of the screen.

7 From the Build menu, choose Execute Celsius.exe to run the program. A console output window appears, displaying the output from the program.

8 If you want to use the debugger for this project, see Section 6.9, How to Debug a Source File.

9 When you are done with this project, select Close Workspace from the File menu.

Visual Fortran includes a number of sample projects, most of which include a project workspace file. See Section 7.1, Using the Sample Programs.

6.8 How to Edit a Source File

The text editor allows you to edit your projects.

The following information assumes you have opened the Celsius workspace in the folder \Program Files\Microsoft Visual Studio\Common\MSDEV98\My Projects and have built the Celsius project. (See Section 6.7, How to Build an Existing Visual Fortran Project (Celsius).)

To edit the Celsius source file CELSIUS.FOR:

1 The contents of the Celsius project are displayed in the FileView pane. Click the plus sign (+) next to the Celsius folder to see the contents. In this case, there is only one file, CELSIUS.FOR. (If you had any INCLUDE files, they would be listed under External Dependencies.)
2 Double-click on the CELSIUS.FOR file name in the FileView pane. The text editor window appears, displaying the source contents of CELSIUS.FOR.

Because CELSIUS.FOR is a fixed-form source file, the text editor shows where column 6 is.

3 Click on a line you want to edit and enter the corrections. For example, change the DO loop to have a stride different from 10.

To save the edited file, click Save in the File menu.

4 Build the revised program by clicking the Build Celsius.exe menu item in the Build menu.

For more information, see Section 6.12, Using the Text Editor.

### 6.9 How to Debug a Source File

The debugger allows you to debug your projects.

The following information assumes you have opened the Celsius workspace in the folder `\Program Files\Microsoft Visual Studio\Common\MSDEV98\My Projects`.

From the Build menu, select Set Active Configuration. Select the Debug configuration. Then build the Celsius project. (See Section 6.7, How to Build an Existing Visual Fortran Project (Celsius).)

To debug the Celsius source file CELSIUS.FOR:

1 Click the first executable line to set the cursor position. In this case, click on the beginning of the first PRINT statement line.

2 Click on the Set/Remove Breakpoint (open hand symbol) button in the Build toolbar, as shown in Figure 6-2.
The red bullet in the left margin of the text editor/debugger window shows where a breakpoint is set.

3 In the Build menu, click the Start Debug: Go item, as shown in Figure 6-3.

Figure 6-3  Starting the Debugger
The debugger is now active. The current position is marked by a yellow arrow at the first executable line (the initial breakpoint).

The Debug menu appears on the Developer Studio title bar in place of the Build menu.

If not displayed previously, the Debug toolbar appears.

4 Step through the lines of source code. You can do this with the Debug menu item Step Over (as shown in Figure 6-4) or the Step Over button on the Debug toolbar.

**Figure 6-4  Using Step Over in the Debugger**

5 Repeat the Step Over action (use the Debug toolbar). Follow program execution into the **DO** loop, and so on until you are at the end of the program. Position the cursor over the variable **Celsius** to view the current value (called Data Tip), as shown in Figure 6-5.
Figure 6-5  Viewing the Value of a Variable in the Debugger

If you need to build the program again, click on the Stop debugging item in the Debug menu.

When you complete working with the project, click the Close Workspace item in the File menu.

Some additional features of the debugger you can try when it is active are shown in Table 6-2:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Local Variables window</td>
<td>In the View menu, click the Debug Windows, Variables item. Click the Locals tab.</td>
</tr>
<tr>
<td>Display the Watch window</td>
<td>In the View menu, click the Debug Windows, Watch window item.</td>
</tr>
<tr>
<td>Display a value in the Watch window</td>
<td>Select a variable name in the text editor window, drag it, and drop it into the Watch window.</td>
</tr>
<tr>
<td>Set or clear a breakpoint</td>
<td>Click on the line where the breakpoint is to be set or cleared. Then do either of the following:</td>
</tr>
<tr>
<td></td>
<td>– Click on the Set/Remove Breakpoint (open hand symbol) button in the Build toolbar.</td>
</tr>
<tr>
<td></td>
<td>– In the Edit menu, click Breakpoints. A dialog box lets you set or clear breakpoints, evaluate expressions, and perform other functions.</td>
</tr>
</tbody>
</table>

In the Debug menu, click the Stop Debugging item to stop the debugger.
6.10 How to Create a New Project Based on Existing Source Files

To create a new Visual Fortran project based on existing source files:

1 Start Developer Studio (see Section 6.2, How to Start the Visual Development Environment).

2 From the File menu, select New. A dialog box appears containing the following tabs:
   - Files
   - Projects
   - Workspaces
   - Other Documents

3 Select the Projects tab, which displays various project types, as shown in Figure 6-6.

Figure 6-6 New Project Type Dialog Box

You need to:

1 Enter the project name, for example, Solver. The Location field will automatically show a subdirectory for the project.
2 Accept the default location or specify another location. This is the master directory under which projects and workspaces will be created. You can change this to anything you want. If you want it to be where your source files are located now, change it to the name of that directory.

3 Click the type of Fortran project to be created, such as Fortran Console Application. If you have any other Visual tools installed, make sure you select a Fortran project type. See Section 6.3, Visual Fortran Projects.

4 Turn on the Create new workspace radio button to create a new Workspace. (If you were adding an additional project to the currently open workspace, you would turn on the Add to current workspace radio button.)

5 Click OK.

Depending on the project type selected, one or more dialog boxes appear, requesting additional information about the project. For example, one dialog box gives you the option of creating only the project files with no source files (empty project) or a project with a source file that contains a template for that project type.

4 If you chose Fortran Console Application as your project type, you’ll be asked ‘What kind of console application do you want to create?’ Select An empty project.

5 If you chose a Location different from the actual location of the source files, you can copy the files into the project directory if you want, but this isn’t necessary.

If a saved Fortran environment exists for the Fortran project type being created, you can also import that Fortran environment to provide default project settings for the new project. (For more information on saved environments, see Building Programs and Libraries in the online Programmer’s Guide described in Section 8.2, Documentation Available in HTML Help Viewer Format.)

6 Choose Project, then Add to Project, then Files. If necessary, change Files of type to Fortran files. Browse to where your source files are located and select the files. Select only the compilable source files, not any files included by INCLUDE or USE statements.

7 Click OK.

8 Click the Build button to build your application. The Build button looks like an open-topped box with two arrows pointing down. You can usually find it somewhere near the left of the large red exclamation point.

You have now built a Debug configuration, without optimization. The executable file and other output files are in the Debug subfolder in your project directory.

To switch to a Release configuration, choose Build, then Set Active Configuration, then Release. Now click Build again. The executable and other output files will be in a Release subfolder in your project directory.

9 To run the program without the debugger, click on the Run button (the exclamation point). To run in the debugger, you need to set a breakpoint. See Section 6.9, How to Debug a Source File.
See also Section 6.8, How to Edit a Source File.

### 6.10.1 How to Add Files to a Project

You can add files to a project by selecting Add To Project from the Project menu. To add an existing file to a project:

1. Select Files from the submenu.

2. The Insert Files into Project dialog box appears. Use this dialog box to select the Fortran files to be added to the project. To add more than one file to the project, hold down the Ctrl key as you select each file name.

To add a new file to a project:

1. Select New from the submenu.

2. The New dialog box appears. Specify the file name and its location.

3. Click the type of file (Fortran Fixed Format Source or Fortran Free Format Source).

4. Click OK. The editor appears allowing you to enter source code. The file name appears in the FileView pane. For example, you might enter the following short Fortran program and save it as HELLO.F90:

   ```fortran
   ! File HELLO.F90
   PROGRAM HELLO_TEST
   print *, 'hello world'
   print *, ' '
   END PROGRAM HELLO_TEST
   ```

Now you can build and run the program as described previously for an existing project. See Section 6.7, How to Build an Existing Visual Fortran Project (Celsius).

For more information about projects:

- See Building Programs and Libraries in the online *Programmer’s Guide* described in Section 8.2, Documentation Available in HTML Help Viewer Format.

### 6.11 Customizing the Visual Development Environment

There are a number of ways you can customize the visual development environment to suit your preferences:

- You can add and delete buttons from existing toolbars and menus.
You can change any of the default shortcut keys, add shortcut keys, set multiple shortcut keys for a command, and specify the windows in which any shortcut is active.

You can add your own tools to the Tools menu.

You can record keystrokes in a text editor window and then play them back to recreate that sequence of commands.

In text editor windows, you can display language elements, such as comments or keywords, in the color of your choice. You can also display the text in one window in a specific font.

You can establish a layout for the windows associated with a particular project workspace. The visual development environment retains that layout of open files and window positions for the next time you start the project workspace.

When you are debugging an application, you can choose which windows and toolbars to display. The visual development environment retains that selection for all subsequent debugging sessions.

For more information, see The Visual C++ Environment in the online Visual C++ User's Guide (for Visual Fortran) described in Section 8.2, Documentation Available in HTML Help Viewer Format.

### 6.12 Using the Text Editor

The text editor in the visual development environment is a language-sensitive editor that recognizes source code syntax and makes source files easy to read. For example, when you edit a file with an .F90, .F, .FOR, or .FPP extension, the editor presents statements and keywords in a second color. You can customize the keyword coloring.

To view the current keyboard mappings, click the Help menu item Keyboard Map.

To customize the keyboard shortcuts for the text editor:

1. In the Tools menu, choose Customize.
2. Click the Keyboard tab.
3. Select the type of editor (such as main or text) from the Editor drop-down list.
4. Select the category of keyboard shortcuts by using the Category drop-down list. For example, select the appropriate type of operation, such as FileOpen.

   For each operation selected, the shortcut key is shown in the Current keys box.

You can deassign a key combination and assign a new key combination.

You can also view the mapping of a key combination by entering that key combination.
To customize the keyboard commands to match a more familiar text editor, such as Brief or Epsilon:

1. In the Tools menu, choose Options.
2. Click the Compatibility tab.
3. Select the editor emulation from the drop-down list.
4. Select other options by using the checkboxes.

You can open any file in binary form and work with either the ASCII or the hexadecimal representation. You can even look at programs, object files, and libraries this way.

All Visual Fortran keywords (such as Fortran statements and intrinsic functions) are highlighted in a color different from the surrounding text. If you are using fixed-form source, the columns of your source code have different colors, including the label zone, the continuation column, and anything beyond the fixed-form line length (by default, column 72).

To print the text in the text editor to a color printer:

1. Open the file to be printed in the text editor.
2. In the File menu, click Print Colorized Fortran.
3. In the dialog box, to print to a printer other than your default printer or to change printer options, click Launch Browser. The Fortran source file is displayed in your default browser. In your browser's File menu, click Print and select the printer and options needed.
4. Click OK.

For an example of using the text editor, see Section 6.8, How to Edit a Source File.

For more information, see Text Editor in the online Visual C++ User's Guide (for Visual Fortran) described in Section 8.2, Documentation Available in HTML Help Viewer Format.

6.13 Using the Source Browser

As you are developing and debugging your application, you need to see the symbols you are using in a variety of contexts. The source browser in the visual development environment lets you look at symbol usage in the source code and view graphs of calling relationships between functions. Using the source browser makes it easy to maintain, revise, and debug your code.

When you build your application, Visual Fortran can create a browse information file containing information about the symbols in your application. The browse window displays this information and lets you move among instances of the symbols in your
source code. For example, you can move to every place in every file where the symbol is used.

To create a browse information file:
1. In the Project menu, click Settings.
2. Click the Fortran tab.
3. Turn on the Generate Source Browser Information checkbox in the General category.
4. Click the Browse Info tab.
5. Set the Build browse info file option.

Because Fortran is not a case-sensitive language, you should make sure that the source browser is treating symbol names as case-insensitive. After you modify and build your project to generate browse information:
1. In the Tools menu, click Source Browser.
2. Near the bottom of the Browse window, locate the Case sensitive checkbox. If the check box is checked on, click it to remove the check mark.
3. When you are done using the Browse window, click OK.

In the Browse window, you can view graphs of calling relationships among functions. You can easily view all the symbols contained in a given file, display the definition of any symbol in the file along with all its references in your project, and then open the file containing a particular reference by double-clicking the entry in the window.

6.14 Using the Resource Editors

The visual development environment provides resource editors to develop user-interface components such as dialog boxes, menus, and icons for your projects. Dialog editors and menu editors are examples of resource editors.

Visual Fortran supports both modal and modeless dialog boxes. You can use a number of dialog functions to define the dialog boxes and their controls. Among the types of controls supported are ActiveX controls, static text, buttons, edit boxes, group boxes, checkboxes and radio buttons, list and combo boxes, scroll bars, pictures, progress bars, spin controls, sliders, and tab controls.

For example, to build a dialog box, you drop the interface controls onto a blank dialog box in the construction area, save it, and write the code to initialize and use it from your program.

For more information, see the following topics:
- Using Dialogs in the online Programmer’s Guide
- Resource Editors in the online Visual C++ User’s Guide (for Visual Fortran)
6.15 Using the Debugger

For an example of using the debugger, see Section 6.9, How to Debug a Source File. The debugger in the visual development environment helps you check the logic of an executing program and examine or change variables at run time.

After you have corrected all the build errors encountered during compiling and linking, you can use the debugger to correct logic errors. The debugger lets you monitor your program as it runs and stop it at locations or situations of your choosing. For example:

- When you have isolated a problem to a specific part of a program, you can have your application execute until the application reaches a particular line by setting a breakpoint on a line of code. You can set breakpoints by using the Edit menu item Breakpoints or by right-clicking in the left margin of the text editor window.

- When debugging the cause of a message or exception, you can suspend program execution when the program receives a specified message, or when a specific exception occurs.

- If you are interested in the values assigned to a particular variable, you can have the debugger break whenever your application changes the variable’s value.

You can request that Visual Fortran start its debugger for any program that fails while running, regardless of whether the program has debug information or whether Visual Fortran was running beforehand. The debugger starts up while the program is still running, allowing you to analyze the program as it runs. With Just-In-Time debugging, it is possible to find and fix the problem in the program and let it continue running.

For more information, see Debugging Fortran Programs in the online Programmer’s Guide described in Section 8.2, Documentation Available in HTML Help Viewer Format.
This chapter contains the following sections:

- 7.1, Using the Sample Programs
- 7.2, Compaq Fortran Language
- 7.3, Using the Command-Line Interface
- 7.4, Using Compaq Extended Math Library (CXML)
- 7.5, Mixed-Language Programming Support with Visual C++ and Visual Basic
- 7.6, Viewing Online Documentation in the HTML Help Viewer
- 7.7, Using the Array Visualizer
- 7.8, Using the IMSL Libraries (Professional and Enterprise Editions)
- 7.9, Using f90SQL-lite
- 7.10, Using Enterprise Toolkit and Technical Programming Extensions (Enterprise Edition)
- 7.11, Support for COM and Automation Objects: Fortran Module Wizard
- 7.12, Support for Creating COM Servers (Professional and Enterprise Editions)
- 7.13, Interface Definitions for Routines

**Note:** For information about how to use Visual Fortran, see Chapter 6, Using Visual Fortran.

### 7.1 Using the Sample Programs

Visual Fortran has several sample programs that you can view and copy for use with your own projects.
Use a text editor to view the source code samples. They are not listed as topics in the HTML Help Viewer.

**Note:** To install the samples during installation, choose a Custom installation and turn on the Sample Programs checkbox.

For a description of the samples, open the file `Samples.htm` in a Web browser (use the File: Open menu item). Table 7-1 shows where to locate `Samples.htm` and the `Samples` folders on the Visual Fortran CD-ROM (at any time) or on your hard disk (after installation).

### Table 7-1 Location of Visual Fortran Sample Programs

<table>
<thead>
<tr>
<th>To find</th>
<th>See this location:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roadmap to the</td>
<td>On the Visual Fortran CD-ROM, open the file: \info\DF\Samples\Samples.htm\ProjectsFiles\Microsoft Visual Studio\DF98\Samples\Samples.htm</td>
</tr>
<tr>
<td>samples</td>
<td>On your hard disk (after installation), open the file: \Project Files\Microsoft Visual Studio\DF98\Samples\Samples.htm</td>
</tr>
<tr>
<td>Samples folders</td>
<td>On the Visual Fortran CD-ROM, locate folders under: \info\DF\Samples\Samples\Samples.htm\ProjectsFiles\Microsoft Visual Studio\DF98\Samples</td>
</tr>
</tbody>
</table>

For example, after a Custom installation, the \Project Files\Microsoft Visual Studio\DF98\Samples\Tutorial folder contains short example programs. The tutorial samples describe (as source comments) how the programs can be built.

Longer sample programs are also provided in subfolders and include the source files. Most samples include a project workspace file, allowing you to open the project workspace in the visual development environment, view the source files in the FileView pane, build the sample, and run it.

**Note:** If you do not install samples, you can copy the samples folders or files from the Visual Fortran CD-ROM to your hard disk. (Remove the Read-Only Property of the copied files.)

For information about Array Visualizer, CXML, and IMSL samples, see the following sections:

- 7.7, Using the Array Visualizer
- 7.4, Using Compaq Extended Math Library (CXML)
- 7.8, Using the IMSL Libraries (Professional and Enterprise Editions)
7.2 Compaq Fortran Language

Visual Fortran uses the highly efficient, optimizing Compaq Fortran compiler system, which supports the Compaq Fortran language on multiple platforms (architecture and operating system pairs).

The Compaq Fortran language provides a superset of the Fortran 95 standard with extensions for compatibility with:

- Previous versions of Compaq Fortran (DEC Fortran and VAX™ FORTRAN)
- Microsoft Fortran PowerStation Version 4

Compaq Fortran conforms to the following standards:


Fortran 95 provides all the original features of Fortran 90 and FORTRAN 77, and adds the extensions and flexibility of newer languages. Some features of the older standard have been declared obsolete or deleted. Although Visual Fortran still recognizes these features, new application code should use the new constructs provided to replace the obsolete or deleted ones.

Compaq Fortran also supports the most widely used Fortran language extensions supplied by vendors on other platforms.

For information about Fortran 95/90 language features, Compaq Fortran language extensions, and other details about the Compaq Fortran language, see:

- The *Compaq Fortran Language Reference Manual* described in Section 8.1, Printed (Hardcopy) Documentation
- The online *Language Reference* described in Section 8.2, Documentation Available in HTML Help Viewer Format
7.3 Using the Command-Line Interface

In addition to the visual development environment, Visual Fortran supports the use of the command-line interface in a command-line window.

You can use the Fortran Command Prompt, located in the Compaq Visual Fortran 6 program folder.

If you use this icon, the command-line window appears with the DFVars.bat file already executed.

The DFVars.bat file sets the appropriate environment variables (such as PATH, INCLUDE, and LIB) as well as the appropriate environment variables for IMSL routines (when using the Professional or Enterprise Edition) for your command-line window environment. The file is located in the following directory:
\Program Files\Microsoft Visual Studio\Dv98\BIN

If you use an MS-DOS window instead of the Fortran Command Prompt window, you need to execute the DFVars.bat file yourself.

For more information on the command-line interface, see the following topics in the online Programmer’s Guide:

• To compile and link your application with the DF command, see Using the Compiler and Linker from the Command Line.

• For a list of compiler and linker options, see Compiler and Linker Options.

• To use the FL32 command or FL32-style compiler options, see Microsoft Fortran Powerstation Command-Line Compatibility in Compiler and Linker Options.

• To use command-line tools like NMAKE, see Using Visual Fortran Tools.

To access the Programmer’s Guide, see Section 8.2, Documentation Available in HTML Help Viewer Format.

7.4 Using Compaq Extended Math Library (CXML)

The Compaq Extended Math Library (CXML) consists of mathematics routines designed for use in many different types of scientific and engineering applications.

Note: To install CXML during installation, choose a Custom installation and turn on the CXML Libraries checkbox.

The following routines are in CXML:

• Basic Linear Algebra routines (BLAS)

The BLAS routines include the industry-standard Basic Linear Algebra Subprograms for Level 1 (vector-vector or BLAS1), Level 2 (matrix-vector or BLAS2), and Level
3 (matrix-matrix or BLAS3). Also included are subprograms for BLAS Level 1 Extensions, Sparse BLAS Level 1, and Array Math Functions (VLIB).

- **Signal Processing routines**
  
  The Signal Processing routines provide a basic set of signal processing functions. Included are one-, two-, and three-dimensional Fast Fourier Transforms (FFT), group FFTs, Cosine/Sine Transforms (FCT/FST), Convolution, Correlation, and Digital Filters.

- **Sparse Linear System routines**
  
  The Sparse Linear System routines provide both direct and iterative sparse linear system solvers. The direct solver package supports both symmetric and nonsymmetric sparse matrices. The iterative solver package contains a basic set of storage schemes, preconditioners, and iterative solvers.

- **LAPACK routines**
  
  LAPACK is an industry-standard subprogram package offering an extensive set of linear system and eigenproblem solvers. LAPACK uses blocked algorithms that are better suited to most modern architectures, particularly ones with memory hierarchies.

- **Utility routines**
  
  Utility routines include random number generation, array math functions, and sorting subprograms.

CXML includes certain Fortran source and module files, an online PDF file that describes each CXML routine, numerous program samples, and other assorted files.

For more information about CXML, see the following:

- The *Compaq Extended Math Library Reference Guide* described in Section 8.4, Documentation Available in PDF Format.
- Using the Compaq Extended Math Library (CXML) in the online *Programmer’s Guide* described in Section 8.2, Documentation Available in HTML Help Viewer Format.
- The CXML section of the Visual Fortran release notes. See Section 2.2, Release Notes.
- The CXML *readme* file installed in: `\Df98\CXML`
- The CXML samples installed in: `\Df98\CXML\Samples`
7.5 Mixed-Language Programming Support with Visual C++ and Visual Basic

Mixed-language programming occurs when an application has source code written in two or more languages.

Compaq provides Visual Fortran. Microsoft provides Visual C++, Visual J++, Visual Basic, Microsoft MASM (Assembler for IA-32 (x86) systems), and other Visual Studio tools. Mixed-language programming is possible among all these languages.

Mixed-language development is especially easy when you use the same versions of Visual C++ and Visual Fortran, because they use the same visual development environment. Having a common development environment lets you edit, debug, link, and compile Fortran and C/C++ modules transparently.

If you need to use language products that use a different version of the visual development environment (or a different development environment) than Visual Fortran, you cannot use the same visual development environment to build all parts of the mixed-language application.

When other languages in a mixed-language application use a different version of Microsoft’s visual development environment, you can copy object files into your project workspace and use the visual development environment to link them into your application.

Another way to build a mixed-language application is to link the Fortran object module directly into a C/C++ program.

Visual Basic and Visual Fortran do not share the same visual development environment. However, you can use Visual Basic to create a graphical user interface for an application and use Visual Fortran to create Fortran DLLs or a COM server from existing Fortran source code to build the numerical calculation engine ‘back end’ of a 32-bit Windows application.

For more information, see the following topics in the online Programmer’s Guide described in Section 8.2, Documentation Available in HTML Help Viewer Format:

- For information on creating DLLs that work with other applications, see Creating Windows Applications.
- For information on creating a COM server, see Creating a COM Server.
- For information on mixed-language programming, see Programming with Mixed Languages.

For more information, see the Microsoft Visual Studio Web site at:

http://msdn.microsoft.com/vstudio/
7.6 Viewing Online Documentation in the HTML Help Viewer

Internet Explorer Version 4 Service Pack 1 is required before you can view online documentation in the HTML Help Viewer. See Section 3.4.4, Installing Internet Explorer.

To view the Visual Fortran online documentation in the HTML Help Viewer, do one of the following:

• Click the Online Documentation item in the Compaq Visual Fortran 6 program folder.

• After you start the visual development environment, click Contents on the Help menu.

The HTML Help Viewer displays the table of contents for the online reference books that are available. The books contain hypertext links to various topics.

Click on the titles in the window to expand the titles and see which documentation is available. For example, click on Compaq Visual Fortran 6.6, then click on Visual Fortran, then click on Compaq Visual Fortran, and so forth. The result will be similar to Figure 9-1, HTML Help Viewer.

For more information, see:

• Section 8.2, Documentation Available in HTML Help Viewer Format

• Chapter 9, Using the HTML Help Viewer

7.7 Using the Array Visualizer

The Compaq Array Visualizer is a software tool that lets you view and analyze data graphically. The Array Visualizer’s advanced data visualization techniques let you discover hidden patterns in large, multidimensional arrays. An extensive number of customization options allow you to bring out the important features of your data. The Array Visualizer uses OpenGL, a high-speed 3D rendering library, to let you move, rotate, and zoom data graphs.

The Array Visualizer includes several software components described in the following sections:

• 7.7.1, Array Viewer

• 7.7.2, Aview Routines Library

• 7.7.3, Avis2D and AvisGrid ActiveX (OCX) Controls

• 7.7.4, Enhancements to the Visual Development Environment

The Array Visualizer is available with the Visual Fortran Professional and Enterprise Editions.
Note: Only the Array Viewer component is available with the Standard Edition.

7.7.1 Array Viewer

The Compaq Array Viewer is a Windows application that displays array data in two adjustable panes:

- The top pane shows the array's numeric values in a scrollable spreadsheet.
- The bottom pane displays a graphical view of the array data as a three-dimensional surface. Other viewing modes include graphical representation of the array data as plane view image map, vector graph, or two-dimensional chart.

Figure 7-1 shows a typical Array Viewer window.

Figure 7-1 Compaq Array Viewer Window

7.7.2 Aview Routines Library

The Aview routines library contains a set of subroutines that allow Visual Fortran or Visual C++ applications to display array data using the Array Viewer (by means of OLE Automation). Using this library, you can create data visualization applications with just a few lines of code. The library routines can also save array data as a file for later viewing with the Array Viewer.
7.7.3 Avis2D and AvisGrid ActiveX (OCX) Controls

The Avis2D and AvisGrid ActiveX controls can be used by any development environment that supports ActiveX controls (Visual C++, Visual Basic, Visual Fortran dialogs) to display array data in a variety of graphing modes. The Avis2D control provides more than 100 properties, methods, and events that you can use to customize its behavior. The AvisGrid control can be used to create tables of array data using about 30 properties, methods, and events.

7.7.4 Enhancements to the Visual Development Environment

The Array Visualizer enhances the visual development environment to let you select an array in the debugger Watch window and use the Array Viewer to inspect it. You can update the view to observe changes in the array data as the program executes.

7.7.5 Array Visualizer Samples

Sample applications are provided with Array Visualizer. You must choose the Complete option during the Array Visualizer installation to install these, as described in Section 3.6, Installing Array Visualizer (Professional and Enterprise Editions). By default, the samples are installed in a folder under:

\Program Files\ArrayVisualizer\Samples

The file Samples.htm summarizes the Array Visualizer samples.

Note: If you do not install samples, you can copy the samples folders or files from the Array Visualizer CD–ROM to your hard disk (remove the Read-Only Property of the copied files).

7.7.6 Installing Array Visualizer

You can install Array Visualizer after you install Visual Fortran or at a later time. See Section 3.6, Installing Array Visualizer (Professional and Enterprise Editions).

If you have the Visual Fortran Standard Edition, see Section 3.5, Installing Array Viewer (Standard Edition).

7.7.7 Starting Array Viewer

You can start Array Viewer from the Compaq Array Visualizer program folder, or double-click the file Aviewer.exe in Windows Explorer (installed by default in the directory \Program Files\ArrayVisualizer\Bin).
If you've installed the Array Visualizer samples described in Section 7.7.5, Array Visualizer Samples, you can use the Array Viewer to view some sample data files in the Samples\Data directory.

### 7.7.8 Information about Array Visualizer

For more information, see the following:

- The Array Visualizer release notes. You can read the release notes by opening the Relnotes.txt file located in the root directory of the Array Visualizer CD–ROM. After installation, look at the Release Notes item in the Compaq Array Visualizer program folder. Or you can read the Relnotes.txt file installed in: \\
  \Program Files\ArrayVisualizer

- The HTML Help Viewer documentation, under the title *Compaq Array Visualizer*.

- The WinHelp documentation for Array Viewer. Use the Help menu in Array Viewer, or click on the file Aviewer.hlp in Windows Explorer (installed in the same directory as Aviewer.exe).

- Debugging Fortran Programs in the online *Programmer’s Guide*, which explains how to use Array Viewer in the debugger. (Professional and Enterprise Editions only.)

- Section 4.7, Redistributing Visual Fortran Files.

### 7.8 Using the IMSL Libraries (Professional and Enterprise Editions)

The Professional and Enterprise Editions of Visual Fortran include the IMSL Fortran 90 MP Library.

The IMSL libraries are for applications in general applied mathematics and for analyzing and presenting statistical data in scientific and business applications.

Table 7-2 shows the IMSL libraries provided.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Library Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMSL</td>
<td>IMSL static library, contains FORTRAN 77 and Fortran 90 routines</td>
</tr>
<tr>
<td>IMSL_ERR</td>
<td>IMSL error handler library</td>
</tr>
<tr>
<td>IMSL_MPISTUB</td>
<td>Stub library for MPI routines used in IMSL</td>
</tr>
</tbody>
</table>

For information on the previous version of the IMSL libraries, see the Visual Fortran release notes, described in Section 2.2, Release Notes.
If you perform a Typical installation, the IMSL modules, libraries, include files, message files, and online help are installed, but the sample programs are not. You must perform a Custom installation to install the samples. See Section 3.4.2, Specifying Installation Options and Destination Directories. The samples are installed by default in \Df98\Imsl\Examples.

**Note:** If you do not install samples, you can copy the samples folders or files from the Visual Fortran CD–ROM to your hard disk (remove the Read-Only Property of the copied files).

In addition to Visual Fortran platforms (architecture/operating system pairs), IMSL libraries are also available from Visual Numerics for many different platforms.

For more information about IMSL, see:

- The IMSL Fortran 90 MP Library Read Me text file provided in the Compaq Visual Fortran 6 program folder.
- The IMSL Fortran 90 MP Library Help item provided in the Compaq Visual Fortran 6 program folder. This brings up the IMSL documentation in PDF format. (See Section 8.4.4, Location of IMSL PDF Files.)
- Using the IMSL Mathematical and Statistical Libraries in the online Programmer’s Guide.
- The Visual Numerics Web page for IMSL at:
  
  http://www.vni.com/products/imsl/

### 7.9 Using f90SQL-lite

f90SQL from Canaima Software is a library of functions and subroutines that makes it possible for Fortran applications to directly read and write data stored in stored in databases. The databases must be compliant with the Open Database Connectivity (ODBC) application programming interface (API).

Examples of database and spreadsheet formats that you can read and write to are: Microsoft Excel, Lotus 1-2-3, Microsoft Access, Microsoft FoxPro, Paradox, Oracle, Sybase, Ingres, Informix, and Microsoft SQL-Server, among others. You can read and write data to the database application’s format directly from your Fortran programs, as long as the application offers an ODBC interface to its data files.

f90SQL-lite is a subset of the full f90SQL product, known as f90SQL-pro. f90SQL-lite is suitable for small record sets and a limited number of database connections. You can purchase f90SQL-pro for larger databases from Canaima Software.

f90SQL-lite is provided on the Visual Fortran CD–ROM, but you must install it yourself. See Section 4.16, Installing f90SQL-lite, for details.

Compaq does not provide technical support for f90SQL-lite.
For more information about f90SQL, see:

- The README.TXT and F90SQL.RTF files provided in the F90_SQL directory on the Visual Fortran CD–ROM. (These will be placed on your system during the installation process.)
- The Canaima Software Web site at:
  http://www.canaimasoft.com

### 7.10 Using Enterprise Toolkit and Technical Programming Extensions (Enterprise Edition)


The Enterprise Toolkit lets you build and debug on both Windows and UNIX system platforms using the Visual Fortran interface, combined with 64-bit Compaq Tru64 UNIX compilers. The Enterprise Toolkit also lets you seamlessly build your applications on several other major UNIX operating systems, such as HP-UX, Solaris, and Linux. You can use the Enterprise Toolkit for portable applications that run on Windows and UNIX systems.

The Enterprise Toolkit contains a sample Fortran project showing how to use the product with Fortran.

Technical Programming Extensions is an add-on to the Enterprise Toolkit. TPE includes, among other features:

- Direct access to KAP optimization settings
- The Porting Assistant, a tool to help you port Fortran applications from other vendors to Compaq Fortran for Tru64 UNIX Alpha™ Systems and Compaq Visual Fortran

For more information, see the Enterprise Toolkit Web site at:
http://www.tru64unix.compaq.com/enterprisetoolkit

### 7.11 Support for COM and Automation Objects: Fortran Module Wizard

Visual Fortran provides a wizard to simplify the use of functionality available with Component Object Model (COM) and Automation (formerly called OLE Automation) objects. COM is an open architecture for cross-platform development of client-server applications, based on object-oriented technology. Automation is a way to manipulate an application’s objects from outside the application. Automation is typically used to create applications that expose objects to programming tools and macro languages.
create and manipulate one application's objects from other applications, or create tools for accessing and manipulating objects. The Visual Fortran Module Wizard generates Fortran 90 modules that simplify calling COM and Automation services from Fortran programs.

The Fortran Module Wizard automatically generates Fortran source code that simplifies invoking:

- Routines in a dynamic-link library (DLL)
- Methods of an Automation object
- Member functions of a COM object

The generated code includes derived-type data declarations for data structures, procedure interface block definitions, and procedure definitions (external jacket routines) that simplify calling conventions.

For more information, see Using COM and Automation Objects in the online *Programmer's Guide* described in Section 8.2, Documentation Available in HTML Help Viewer Format.

7.12 Support for Creating COM Servers (Professional and Enterprise Editions)

COM supports a model of client-server interaction between a user of an object (the client) and the implementor of the object (the server).

Visual Fortran provides a COM server wizard that simplifies the task of creating a COM server or a server that supports dual interfaces. Applications that access COM objects can use the objects exposed by the COM server, including Visual Fortran, Visual C++, and Visual Basic clients.

For information about how to implement the COM server wizard as a Developer Studio add-in, see Section 4.2, Specifying the COM Server Wizard as a Developer Studio Add-in (Professional and Enterprise Editions Only).

For more information, see Creating a COM Server in the online *Programmer's Guide* described in Section 8.2, Documentation Available in HTML Help Viewer Format.

7.13 Interface Definitions for Routines

7.13.1 Visual Fortran and Array Visualizer Library Routines

Visual Fortran provides procedure interface definitions to all of the Visual Fortran and Array Visualizer library routines. These interfaces define the properties of a procedure:
the specifications of the attributes for a function result, the specification of dummy argument attributes, and the information in the procedure header.

To access the interface definitions, you need to insert a USE statement to include the module file that contains the interface definitions. For example, the following USE statement includes many of the general-purpose Visual Fortran routines:

```fortran
USE DFLIB
```

Other groups of Visual Fortran routines might require different USE statements, as listed in the description of each routine.

Place the USE statements at the beginning of the program unit before any other statements, such as IMPLICIT NONE or data declarations.

A description of each Visual Fortran routine is listed alphabetically in A to Z Reference in the online Language Reference described in Section 8.2, Documentation Available in HTML Help Viewer Format. Functional groups of routines are also described in various chapters in the online Programmer’s Guide described in Section 8.2, Documentation Available in HTML Help Viewer Format.

The Array Visualizer routines are listed in the online Compaq Array Visualizer HTML Help Viewer documentation, under API Calls for Fortran Programmers, API Calls for C Programmers, and API Calls for C++ Programmers.

### 7.13.2 CXML and IMSL Routines

The CXML routines require different USE or INCLUDE statements.

The IMSL routines require different USE statements.

Guidelines for calling the CXML and IMSL routines are provided in separate chapters in the online Programmer’s Guide described in Section 8.2, Documentation Available in HTML Help Viewer Format.

Detailed descriptions of the CXML and IMSL routines are provided in separate PDF files. See Section 8.4, Documentation Available in PDF Format.

### 7.13.3 Win32 Platform SDK Routines

Visual Fortran also provides interface definitions to most of the Win32 Platform SDK (operating system) routines. For example, the USE DFWIN statement includes interfaces for most of the Win32 SDK routines described in the Platform SDK title in the HTML Help Viewer.

These interface definitions simplify the task of calling the Win32 routines, which are intended to be called from C. For more information, see Calling Win32 Routines in the online Programmer’s Guide described in Section 8.2, Documentation Available in HTML Help Viewer Format.
This chapter contains the following sections:

- 8.1, Printed (Hardcopy) Documentation
- 8.2, Documentation Available in HTML Help Viewer Format
- 8.3, Documentation Available in HTML Format
- 8.4, Documentation Available in PDF Format
- 8.5, Documentation Available in WinHelp Format
- 8.6, Information About New Features
- 8.7, Where to Find Information About Particular Topics

**Note:** For information about using the sample programs, see Section 7.1, Using the Sample Programs.

For information about reading the Release Notes, see Section 2.2, Release Notes.

### 8.1 Printed (Hardcopy) Documentation

The two manuals available in printed form are the following:

- *Compaq Visual Fortran Installing and Getting Started*
  
  This is the manual you are now reading.

  This manual is also available online, in PDF format. See Section 8.4.2, Location of Installing and Getting Started PDF File.

- *Compaq Fortran Language Reference Manual*
This manual describes the Compaq Fortran language for all Compaq Fortran platforms, including Visual Fortran. It contains information on language syntax and semantics and on Fortran standards and extensions to the standards.

Compaq extensions to the Fortran 95 standard are identified by blue-green color in the manual.

The *Compaq Fortran Language Reference Manual* is provided in HTML form on the Visual Fortran CD-ROM in the following directory: `\Info\Df\Doc\LRM`. Open the file `Dflrm.htm`.

The *Compaq Fortran Language Reference Manual* is also available online, with slightly different information, in HTML Help Viewer format. See Section 8.2.2, Language Reference.

**Note:** The *Compaq Visual Fortran Installing and Getting Started* and *Compaq Fortran Language Reference Manual* are also available in HTML form on the Visual Fortran home page. To view them:

1. Open the Fortran home page at: `http://www.compaq.com/fortran`
2. Click on Online Documentation in the left margin.
3. Scroll down under Compaq Visual Fortran to find the manuals.

To order additional copies of the printed *Compaq Visual Fortran Installing and Getting Started* and *Compaq Fortran Language Reference Manual* included with each single-user kit, contact a local Compaq sales office or reseller and request Compaq part number QA-5LBAA-GZ.6.6.

### 8.1.1 Compaq Fortran Online Bookstore

You might want to purchase additional books about the Fortran language, Visual Fortran, or programming for the Windows platform that are not provided in your kit. Visual Fortran provides an online bookstore that lists suggested titles.

To bring up the Compaq Fortran Online Bookstore:

1. Open the Fortran home page at: `http://www.compaq.com/fortran`
2. Click on Bookstore in the left margin.
3. Click on the Compaq Fortran Online Bookstore link at the bottom of the page.

### 8.2 Documentation Available in HTML Help Viewer Format

**Note:** For information about how to bring up the HTML Help Viewer, see Section 7.6, Viewing Online Documentation in the HTML Help Viewer.
For details about the HTML Help Viewer, see Chapter 9, Using the HTML Help Viewer.

Visual Fortran and related online documentation appears under the *Compaq Visual Fortran* title.

The primary online reference materials for Visual Fortran are:

- Compaq Array Visualizer documentation for the Professional and Enterprise Editions (several books in the *Compaq Array Visualizer* title). See Section 8.2.5, Compaq Array Visualizer Documentation.
- Platform SDK and SDK manuals in the *Platform SDK* and *SDK Documentation* titles. See Section 8.2.6, Platform SDK and SDK Documentation.

These documentation resources are available online after you install Visual Fortran.

The *Programmer’s Guide*, *Language Reference*, and *Error Messages* manuals are also available as .HTM files that you can view using your favorite browser, not the HTML Help Viewer.

### 8.2.1 Programmer’s Guide

The *Programmer’s Guide* covers the following aspects of Visual Fortran programming on Windows 2000, Windows NT 4, Windows Me, Windows 98, and Windows 95 systems:

- How to build and debug efficient applications using the visual development environment or the command line, selecting appropriate compiler and linker options, using the debugger, and performance guidelines.

Using COM and Automation objects (client) and creating a COM server (including support for dual interfaces).

Intrinsic data types, handling run-time errors and exceptions, and converting foreign unformatted files.

How to use IMSL library routines (included in the Professional and Enterprise Editions of Visual Fortran).

How to use CXML library routines.

Source compatibility and using Visual Fortran tools.

Compaq extensions to the Fortran 95 standard are identified by a blue-green color.

### 8.2.2 Language Reference

The *Language Reference* describes the Compaq Visual Fortran programming language. It contains all of the material in the printed *Compaq Fortran Language Reference Manual* described in Section 8.1, Printed (Hardcopy) Documentation that is relevant to Visual Fortran. It also contains information not found in the printed manual about routines available only on Windows platforms.

Information found in the *Language Reference* includes:

- Individual sections that describe aspects of the Fortran 95/90 language
  
  Topics include program structure, constants and variables, various types of statements, execution control, data transfer and I/O, scope and association, compilation control and directives, and other topics.

- A to Z Reference
  
  Organizes the functions, subroutines, and statements available in Visual Fortran by the operations they perform. Also has descriptions of all Visual Fortran statements, intrinsics, and library routines (arranged in alphabetical order).

- Glossary
  
  Contains abbreviated definitions of some commonly used terms in the Visual Fortran documentation.

Compaq extensions to the Fortran 95 standard are identified by a blue-green color.
8.2.3 Error Messages

*Error Messages* is a list of error messages with explanations, including Visual Fortran run-time messages, linker messages, and tools messages.

8.2.4 Visual C++ User’s Guide (for Visual Fortran)

The *Visual C++ User’s Guide (for Visual Fortran)* provides information on navigating the menus and windows of the visual development environment. It describes how to set up projects, how to work with the editor, debugger, and browser, and how to set linker options.

8.2.5 Compaq Array Visualizer Documentation

The Compaq Array Visualizer online documentation provides information about the Array Visualizer, including how to get started with the Array Visualizer, Fortran (fagl and fav) routines reference information, C (agl and CAVviewer Class) routines reference information, and Avis2D and AvisGrid ActiveX controls information (including properties and methods reference).

8.2.6 Platform SDK and SDK Documentation

The Platform Software Development Kit (SDK) online documentation is included to give you reference information about library routines (such as OpenGL) provided by your operating system. This documentation is shown under the online titles *Platform SDK* and *SDK Documentation*.

8.2.7 Additional HTML Help for the Enterprise Edition

The Enterprise Toolkit part of the Enterprise Edition includes additional documentation in HTML Help form, including Compaq Tru64 UNIX operating system documentation and related product documentation.

With the Enterprise Edition, the additional HTML Help (such as the Compaq Tru64 UNIX documentation) is added to its own collection. During installation of the Enterprise Toolkit, you can select existing collections (such as MSDN or Visual Fortran) to be added to the Compaq Enterprise Toolkit collection. The Visual Fortran collection remains as a separate collection that you can select. See Section 9.11, Other HTML Help Viewer Features.

You can use the subset capabilities of HTML Help to limit the information displayed or searched with the Search tab or F1 key. For example, you can define and use a subset that only contains the Compaq Tru64 UNIX documentation. See Section 9.9, Changing the Current Collection.
8.3 Documentation Available in HTML Format

The documentation described in Section 8.2, Documentation Available in HTML Help Viewer Format, is also provided in HTML format, to be read using your favorite browser. The HTML files are located on the Visual Fortran CD–ROM at:
\Info\Df\Doc\CVF_HTML

The HTML files for the Compaq Fortran Language Reference Manual described in Section 8.1, Printed (Hardcopy) Documentation is located on the Visual Fortran CD–ROM at:
\Info\Df\Doc\CVF_LRM

8.4 Documentation Available in PDF Format

This documentation is provided in PDF format, to be read using the Adobe Acrobat Reader:

- Compaq Visual Fortran Installing and Getting Started. See Section 8.4.2, Location of Installing and Getting Started PDF File.
- Compaq Extended Math Library Reference Guide. See Section 8.4.3, Location of CXML PDF File.
- IMSL PDF files for the Professional and Enterprise Editions. See Section 8.4.4, Location of IMSL PDF Files.
- FLEXlm End Users Manual. See Section 8.4.5, Location of FLEXlm PDF File.
- Visual Fortran and Array Visualizer HTML Help documentation, provided in PDF form for those who cannot or prefer not to view the HTML files. The PDF files are on the Visual Fortran CD–ROM in the following directory:
\Info\Df\Doc\CVF_PDF

The following PDF documentation is provided in this directory:

- Programmer's Guide, described in Section 8.2.1, Programmer's Guide
- Language Reference, described in Section 8.2.2, Language Reference
- Error Messages, described in Section 8.2.3, Error Messages
- Array Visualizer PDF files, described in Section 8.2.5, Compaq Array Visualizer Documentation
8.4.1 Viewing PDF Files

To view the PDF files, you must use the Adobe Acrobat Reader, Version 4.0 or later. To get the latest version of Acrobat Reader, do one of the following:

- Download it from the Adobe Systems Web site and install it. The site is at:
  
  http://www.adobe.com

- Use the Acrobat Reader self-extracting installation file located on the Visual Fortran CD–ROM. In Windows Explorer, double-click on the file rs40eng.exe in the \86\Tools\AcroRead directory.

It is recommended that you remove any previous versions of Acrobat Reader before you install a newer version.

8.4.2 Location of Installing and Getting Started PDF File

The Compaq Visual Fortran Installing and Getting Started PDF file Cvf_gs.pdf is located in the root directory of the Visual Fortran CD–ROM.

After installation, the PDF file is in:

\Program Files\Microsoft Visual Studio\Df98

8.4.3 Location of CXML PDF File

The Compaq Extended Math Library Reference Guide PDF file Cxmlref.pdf is located on the Visual Fortran CD–ROM in the following directory:

\86\df\cxml\doc

After installation (if requested), the PDF file is in:

\Program Files\Microsoft Visual Studio\Df98\Cxml\Doc

8.4.4 Location of IMSL PDF Files

The following PDF files are available for IMSL:

- IMSL contents file, Imsl.pdf
- IMSL Math/Library, Volumes 1 and 2, file Math.pdf
- IMSL Math/Library, Special Functions, file Sfun.pdf
- IMSL Stat/Library, Volume 1, file Statvol1.pdf
- IMSL Stat/Library, Volume 2, file Statvol2.pdf
- IMSL Fortran 90 MP Library, file F9040.pdf
The PDF files are located on the Visual Fortran CD–ROM in the following directory:
\x86\df\IMSL\Help
After installation (if requested), the PDF files are in:
\Program Files\Microsoft Visual Studio\Df98\Imsl\Help

8.4.5 Location of FLEXlm PDF File

If you use the default installation directory when you install the FLEXlm software license manager, the FLEXlm End Users Manual PDF file, enduser.pdf, is installed in:
C:\FLEXLM

8.5 Documentation Available in WinHelp Format

The following documentation is available in WinHelp format when you click on Help when using the products:
- Online help for Array Viewer
- Online help for some Visual Fortran tools, such as Bit Viewer and Format Editor.

8.6 Information About New Features

For information about new features for Visual Fortran, bring up the HTML Help Viewer. See Section 9.2, Displaying the HTML Help Viewer.

In the Contents pane, do the following:
1. If not expanded, expand the Compaq Visual Fortran 6.6 title.
2. If not expanded, expand Visual Fortran.
3. If not expanded, expand Compaq Visual Fortran.
4. Click on Home Page.
5. Click on the link to New Features for Compaq Visual Fortran Version 6.6.

For information about new features for Array Visualizer, bring up the HTML Help Viewer. In the Contents pane:
1. If not expanded, expand the Compaq Visual Fortran 6.6 title.
2. If not expanded, expand Visual Fortran.
3. If not expanded, expand Compaq Array Visualizer.
4. Click on Home Page.
8.7 Where to Find Information About Particular Topics

Table 8-1 lists various topics and where to find information about them in the document set.

Note that you can search through the online books for keywords. See Section 9.7, Using the Search Tab to Locate Topics by Searching.

Table 8-1 Where to Find Information About Particular Topics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Where to Find It</th>
</tr>
</thead>
</table>
| Using the Microsoft visual development environment | Chapter 6, Using Visual Fortran  
  *Programmer's Guide: Building Programs and Libraries*  
| Compatibility with versions of Microsoft Fortran and Microsoft extensions | *Programmer's Guide: Compatibility Information, Compiler and Linker Options* |
| Defining procedures for an application      | *Language Reference: Program Structure, Characters, and Source Forms, Program Units and Procedures*  
  *Compaq Fortran Language Reference Manual: Program Structure, Characters, and Source Forms, Program Units and Procedures* |
| Starting a new program                      | *Programmer's Guide: Portability and Design Considerations* |
| Handling run-time errors                    | *Programmer's Guide: Handling Run-Time Errors, Locating Run-Time Errors in the Debugger in the topic Debugging Fortran Programs*  
| Improving performance                       | *Programmer's Guide: Performance: Making Programs Run Faster* |
| Adding windows to your application          | *Programmer's Guide: Using QuickWin, Using Dialogs* |
| Getting user input with dialog boxes       | *Programmer's Guide: Using Dialogs* |
| Adding mouse functions to your application  | *Programmer's Guide: Using QuickWin* |
| Adding graphic elements                     | *Programmer's Guide: Drawing Graphic Elements, Using Fonts from the Graphics Library* |
| Multitasking                                | *Programmer's Guide: Creating Multithread Applications* |
| Interacting with other applications        | *Programmer's Guide: Programming with Mixed Languages, Creating Fortran DLLs* |
| Working with other platforms                | *Programmer's Guide: Portability and Design Considerations, Portability Library, Compatibility Information, The Floating-Point Library* |
| CXML routines                               | Section 7.4, Using Compaq Extended Math Library (CXML)  
  *Programmer's Guide: Using the Compaq Extended Math Library (CXML)* |
### Table 8-1  Where to Find Information About Particular Topics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Where to Find It</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMSL routines</td>
<td>Section 7.8, Using the IMSL Libraries (Professional and Enterprise Editions)</td>
</tr>
<tr>
<td></td>
<td><em>Programmer's Guide: Using the IMSL Mathematical and Statistical Libraries</em></td>
</tr>
<tr>
<td>Using COM and Automation objects from Fortran applications</td>
<td><em>Programmer's Guide: Using COM and Automation Objects</em></td>
</tr>
<tr>
<td>Creating a Fortran COM server</td>
<td><em>Programmer's Guide: Creating a COM Server</em></td>
</tr>
<tr>
<td>Compaq Array Viewer and Array Visualizer description</td>
<td>Section 7.7, Using the Array Visualizer</td>
</tr>
<tr>
<td></td>
<td><em>Getting Started in the Compaq Array Visualizer title</em></td>
</tr>
<tr>
<td>Using the Array Viewer</td>
<td>Help menu in the Array Viewer</td>
</tr>
<tr>
<td></td>
<td><em>Getting Started in the Compaq Array Visualizer title</em></td>
</tr>
<tr>
<td>Calling the Array Visualizer routines from Fortran applications</td>
<td><em>API Calls for Fortran Programmers in the Compaq Array Visualizer title</em></td>
</tr>
<tr>
<td>Calling the Array Visualizer routines from C or C++ applications</td>
<td>*API Calls for C Programmers and API Calls for C++ Programmers in the Compaq Array Visualizer title</td>
</tr>
<tr>
<td>Using the Array Visualizer Avis2D and AvisGrid ActiveX controls</td>
<td><em>Array Visualizer Controls in the Compaq Array Visualizer title</em></td>
</tr>
<tr>
<td>Differences between Fortran 95 and Fortran 90</td>
<td><em>Language Reference: Fortran 95 Features, Fortran 90 Features</em></td>
</tr>
<tr>
<td></td>
<td><em>Compaq Fortran Language Reference Manual: Overview</em></td>
</tr>
<tr>
<td>Differences between Fortran 90 and FORTRAN 77</td>
<td><em>Language Reference: Fortran 95 Features, Fortran 90 Features</em></td>
</tr>
<tr>
<td></td>
<td><em>Compaq Fortran Language Reference Manual: Overview</em></td>
</tr>
<tr>
<td>Glossary of terms</td>
<td><em>Language Reference: Glossary</em></td>
</tr>
<tr>
<td></td>
<td><em>Compaq Fortran Language Reference Manual: Glossary</em></td>
</tr>
</tbody>
</table>
This chapter contains the following sections:

- 9.1, What Is the HTML Help Viewer?
- 9.2, Displaying the HTML Help Viewer
- 9.3, Using the Contents Tab
- 9.4, Navigating by Jumping to Related Topics
- 9.5, Using F1 to Get Context-Sensitive Help
- 9.6, Using the Index Tab to Locate Topics by Index Keyword
- 9.7, Using the Search Tab to Locate Topics by Searching
- 9.8, Using the Favorites Tab for Bookmarks
- 9.9, Changing the Current Collection
- 9.10, Defining and Using Subsets
- 9.11, Other HTML Help Viewer Features
- 9.12, Problems Displaying HTML Help Viewer Information

9.1 What Is the HTML Help Viewer?

An online documentation help system called the HTML Help Viewer is integrated with the visual development environment.

The HTML Help Viewer appears in a separate window, as shown in Figure 9-1.
The left window area shows the contents of the titles. It has tabs for the following panes: Contents, Index, full-text Search, and Favorites.

The right window area displays text for a selected topic in a document window.

The HTML Help Viewer provides a built-in toolbar, as shown in Figure 9-2.

Table 9-1 describes the buttons in the toolbar.

<table>
<thead>
<tr>
<th>Click this button:</th>
<th>To do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide or Show</td>
<td>Hide removes the left pane, which contains the Contents, Index, and Search tabs. After you click Hide, click Show to redisplay the Contents pane.</td>
</tr>
<tr>
<td>Locate</td>
<td>Locate shows you the location of the current topic in the Contents.</td>
</tr>
<tr>
<td>Next and Previous</td>
<td>Next and Previous move you to the topic that follows (down arrow) or precedes (up arrow) the current topic in the Contents. Topics are ordered as they appear in the Contents.</td>
</tr>
<tr>
<td>Back and Forward</td>
<td>Back returns you to the last topic you viewed. Forward moves you forward (if you previously clicked Back).</td>
</tr>
<tr>
<td>Stop</td>
<td>Stop stops retrieval of information for the current topic.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refresh redisplays the contents of the screen.</td>
</tr>
<tr>
<td>Home</td>
<td>Home returns you to the home screen of the HTML Help Viewer help system.</td>
</tr>
</tbody>
</table>
Most of the functions performed by the toolbar buttons are also available as menu items in the Go menu.

You can use the Page Up, Page Down, and arrow keys on your keyboard to scroll through text.

You can also use keyboard shortcuts for navigation. For example, to change focus from the left side of the Help Viewer to the right (text) side, click on F6.

### 9.2 Displaying the HTML Help Viewer

There are several ways to display the HTML Help Viewer:

- Click the Online Documentation item in the Compaq Visual Fortran program folder. The HTML Help Viewer appears with the Contents displayed.

- Within the visual development environment, in the Help Menu, click either Contents, Index, or Search. The HTML Help Viewer appears with the Contents, Index, or Search pane displayed.

- In a text window (such as a text editor window), move your pointer to a word of a Fortran statement, routine, intrinsic, or keyword and click F1. The HTML Help Viewer appears with the text associated with that topic (or a selectable list) displayed.

Figure 9-3 shows the Contents with several online titles expanded. See Table 9-2, How to Use the Contents Pane.
You can also display the HTML Help Viewer by other means supported by HTML Help.

For example, you can use the HH command within a command prompt window (or desktop shortcut) to open a .CHM file installed on your hard disk. You can similarly open a .CHM file within Internet Explorer (click Open in the File menu, then click Browse). Visual Fortran HTML Help files are installed by default in the following directory:

\Program Files\Microsoft Visual Studio\Df98\Doc

Note: If you have trouble displaying the HTML Help Viewer, see Section 9.12, Problems Displaying HTML Help Viewer Information.

9.3 Using the Contents Tab

The HTML Help Viewer provides a book-like table of contents showing the titles of books, sections, and topics. You can browse among the various categories of
information. Visual Fortran titles appear with certain other visual development
environment titles.

To display the contents, see Section 9.2, Displaying the HTML Help Viewer.

Table 9-2 shows how to use the Contents pane. See Figure 9-3, HTML Help Viewer
Window with Contents Displayed.

<table>
<thead>
<tr>
<th>Table 9-2</th>
<th>How to Use the Contents Pane</th>
</tr>
</thead>
<tbody>
<tr>
<td>To do this:</td>
<td>Click this:</td>
</tr>
<tr>
<td>Open a title</td>
<td>Click the + symbol in front of the name or double-click the name itself. The + symbol changes to a - symbol when a title is open.</td>
</tr>
<tr>
<td>Close a title</td>
<td>Click the - symbol in front of the name or double-click the name itself. The - symbol changes to a + symbol when a title is closed.</td>
</tr>
<tr>
<td>View a topic</td>
<td>Double-click the topic’s page icon or the topic name in the Contents. The topic you selected is displayed in a topic window.</td>
</tr>
</tbody>
</table>

9.4 Navigating by Jumping to Related Topics

From any topic window, there are several ways to jump to related information, such as:

- Click on one of the HTML Help Viewer buttons. (See Table 9-1, Buttons in the HTML Help Viewer Toolbar.)
- Select a word and click F1. (See Section 9.5, Using F1 to Get Context-Sensitive Help.)
- Click on underlined words in a color, such as blue, to move to another related topic or display a pop-up window with additional information. For certain types of jumps, a selectable list appears to allow a choice among multiple topics.

If jumps between topics in the HTML Help Viewer do not work as expected, click the HTML Help View menu, Internet Options item. Check the settings in the Security tab.

9.5 Using F1 to Get Context-Sensitive Help

Context-sensitive help on specific keywords and functions is available whenever you are working in a text window. You can also get detailed descriptions of options whenever you are working in a visual development environment dialog box.

To get help on a word in a text window, move your pointer to the word that you want help on and click F1.

The HTML Help Viewer displays the topic. If there are multiple topics indexed in Books Online under the word you specified, the Select Reference dialog box displays all topic titles that contain information on the keyword you specified.
When in a dialog box, to get help on a part of a dialog box, do either of the following:

- Click the ? (Help) button and click the item you want help on.
- Select the item you want help on and click F1.

### 9.6 Using the Index Tab to Locate Topics by Index Keyword

The HTML Help Viewer provides a book-like index to all topics in Books Online. Every topic is indexed under one or more keywords to make them easy for you to find.

To find a topic with the index:

1. Bring up the Index pane as described in Section 9.2, Displaying the HTML Help Viewer.
2. Enter the word(s) you want information on. Topics relevant to the word(s) you have entered appear.
3. Either select the topic you want to view and click the Display button or double-click the topic you want to view.

Certain index keywords will be dimmed to indicate they are not in the current subset or are placeholders for the indented keywords beneath them.

### 9.7 Using the Search Tab to Locate Topics by Searching

If you cannot easily find the information you are looking for in the index or you are looking for detailed information, you can perform a full-text search of either the entire contents of Books Online or the currently selected subset. (See Section 9.9, Changing the Current Collection.) The HTML Help Viewer displays every occurrence of a given word or phrase, anywhere within the help system.

To search the full text of the online books:

1. Bring up the Search pane as described in Section 9.2, Displaying the HTML Help Viewer.
2. Enter the word, phrase, or wildcard expression you want information on.
3. Click the List Topics button.
   - The list box at the bottom of the Search dialog box displays all the topics containing the word or phrase you specified.
4. Either select the topic you want to view and click the Display button or double-click the topic you want to view.

At the bottom, the Search pane contains checkboxes for the following:
9.7.1 Basic Search Syntax

A basic search query consists of the word or phrase you want to find. To create more complex search queries, you can use Boolean operators (AND, OR, NOT) and a proximity operator (NEAR).

Keep in mind the following rules when you are creating a query:

- Search queries are case-insensitive, so you can enter your query in uppercase or lowercase letters.
- You can search for any combination of letters (a-z) and numbers (0-9), except for the words in the exception list (a, an, and, as, at, be, but, by, do, for, from, have, he, in, it, not, of, on, or, she, that, the, there, they, this, to, we, which, with, you), which are ignored during a search.
- Punctuation marks such as the period (.), colon (:), semicolon (;), comma (,), and hyphen (-) are ignored during a search.
- Use single or double quotation marks to enclose phrases; you cannot search for these characters.
- You can use parentheses to nest expressions within your query.

9.7.1.1 Words, Phrases, and Wildcards

You can use wildcards with the basic query syntax to create powerful and flexible search queries, as shown in Table 9-3.

<table>
<thead>
<tr>
<th>To search for:</th>
<th>Example:</th>
<th>The search will find:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A single word</td>
<td>overload</td>
<td>Topics that contain the word overload (you will also find its grammatical variations, such as overloads and overloaded).</td>
</tr>
</tbody>
</table>
9.8 Using the Favorites Tab for Bookmarks

In the HTML Help Viewer window, click on the Favorites tab to display your bookmarks (favorite items).

To add a bookmark to your Favorites list:

1. Display the appropriate topic.
2. Click the Add button.

To remove a bookmark:

1. Click on the bookmark to be removed.
2. Click the Remove button.

To display the topic associated with a bookmark:

1. Click on the bookmark to be viewed.
2. Click the Display button.

9.9 Changing the Current Collection

In the HTML Help Viewer, a collection is a group of related titles and files.

When you use the Contents, Index, or Search functions, the current collection is used. The current collection is also used when you search for topics within the visual development environment, such as when you move your pointer to a word and click F1.

Typically, your current collection will be the Compaq Visual Fortran documentation. However, if you also have the Microsoft MSDN online documentation installed (such as

---

Table 9-3  How to Use Wildcards with the Basic Search Syntax

<table>
<thead>
<tr>
<th>To search for:</th>
<th>Example:</th>
<th>The search will find:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A phrase, in single or double quotes</td>
<td>‘new operator”</td>
<td>Topics that contain the literal phrase new operator and all its grammatical variations. Without the quotation marks, the query is equivalent to specifying: new AND operator</td>
</tr>
<tr>
<td></td>
<td>‘new operator’</td>
<td>Using two words without quotation marks (or the AND operator) finds topics containing the individual words, not the phrase.</td>
</tr>
<tr>
<td>A wildcard expression</td>
<td>esc*</td>
<td>Topics that contain the terms esc, escape, escalation, and so on. The asterisk cannot be the only character in the term.</td>
</tr>
<tr>
<td></td>
<td>80?86</td>
<td>Topics that contain the terms 80186, 80286, 80386, 80x86, and so on. The question mark cannot be the only character in the term.</td>
</tr>
<tr>
<td></td>
<td>*86</td>
<td>Topics that contain the terms 386, 486, x86, 8086, and so on.</td>
</tr>
</tbody>
</table>

---
for a Microsoft Visual Studio product or subscription), the MSDN Library might be the current collection.

For example, if the MSDN Library is the current collection, when you click Contents from the Help menu, the MSDN online documentation might appear instead of the Visual Fortran online documentation.

You can change your current preferred collection.

On Windows 2000 systems, you need to have at least Power user privilege to change collections.

To change the current online documentation collection in use:

1. Within the visual development environment, in the Tools menu, select Options.
2. Click on the Help System tab. (Depending on display settings, you might need to scroll to find the tab.)
3. In the Preferred Collection box, select Compaq Visual Fortran if you want to use the Visual Fortran collection or select MSDN Library if you want to use the MSDN collection.
4. Click OK. The collection you just selected is now your current collection.

If you have installed the Enterprise Edition, see Section 8.2.7, Additional HTML Help for the Enterprise Edition for information on the collection to use.

Note: You can always display the Visual Fortran online documentation in the HTML Help Viewer by clicking the Online Documentation item in the Compaq Visual Fortran 6 program folder. However, searches will continue to use the current collection, which might or might not be the Visual Fortran collection.

9.10 Defining and Using Subsets

The HTML Help Viewer lets you define and use subsets to limit the index or search activity on your system. For example, you can define a subset for just the Visual Fortran documentation, the Array Visualizer documentation, or the Platform SDK documentation, or any combination.

The name of the current subset is shown in the upper left part of the HTML Help Viewer window in a list box labeled Active Subset. The subset titled Entire Collection displays the entire contents of the currently selected collection. (See Section 9.9, Changing the Current Collection.)

To define a new subset:

1. Start the HTML Help Viewer.
2. In the View menu, click Define Subset.
3 In the Available Items list, double-click the Compaq Visual Fortran 6.6 subcategories.

4 If needed, double-click the subcategory to display its contents.

5 Click the appropriate title. You can use the Ctrl key to select multiple titles.

6 Click the Add button; the selected titles are moved into the right pane.

7 In the lower-right corner, in the text box below Save new subset as:, highlight and enter the desired subset name.

8 Click the Save button to save the defined subset for subsequent use.

9 Click the Close button.

To use a previously defined subset, in the Active Subset list box, select the desired subset.

After you select the subset, the Contents pane shows only the contents of the current subset.

When you exit the HTML Help Viewer, it remembers the last subset selected and uses it the next time you start the HTML Help Viewer.

If you use multiple subsets and cannot find a topic you need, make sure you select the Entire Contents subset or the appropriate subset you previously defined.

9.11 Other HTML Help Viewer Features

The HTML Help Viewer environment provides other features, including locating text within a page and access to Microsoft Internet Explorer preferences.

To locate a text string within the current topic page:

1 In the Edit menu, click Find in this Topic.

2 Enter the text to be located.

3 Review and, if needed, set the displayed radio button options.

4 Click the Find Next button. The text string, if located, is highlighted.

5 If appropriate, click the Find Next button again to locate the next place where that text string is located on the current page.

To access Microsoft Internet Explorer preferences:

1 In the View menu, click Internet Options.

2 Click the appropriate tab.

3 Change the options as needed.
4 Click OK.

To open a page on your company’s intranet or the Internet:

1 In the Go menu, click URL.

2 Enter the desired URL, such as: http://www.compaq.com

3 Click OK.

If you cannot access the specified page, correct the URL or check your Internet Explorer preferences (in the View menu, click Internet Options).

9.12 Problems Displaying HTML Help Viewer Information

Under Visual Fortran are the titles Compaq Visual Fortran and Compaq Array Visualizer.

If the expected HTML Help Viewer window (shown in Figure 9-1, HTML Help Viewer) does not appear, possible causes and solutions include:

• Microsoft Internet Explorer Version 4 is not installed properly.
  The HTML Help Viewer requires a certain minimum release of Internet Explorer Version 4. You can install the correct release of Internet Explorer Version 4 from the Visual Fortran CD–ROM. See Section 3.4.4, Installing Internet Explorer.
  On Windows 2000 and Windows NT 4 systems, Internet Explorer Version 4 must be installed from an Administrator account.

• Microsoft Internet Explorer Version 4 was not installed before installing Visual Fortran.
  You must install the minimum (or later) release of Internet Explorer Version 4 before you install Visual Fortran. See Section 3.4.4, Installing Internet Explorer.

• The current subset prevents you from locating the desired information.
  You may have selected a subset of the Visual Fortran collection recently or when you last used the HTML Help Viewer. You can select the Entire Collection to locate the desired information in the Active Subsets list box. See Section 9.10, Defining and Using Subsets.

• You have Microsoft MSDN installed and the MSDN Library, not Visual Studio, appears in the Contents. See Section 9.9, Changing the Current Collection.

• The expected Visual Fortran Contents do not appear, even though you do not have Microsoft MSDN installed.
  Start the HTML Help Viewer by clicking the Online Documentation item in the Compaq Visual Fortran 6 program folder. (Do not start the HTML Help Viewer from the visual development environment Help menu.)
You might find useful tips on displaying HTML Help Viewer information by looking at the Compaq Visual Fortran Knowledge Base at the Compaq Fortran Web page, described in Section 10.2, Types of Technical Support.
This chapter contains the following sections:

- 10.1, Overview of Technical Support
- 10.2, Types of Technical Support
- 10.3, Guidelines for Reporting Problems

10.1 Overview of Technical Support

For information about Visual Fortran, including availability of new releases and the location of service update kits, you can access the Compaq Fortran home page with a Web browser at:

http://www.compaq.com/fortran

If you have questions related to the use or installation of Visual Fortran or the visual development environment, including the installation of the IMSL libraries, consult the printed and online documentation provided before you contact Compaq technical support.

For specific questions about the use of IMSL library routines (not related to installation or the use of Visual Fortran), first carefully read Using the IMSL Mathematical and Statistical Libraries in the online Programmer’s Guide before you contact Visual Numerics, Inc.

10.2 Types of Technical Support

The following types of Visual Fortran technical support are available:

- E-mail support
Visual Fortran e-mail support is available worldwide in English as a free service. The length of time to answer your questions will vary. For example, a detailed problem report might require multiple days to investigate.

Compaq prefers that you use the VF Reporter tool to submit e-mail questions. See Chapter 11, Using the VF Reporter Tool.

- **Paid consulting support through Compaq Services**

  For a description of the paid technical support options available, access the Compaq Fortran Web page at:

  http://www.compaq.com/fortran

  Under the Compaq Visual Fortran heading, in the QuickSelect Page menu, choose Support.

  The type of paid technical support services available from Compaq also depends on the country in which you live. You can contact your local Compaq office for information about the type of support services available in your country.

- **User-to-user support on Compaq message boards**

  Compaq hosts a Web-based forum where users can post general questions. To use it, access the following Web page:

  http://www.compaq.com/fortran/forum

  You will be prompted to register to use this service. After registering or logging in, select the Visual Fortran category.

- **Visual Fortran Frequently Asked Questions (FAQ) and Knowledge Base**

  To see these, access the Compaq Fortran Web page at:

  http://www.compaq.com/fortran

  Under the Compaq Visual Fortran heading, in the QuickSelect Page menu, choose Frequently Asked Questions or Knowledge Base.

- **Newsletter**

  All registered Visual Fortran users with a valid e-mail address will receive a periodic electronic newsletter notification.

## 10.3 Guidelines for Reporting Problems

If you have a problem, read the following to determine if the problem is a known problem:

- Release notes in the Visual Fortran program folder
- Frequently Asked Questions
Knowledge Base

To report a problem, Compaq prefers that you use the VF Reporter tool. See Chapter 11, Using the VF Reporter Tool.

If you cannot use VF Reporter, see the online BUGREPRT.TXT file for information on sending a report to Compaq. The file is in the following directory:

\Program Files\Microsoft Visual Studio\Df98

When reporting a problem, be sure to include the following:

- The name and version number of the operating system you are using.
- The specific commands or steps used to compile and link the program. In the visual development environment, this includes the Fortran and Link tab settings from the Project menu Settings item.
- Any error messages displayed.
- Relevant detailed information (possibly including source program listings). Try to narrow the cause of the problem to a specific subprogram or lines of code.
Using the VF Reporter Tool

This chapter contains the following sections:

• 11.1, What Is VF Reporter?
• 11.2, Starting VF Reporter
• 11.3, User Information Dialog Box
• 11.4, System Information Dialog Box
• 11.5, Manually E-Mailing Problem Reports
• 11.6, Problems Mailing Files with VF Reporter

11.1 What Is VF Reporter?

VF Reporter is an automated, simple, e-mail mechanism for reporting suspected problems or sending suggestions to the Visual Fortran team. If you encounter a problem you believe is caused by Visual Fortran, you can use VF Reporter to report it to Compaq.


You can use your e-mail package’s MAPI support to mail your report directly from VF reporter, or manually e-mail the information yourself after VF Reporter has collected it.

VF Reporter is automatically installed when you install Visual Fortran. When installed, VF Reporter files are copied into:

\Program Files\Microsoft Visual Studio\Df98\Vfrportr

Note: To read this chapter in a Web browser, open the file Readme.htm in the Vfrportr directory.

If you remove Visual Fortran, VF Reporter is automatically removed.
VF Reporter automatically gathers system information, including the product identifier, version number, path information, and other system information.

### 11.2 Starting VF Reporter

To start VF Reporter:

1. Click Start.
2. Click Programs.
4. Click VF Reporter.

This brings up the User Information dialog box shown in Figure 11-1.

**Figure 11-1 VF Reporter User Information Dialog Box**

Initially, the User Information dialog box does not contain information. When you start VF Reporter, if existing user information is found, a dialog box appears asking if you want to use that information. To reuse or edit the displayed user information, click Yes. To enter all new information, click No.

If you say Yes, you can edit the user information. It will be saved when you click Save or Mail.

To use VF Reporter to send in a report to Compaq, follow these instructions:
1 Fill in the requested user information in the various tabs in the User Information dialog box. (See Section 11.3.1, Tabs in the User Information Dialog Box.)

2 Click the System Information button at the bottom of the User Information dialog box to display the System Information dialog box. Click the various tabs and view the system information collected by VF Reporter.

If a tab contains information that you don't want to send to Compaq with your report, turn off the checkbox to prevent the information from being sent. (See Section 11.4, System Information Dialog Box.)

3 Click the User Information button to display the User Information dialog box again.

4 After you review the user information, click Save to save the current set of information to an ASCII text file. Both the user information and the system information are saved in the text file. You can specify a file name when you save the information. See Section 11.3.2, Buttons in the User Information Dialog Box, for information about the Save button.

5 If you have turned on the checkbox *I want to use my e-mail package's MAPI support to email reports*, you can click on the E-Mail button to send the report.

If you have not turned on the toggle, you can send the e-mail manually. Be sure to attach the text file that you saved.

### 11.3 User Information Dialog Box

The User Information dialog box contains tabs and buttons to help you create your report to send to Compaq.

#### 11.3.1 Tabs in the User Information Dialog Box

The User Information dialog box contains the following tabs that you need to fill in:

- **User**: Enter the name, address, e-mail address, and phone numbers. If you choose to use your e-mail software's MAPI support, the e-mail address must be correct, because this is the address that Compaq will reply to after you send in your report.

- **Severity**: Specify the category of the problem (such as run-time error or suggestion), whether the problem can be reproduced, and whether you are porting code from another platform.

- **Description**: Briefly describe the project type, the structure of the application, and the problem. You can include the steps needed to reproduce the problem in the To Reproduce tab. You can attach source and project files using the Attach Files tab instead of including the actual code in the Description tab.
- Workarounds: If you found a workaround that allows you to avoid the problem and produce the intended results, describe it.

- Attach Files: Supply only the code needed to reproduce the problem. For example, you might try to show only the main program, relevant module definition or included files, and any subroutines or functions needed to reproduce the problem. You can attach multiple files. VF Reporter will create a zip file from the attached files that will be attached to the e-mail message.

  You should avoid sending sensitive source code. In most cases, reducing the size of source code that can safely reproduce the problem minimizes the possibility of sending sensitive source code.

- To Reproduce: List the steps needed to reproduce the problem in detail. Refer to any attached files by their file names. With command-line examples, include the compiler options used.

- Comments: Include any comments needed.

### 11.3.2 Buttons in the User Information Dialog Box

The User Information dialog box contains the following buttons:

- **Previous:** Moves to the previous tab. This button is dimmed if the first (User) tab is displayed.

- **Next:** Moves to the next tab. This button is dimmed if the last (Comments) tab is displayed.

- **System Information:** Displays the System Information dialog box and its set of tabs. See Section 11.4, System Information Dialog Box.

  You can choose to exclude the contents of one or more System Information tabs from the mail message by checking the check box at the bottom of the appropriate System Information tab. After viewing the system information, click the User Information button to display the User Information dialog box.

- **Load:** Loads a previously saved text file. After you load a file, the current file name is displayed in the top part of the User Information dialog box.

  You are asked about saving the existing file before loading the new file. If you answer Yes, the action is the same as if you had clicked the Save button.

  You then operate exactly as if the file had just been created. Note that when you save the file, you are asked whether to overwrite the file that was read or to create a new file.

- **Save:** Creates the report that will be sent to the Visual Fortran team and also saves all the files specified in the Attach Files tab as a zip file.
The information in the User Information dialog box and the System Information dialog box is saved to an ASCII text file.

By default, the text file is saved to the following directory: Program Files\Microsoft Visual Studio\Df98\VFRPORTR\VFmail. You can specify a different directory.

The text file is similar to the online BUGREPRT.TXT file. (See Section 10.3, Guidelines for Reporting Problems.) In contrast to the BUGREPRT.TXT file, VF Reporter omits some of the extraneous instructions and appends the gathered information to the bottom of the file in ini file format.

The names and path names of the files to be mailed are displayed and the names are copied to the clipboard so that you can paste them into the appropriate fields of your mail package.

You should inspect the files to make sure that the information included is exactly what you want the Visual Fortran team to see.

It is your responsibility to assure that no sensitive information is compromised.

The Save action also writes information entered in the User tab in the User Information dialog box to the user's area in the registry.

- **E-Mail**: Implicitly clicks the Save button, which prompts you for the file name of the file. It then attempts to initiate a mail session with your MAPI-compliant mail client.

  Enter a meaningful subject for the message (such as the software component that might be causing the problem). The files are automatically attached and e-mailed to the Visual Fortran team at vf-support@compaq.com.

  If the VF Reporter cannot access your MAPI-compliant mail client, see Section 11.5, Manually E-Mailing Problem Reports.

- **Exit**: Ends the VF Reporter session.

### 11.4 System Information Dialog Box

In the User Information dialog box, you can click the System Information button to display the System Information dialog box.

The tabs in this dialog box contain information that VF Reporter has collected about your system and environment.

Any tab that contains information that you might not want to send with the report has a checkbox. If you check this box, the information in that tab will not be included in the report.

The tabs are:

- **Registration**: The Visual Fortran Registration information that was placed in the registry when the product was installed.
• **DF /What:** The information that was gathered by running the DF /What command. It contains version information and file path information.

• **Environment:** The information from the operating system's environment block. You can get this information by entering `SET` in a command prompt.

• **Autoexec.bat:** The contents of the file, if you have an Autoexec.bat file in the root of C:.

• **Config.sys:** The contents of the file, if you have a Config.sys file in the root of C:.

• **OS:** The information about the Windows operating system found in the Registry. The Windows Product ID, which is the license number, is not collected, displayed, or used in any way, to avoid any violation of license agreements.

• **Drives:** A list of physical and logical drives found on your system. The display includes the drive letter, an indicator of the drive type, the file system, volume size, and volume free space. If you have set a Temp variable in the Environment, the phrase ‘Temp points here’ is next to the drive that is being used.

• **IMSLLibs.Ini:** The contents of the file, if you have installed IMSL Library support (Professional and Enterprise Editions only).

• **DFVars.Bat:** The contents of the file. The Do not include checkbox is checked by default because the contents are quite lengthy and generally do not provide insight into problems or suggestions. However, if the contents of the DFVars.Bat file might help clarify a problem, clear the checkbox to include the file in the report.

• **Memory:** All of the memory information that is provided by the system level APIs.

• **System:** The system information found in the registry.

• **Registry (CVF):** All of the information found in the registry under the Visual Fortran heading.

• **OpenGL:** The information pertaining to the Video Graphics Library that might be important in diagnosing Array Visualizer problems.

• **Autoexec.NT:** The contents of the Autoexec.NT file, if you have one.

### 11.5 Manually E-Mailing Problem Reports

Instead of clicking the E-Mail button in the User Information dialog box, you can manually e-mail your report to Compaq. You might need to do this if your mail client is not MAPI-compliant. (See Section 11.6, Problems Mailing Files with VF Reporter.)

To e-mail your report:

1. In your e-mail software, start a new message to be sent to:

   vf-support@compaq.com
2 Enter a meaningful subject for the message (such as the software component that might be causing the problem).

3 Either attach the text file you saved (by default, it’s saved in \Program Files\Microsoft Visual Studio\Df98\VFREPORT\VFmail) or copy the contents of the file into the message.

4 Attach to the e-mail message the zip file containing the files you specified in the Attach Files tab of the User Information dialog box. (When you clicked the Save button, the files were saved as a zip file.

5 Send the message.

11.6 Problems Mailing Files with VF Reporter

VF Reporter’s ability to mail files automatically relies on the Microsoft MAPI control. The system determines the availability of a MAPI-compliant mail client by attempting to load the file \Mapi32.dll\. A failure to load that file indicates that the MAPI session will not succeed. Consequently, the E-Mail button is dimmed and a message is displayed.

If the \Mapi32.dll file is found, but subsequently there is a failure to initiate a session, a message is displayed. The E-Mail button is not dimmed, so you can retry if an incorrect ID or password caused the error.

If a problem is encountered, the name of the report file and the name of the zip file (if you attached files) are put on the clipboard so that you can simply paste the names and manually mail the files. See Section 11.5, Manually E-Mailing Problem Reports.
Glossary

A

Add-in
A dynamic-link library that lets you automate routine tasks in the Developer Studio environment. 4-2

Automation
A way to manipulate an application’s objects from outside the application. 7-12

B

Browse information file
A file used by the source code browser and containing information about the symbols in your application. 6-17

C

Component Object Model (COM)
An open architecture for cross-platform development of client-server applications, based on object-oriented technology. 7-12

Configuration
Settings for a project. The configuration specifies such things as the type of application to build, target platform, and the settings to use when building, such as compiler and linker options. 6-7

D

Debug configuration
A configuration that contains full symbolic debugging information that can be used by the debugger. Typically, no optimization or minimal optimization is used. See also Release configuration. 6-7

Debugger
A tool that helps you check the logic of an executing program and examine or change variables at runtime. 6-19

Docking window
A window that is docked (attached) along an edge of the visual development environment window and does not have a title bar. 6-6

Dynamic-link library (DLL)
A set of routines that can be called from procedures that are loaded into your application at run time. 6-3

F

Floating window
A window that can be moved and has a title bar. 6-6

L

Linker
A tool that links one or more object files into an executable. The Developer Studio linker supports incremental linking for faster builds following small changes to the set of source files. 6-2

P

Procedure interface definition
The properties of a procedure, in particular the specifications of the attributes for a function result, the specification of dummy argument attributes, and the information in the procedure heading. 7-13

Profiler
A tool for determining the execution frequency of various code paths. 6-2

Project
A set of source files required to build an application. Also see Workspace. 6-3

Project type
One of seven classifications for projects. Every Visual Fortran project must be one of these seven types. 6-3

R

Release configuration
A configuration that does not contain any symbolic debugging information. It does, however, contain default optimizations or your selected optimizations if you have overridden the defaults. See also Debug configuration. 6-7

Resource
Binary data added to an application’s executable file. Examples are dialog boxes and icons. 6-5

Resource editor
A tool to help develop user-interface components such as dialog boxes, menus, and icons for your
projects. 6-18

S

Source browser
A tool that lets you look at symbol usage in the source code and view graphs of calling relationships between functions. 6-17

Static library
A set of routines that can be called from procedures that are loaded into your application at link time. 6-3

W

Workspace
The container for one or more projects. The primary workspace file has the extension .dsw. 6-4
# Index

## Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>? (Help button)</td>
<td>6-6</td>
</tr>
</tbody>
</table>

## A

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acrobat Reader</td>
<td>8-7</td>
</tr>
<tr>
<td>ActiveX control</td>
<td></td>
</tr>
<tr>
<td>Avis2D</td>
<td>7-9</td>
</tr>
<tr>
<td>AvisGrid</td>
<td>7-9</td>
</tr>
<tr>
<td>Add-in</td>
<td></td>
</tr>
<tr>
<td>Adobe Acrobat Reader</td>
<td></td>
</tr>
<tr>
<td>Adobe Acrobat Reader, see</td>
<td></td>
</tr>
<tr>
<td>Acrobat Reader</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td></td>
</tr>
<tr>
<td>defining procedures for</td>
<td></td>
</tr>
<tr>
<td>where to find information about</td>
<td>8-9</td>
</tr>
<tr>
<td>Array Viewer</td>
<td></td>
</tr>
<tr>
<td>demo file</td>
<td>4-7</td>
</tr>
<tr>
<td>installing</td>
<td>3-10</td>
</tr>
<tr>
<td>run-time distributables package</td>
<td>4-6</td>
</tr>
<tr>
<td>starting</td>
<td>7-9</td>
</tr>
<tr>
<td>using</td>
<td>7-8</td>
</tr>
<tr>
<td>window</td>
<td>7-8</td>
</tr>
<tr>
<td>Array Visualizer</td>
<td>7-7 to 7-10</td>
</tr>
<tr>
<td>see also Array Viewer</td>
<td></td>
</tr>
<tr>
<td>and the visual development environment</td>
<td>7-9</td>
</tr>
<tr>
<td>applications</td>
<td></td>
</tr>
<tr>
<td>redistribution files for</td>
<td>4-7</td>
</tr>
<tr>
<td>Aview routines library</td>
<td>7-8</td>
</tr>
<tr>
<td>Avis2D and AvisGrid ActiveX (OCX) controls</td>
<td>7-9</td>
</tr>
<tr>
<td>documentation</td>
<td>8-5</td>
</tr>
<tr>
<td>information about</td>
<td>7-10</td>
</tr>
<tr>
<td>installing</td>
<td>3-12</td>
</tr>
<tr>
<td>new features</td>
<td>8-8</td>
</tr>
<tr>
<td>program folder, contents of</td>
<td>3-18</td>
</tr>
<tr>
<td>release notes</td>
<td>7-10</td>
</tr>
<tr>
<td>removing</td>
<td>4-12</td>
</tr>
<tr>
<td>sample programs</td>
<td>7-9</td>
</tr>
<tr>
<td>Array Visualizer Kit Location dialog box</td>
<td>3-12</td>
</tr>
<tr>
<td>AUT0EXEC.BAT file</td>
<td>3-9, 4-13</td>
</tr>
<tr>
<td>Automation (OLE Automation) objects, support for</td>
<td>7-12</td>
</tr>
<tr>
<td>Automation, see OLE Automation</td>
<td></td>
</tr>
<tr>
<td>Aview routines library</td>
<td>7-8</td>
</tr>
<tr>
<td>AVIEWnnnn.DLL file</td>
<td>4-7</td>
</tr>
<tr>
<td>Avis2D ActiveX control</td>
<td>7-9</td>
</tr>
<tr>
<td>Avis2D.OCX file</td>
<td>4-7</td>
</tr>
<tr>
<td>AvisGrid ActiveX control</td>
<td>7-9</td>
</tr>
<tr>
<td>AvisGrid.OCX file</td>
<td>4-7</td>
</tr>
</tbody>
</table>

## B

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Linear Algebra, see</td>
<td></td>
</tr>
<tr>
<td>BLAS routines</td>
<td>7-4</td>
</tr>
<tr>
<td>Bookmarks in the HTML Help Viewer</td>
<td>9-8</td>
</tr>
<tr>
<td>Bookstore, online</td>
<td>8-2</td>
</tr>
<tr>
<td>Browse information file</td>
<td>6-17</td>
</tr>
<tr>
<td>Browse window</td>
<td>6-18</td>
</tr>
<tr>
<td>Browser, source</td>
<td>6-17</td>
</tr>
<tr>
<td>BUGREFRT.TXT file</td>
<td>10-3, 11-5</td>
</tr>
</tbody>
</table>

## C

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calling routine</td>
<td>7-13</td>
</tr>
<tr>
<td>Canaima Software</td>
<td>4-15, 7-11</td>
</tr>
<tr>
<td>CD-ROM</td>
<td></td>
</tr>
<tr>
<td>running Visual Fortran from</td>
<td>3-15</td>
</tr>
<tr>
<td>CD-ROM drive requirements</td>
<td>2-2</td>
</tr>
<tr>
<td>CD-ROMs</td>
<td></td>
</tr>
<tr>
<td>for Enterprise Edition</td>
<td>1-5</td>
</tr>
<tr>
<td>for Professional Edition</td>
<td>1-5</td>
</tr>
<tr>
<td>for Standard Edition</td>
<td>1-4</td>
</tr>
<tr>
<td>Celsius project</td>
<td></td>
</tr>
<tr>
<td>building</td>
<td>6-7</td>
</tr>
<tr>
<td>Celsius.dsw file</td>
<td>6-7</td>
</tr>
<tr>
<td>Choose Destination Path dialog box</td>
<td>3-11</td>
</tr>
<tr>
<td>for Array Viewer</td>
<td></td>
</tr>
<tr>
<td>ClassView tab</td>
<td>6-5</td>
</tr>
<tr>
<td>Collection</td>
<td>9-8</td>
</tr>
<tr>
<td>changing the current</td>
<td>9-8</td>
</tr>
<tr>
<td>COM</td>
<td></td>
</tr>
<tr>
<td>objects, support for</td>
<td>7-12</td>
</tr>
<tr>
<td>server wizard</td>
<td>7-13</td>
</tr>
<tr>
<td>server wizard, specifying as an add-in</td>
<td>4-2</td>
</tr>
<tr>
<td>server, creating</td>
<td>7-13</td>
</tr>
<tr>
<td>Command-line interface</td>
<td>7-4</td>
</tr>
<tr>
<td>Compaq Array Viewer</td>
<td></td>
</tr>
<tr>
<td>Compaq Array Viewer, see</td>
<td></td>
</tr>
<tr>
<td>Array Viewer</td>
<td></td>
</tr>
<tr>
<td>Compaq Array Visualizer</td>
<td></td>
</tr>
<tr>
<td>Compaq Array Visualizer, see</td>
<td></td>
</tr>
<tr>
<td>Array Viewer</td>
<td></td>
</tr>
<tr>
<td>Compaq Extended Math Library Reference Guide manual</td>
<td>8-7</td>
</tr>
<tr>
<td>Compaq Extended Math Library</td>
<td></td>
</tr>
<tr>
<td>see CXML</td>
<td></td>
</tr>
<tr>
<td>Compaq Fortran language</td>
<td>7-3</td>
</tr>
<tr>
<td>Compaq Fortran Language Reference Manual manual</td>
<td>8-1</td>
</tr>
<tr>
<td>Compaq Fortran Online Bookstore</td>
<td>8-2</td>
</tr>
<tr>
<td>Compaq Fortran Web site</td>
<td>1-x</td>
</tr>
<tr>
<td>Compaq message board</td>
<td>10-2</td>
</tr>
<tr>
<td>Compaq Visual Fortran Installing and Getting Started manual</td>
<td>8-7</td>
</tr>
<tr>
<td>compaq.exe file</td>
<td>5-2</td>
</tr>
<tr>
<td>Compiling</td>
<td></td>
</tr>
<tr>
<td>where to find information about</td>
<td>8-9</td>
</tr>
</tbody>
</table>
Component Object Model, see COM Components, software
for Visual Fortran, 1-1 to 1-4 Concurrent-use license, 5-1 to 5-6 Contents tab
in the HTML Help Viewer, 9-4 Context-sensitive help
using F1 to get, 9-5 Copying project files, 4-3 Current collection, see Collection Custom installation option, 3-7 Custom Options Selection dialog box
for Visual Fortran, 3-7 Customizing
visual development environment, 6-15 Cvf_gs.pdf file, 8-7 CVF-Network-License-Server.exe file, 5-2 CXML, 7-4 to 7-5 Sample programs, 7-5 Cxmlref.pdf file, 8-7

D Data arrays
guidelines for programs, 4-9 Debugger
clearing a breakpoint, 6-12
displaying a value in the Watch window, 6-12
displaying Local Variables window, 6-12
displaying Watch window, 6-12
setting a breakpoint, 6-12
starting, 6-10
using, 6-19
using Step Over with, 6-11
Defining procedures for an application
where to find information about, 8-9
Deinstalling
Array Visualizer, 4-12
Internet Explorer, 4-12
Visual Fortran Version 5, 4-10
Visual Fortran Version 6, 4-9
DeIsLn.isu files, 4-11 Demo file
for Array Viewer, 4-7 Dependency Walker, 3-16
Destination directories
specifying, 3-7
Developer Studio, see Visual development environment
DF command, 7-4
DFDLG100.DLL file, 4-6
DFORMD.DLL file, 4-6
DFORRT.DLL file, 4-6
DFVars.bat file, 3-9, 7-4
Dialog box
Array Visualizer Kit Location, 3-12
Choose Destination Path, 3-11
Custom Options Selection, 3-7
Environment Variable Update, 3-9
FLEXlm License Finder, 5-5
License Terms, 3-4, 3-11, 3-12
New Project Type, 6-13
Registration, 3-4, 3-12
Registration Confirmation, 3-5, 3-12
Restart Windows, 3-11
Select Folder, 3-8, 3-11, 3-13
Setup Complete, 3-11, 3-14
Setup Install Type, 3-4, 3-5, 3-12
System Information, 11-5
User Information, 11-2, 11-3
using the dialog editor to create, 6-18
Welcome, 3-11, 3-12
Dialog editor, 6-18
Disk space
required, 2-2
Docking View menu option, 6-6
Docking window, 6-6
Documentation
and the HTML Help Viewer, 9-1 to 9-12
for Array Visualizer, 8-5
for Enterprise Edition, 8-5
for new features, 8-8
hardcopy, 8-1
in HTML format, 8-6
in HTML Help Viewer format, 8-2
in PDF format, 8-6
Platform SDK, 8-5
printed manuals, 8-1
road map, 8-1 to 8-10
SDK, 8-5
WinHelp, 8-8
Dual-boot system, 3-11
Dynamic-link libraries (DLLs)
redistributing, 4-7

E E-mailing
Compaq, 1-xi
problem reports, 11-6
enduser.pdf file, 5-2, 8-8
Enterprise Edition, 7-12
additional components in, 1-2, 1-3
additional documentation, 8-5
CD-ROMs for, 1-5
components in, 1-1
Enterprise Toolkit, 7-12
installing, 3-14
Environment variable definitions
checking for and removing, 4-13
Environment Variable Update dialog box, 3-9
Error Lookup, 3-16
Error Messages manual, 8-5
Excel, 2-4

F
F1, using to get context-sensitive help, 9-5
F6, using to change focus, 9-3
f90SQL-lite
   installing, 4-15
   using, 7-11
f90SQL-pro, 7-11
FAQ, 10-2
Favorites tab
   in the HTML Help Viewer, 9-8
FileView tab, 6-5
FL32, 7-4
FLEXlm End Users Manual, 5-2
FLEXlm License Finder dialog box, 5-5
FLEXlm software license manager, 5-1
   configuring, 5-3
   documentation, 8-8
   how it works, 5-6
   installing, 5-2
Floating window, 6-6
FORTRAN 66 standard, 7-3
FORTRAN 77 standard, 7-3
Fortran 90 standard, 7-3
Fortran 95 standard, 7-3
Fortran COM Server project, 6-3
Fortran Command Prompt, 3-16
Fortran Console application, 6-4
   converting to Fortran QuickWin application, 6-4
Fortran Dynamic-Link Library application, 6-3
FORTRAN IV (FORTRAN 66) standard, 7-3
Fortran Module Wizard, 3-16, 7-12
Fortran QuickWin application, 6-4
Fortran Standard Graphics application, 6-4
   converting to Fortran QuickWin application, 6-4
Fortran Static Library application, 6-3
Fortran Windows application, 6-4
FQWIN.HLP file, 4-6
Frequently Asked Questions, see FAQ

G
GLOBEtrotter, Inc., 5-1

H
Hard disk space
   required, 2-2
Hardcopy documentation, 8-1
Help button, 6-6
Help Viewer, see HTML Help Viewer
Help Workshop, 3-17
Highlights, product, 7-1 to 7-14
HLP files, 3-17
Host ID in FLEXlm software license manager, 5-3
HostID box, 5-2
HP-UX operating system, 7-12
HTML documentation, 8-6
HTML Help Viewer, 9-1 to 9-12
   additional features, 9-10
   changing the current collection
   context-sensitive help, 9-5
   defining and using subsets, 9-9
   displaying, 9-3
   documentation available with, 8-2
   navigating by jumping, 9-5
   overview, 9-1
   problems displaying information, 9-11
   search syntax, 9-7
   toolbar, 9-2
   using F1, 9-5
   using the Contents tab, 9-4
   using the Favorites tab, 9-8
   using the Index tab, 9-6
   using the Search tab, 9-6
   viewing online documentation in, 7-7
   window, 9-1

I
IMSL
   contents file, 8-7
   documentation in PDF format, 8-7
   error handler library, 7-10
   Fortran 90 MP libraries, 7-10
   information about, 7-11
   static library, 7-10
   stub library for MPI routines, 7-10
IMSL Fortran 90 MP Library manual, 8-7
   IMSL library, 7-10
IMSL Math/Library, Special Functions manual, 8-7
IMSL Math/Library, Volume 2 manual, 8-7
IMSL Math/Library, Volumes 1 and 2 manual, 8-7
IMSL Stat/Library, Volume 1 manual, 8-7
Imsl.pdf file, 8-7
IMSL_ERR library, 7-10
IMSLMPISTUB library, 7-10
Include paths
   updating, 4-15
   INCLUDE variable, 4-14
   Increasing stack size, 4-9
   Index tab
in the HTML Help Viewer, 9-6
Installation
starting, 3-1
Installation number see Registration number
Installation option
Custom, 3-7
Run From CD-ROM, 3-7
Typical, 3-6
Installation options
changing, 4-3
for Array Visualizer, 3-13
specifying, 3-6
Installing
Array Viewer, 3-10
Array Visualizer, 3-12
Enterprise Toolkit, 3-14
f90SQL-lite, 4-15
FLEXlm software license manager, 5-2
Internet Explorer, 3-10
Service Pack 3, 3-9
service update kit, 4-9
Technical Programming Extensions, 3-14
Visual Fortran, 3-1 to 3-18
prerequisites, 2-1 to 2-8
steps for, 3-4
Visual Fortran service update kit, 4-9
with Visual Fortran Version 5, 2-6
with Visual Fortran Version 6.0 or 6.1, 2-6
with Visual Studio products, 2-4
Interface definition, 7-13
Internet Explorer, installing, 3-10

J
Jumping in the HTML Help Viewer, 9-5

K
KAP optimization settings, 7-12
Keyboard shortcuts, 6-16
Knowledge Base, 10-2

L
Language Reference manual, 8-4
LAPACK routines, 7-5
LIB variable, 4-14
Library path updating, 4-15
License
concurrent-use, 5-1 to 5-6
multiple-user, 2-7
License key file, 5-2
License manager software, see FLEXLM software license manager
License number, 2-3
License Terms dialog box
for Array Viewer, 3-11
for Array Visualizer, 3-12
for Visual Fortran, 3-4
LINK_F90 variable, 4-14
Linker, 6-2
Linking
where to find information about, 8-9
Linux operating system, 7-12
lmgrd.exe file, 5-2
lmtools.exe file, 5-2
lmutil.exe file, 5-2

M
MAPI e-mail support, 11-1
Mapix32.dll file, 11-7
Master Setup window
activating, 3-2
using to install Visual Fortran, 3-3
Math.pdf file, 8-7
Memory requirements for installing Visual Fortran, 2-2
Message board, 10-2
Microsoft Excel, 2-4
Microsoft MASM (Assembler for x86 systems), 7-6
Microsoft Visual SourceSafe, 2-4
Mixed-language programming, 7-6
Monitor requirement, 2-2
MPI routines library, 7-10
MS-DOS window, 7-4
Multiple-user license considerations, 2-7

N
New features documentation, 8-8
New Project Type dialog box, 6-13
Newsletter for Visual Fortran, 10-2
NMAKE, 7-4

O
OCX control, see ActiveX control
OCX files
and redistribution, 4-7
OLE Automation
and Array Viewer, 7-8
and Fortran Module Wizard, 7-12
OLE-COM Object Viewer, 3-17
Online Bookstore, 8-2
Online documentation
see also HTML Help Viewer
viewing in HTML Help Viewer, 7-7
Online help
getting in the visual development environment, 6-6
Online Registration, 3-17
OpenGL, 7-7
Optional software, 2-4

**P**

Packaging for Visual Fortran, 1-4 to 1-5
Path variable, 4-14
PDF documentation, 8-6
  Array Visualizer HTML help files, 8-6
  Compaq Extended Math Library Reference Guide manual, 8-7
  Compaq Visual Fortran Installing and Getting Started manual, 8-7
  FLEXlm End Users Manual manual, 8-8
  for IMSL, 8-7
  Visual Fortran HTML help files, 8-6
PDF files
  viewing, 8-7
Per-User Setup, 3-17
Per-user setup option, applying, 4-1
Platform SDK documentation, 8-5
Porting Assistant, 7-12
Postinstallation tasks, 4-1 to 4-15
Prerequisites
  for installing Visual Fortran, 2-1 to 2-8
Printed manuals, 8-1
Problem reports
  manually e-mailing, 11-6
Problems
  displaying HTML Help Viewer information, 9-11
  reporting guidelines for, 10-2
Procedure interface definition, 7-13
Process Viewer, 3-17
Product highlights, 7-1 to 7-14
Professional Edition
  additional components in, 1-2
  CD-ROMs for, 1-5
  components in, 1-1
Profiler, 6-2
Program folder
  Array Visualizer, 3-18
  Visual Fortran, 3-16
Programmer’s Guide manual, 8-3
Project, 6-3
  adding files to, 6-15
  building, 6-7
  configuration, 6-7
  creating a new, 6-13
  files, copying, 4-3
  information about, 6-15
  settings, 6-7
  types, 6-3
  workspace, 6-4
Project type
  Fortran COM Server, 6-3
  Fortran Console, 6-4
  Fortran Dynamic-Link Library application, 6-3
  Fortran QuickWin application, 6-4
  Fortran Standard Graphics, 6-4
  Fortran Static Library application, 6-3
  Fortran Windows, 6-4

**R**

Read Me, 3-17
Readme file
  for CXML, 7-5
  for IMSL, 3-17
  for VF Reporter, 11-1
  for Visual Fortran, 3-4, 3-17
Redistributing
  dynamic-link libraries (DLLs), 4-7
  files, 4-4 to 4-8
  manually, 4-8
Redistribution files for Array Visualizer applications, 4-7
Redistribution folders, files in, 4-6
Registering Visual Fortran with Compaq, 3-15
Registration Confirmation dialog box
  for Array Visualizer, 3-12
  for Visual Fortran, 3-5
  Registration dialog box, 3-4
  for Array Visualizer, 3-12
Registration information
  updating, 3-15
Registration number, 2-3
REGSVR32 utility, 4-8
Reinstalling
  Visual Fortran, 4-3
Release notes for Array Visualizer, 7-10
Release notes for Visual Fortran, 2-3
Removing
  Array Visualizer, 4-12
  environment variable definitions, 4-13
  Internet Explorer, 4-12
  VF Reporter, 11-1
  Visual Fortran Version 5, 4-10
  Visual Fortran Version 6, 4-9
Reporter, see VF Reporter
Reporting problems
  guidelines for, 10-2
Requirements for running Visual Fortran, 2-1
Resource editor
  dialog, 6-18
Resource editors, using, 6-18
ResourceView tab, 6-5
Restart Windows dialog box, 3-11
Road map to the documentation, see Documentation, road map
Run From CD-ROM installation option, 3-7
Running Visual Fortran from CD-ROM, 3-15
Run-time redistributables kit for Visual Fortran, 4-5
Run-time redistributables package for Array Viewer, 4-6

S
Sample programs, 7-1 to 7-2
  Array Visualizer, 7-9
  CXML, 7-5
  folders, 7-2
Samples.html file, 7-2
SDK documentation, 8-5
Search syntax, 9-7
  using wildcards, 9-7
Search tab
  in the HTML Help Viewer, 9-6
Searching to locate topics, 9-6
Select Folder dialog box
  for Array Viewer, 3-11
  for Array Visualizer, 3-13
  for Visual Fortran, 3-8
Service Pack 3, installing, 3-9
Service update kit
  installing, 4-9
Setup Complete dialog box
  for Array Viewer, 3-11
  for Array Visualizer, 3-14
Setup Install Type dialog box
  for Array Visualizer, 3-12
  for Visual Fortran, 3-4, 3-5
Sfun.pdf file, 8-7
Shortcuts
  keyboard, 6-16
Signal Processing routines, 7-5
Software components for Visual Fortran, 1-1 to 1-4
Software Product Description (SPD), 1-4
Solaris operating system, 7-12
Source browser, using, 6-17
Sparse Linear System routines, 7-5
SPLINE mixed-language sample program, 6-4
Spy++, 3-17
Stack size, increasing, 4-9
Standard
  FORTRAN 66, 7-3
  Fortran 90, 7-3
  Fortran 95, 7-3
  FORTRAN IV (FORTRAN 66), 7-3
Standard Edition
  CD-ROMs for, 1-4
  components in, 1-1
upgrading from, 2-4
Starting
  Array Viewer, 7-9
  Visual Fortran, 6-3
Statvol1.pdf file, 8-7
Statvol2.pdf file, 8-7
Subset
  defining in the HTML Help Viewer, 9-9
Support, technical, 10-1 to 10-3
  e-mail support, 10-1
  FAQ, 10-2
  guidelines for reporting problems, 10-2
  Knowledge Base, 10-2
  newsletter, 10-2
  overview, 10-1
  paid consulting support, 10-2
  types of, 10-1
  user-to-user support, 10-2
System Information dialog box, 11-5
System requirements, 2-1
System requirements for Visual Fortran, 2-1 to ??

T
Tasks, postinstallation, 4-1 to 4-15
Technical Programming Extensions, see TPE
Technical support, see Support, technical
Text editor, using, 6-16
TPE, 7-12
  installing, 3-14
Tru64 UNIX operating system documentation, 8-5
Typical installation option, 3-6

U
uninst command, 4-11
Upgrading
  from Standard Edition, 2-4
USE statement, 7-13
USE statement, 7-14
User Information dialog box, 11-2, 11-3
  buttons in, 11-4
  tabs in, 11-3
Utility routines
  for CXML, 7-5

V
VF Reporter, 11-1 to 11-7
  overview, 11-1
  problems mailing files, 11-7
Readme file, 11-1
System Information dialog box, 11-5
User Information dialog box, 11-3
VFmail directory, 11-5
VFREPORT directory, 11-1
VFRUN, 4-5
VGA monitor
  requirement, 2-2
Viewing
  PDF files, 8-7
Visual Basic
  and mixed-language programming, 7-6
Visual C++
  and mixed-language programming, 7-6
  installing after Visual Fortran, 4-15
Visual development environment
  customizing, 6-15
  docking window, 6-6
  floating window, 6-6
  getting online help, 6-6
  starting Visual Fortran from, 6-3
  using
    where to find information about, 8-9
    windows, 6-4 to 6-6
Visual Fortran
  Enterprise Edition, 7-12
  installing, 3-1 to 3-18
  new features, 8-8
  packaging, 1-4 to 1-5
  product highlights, 7-1 to 7-14
  program folder, contents of, 3-16
  projects, 6-3
  release notes, 2-3
  sample programs, 7-1 to 7-2
  Software Product Description (SPD), 1-4
  starting, 6-3
  system requirements, 2-1 to ??
  using, 6-1 to 6-19
Visual Fortran Master Setup window
  activating, 3-2
  using to install Visual Fortran, 3-3
Visual Fortran Reporter, see VF Reporter
Visual Fortran Version 5
  installing Visual Fortran with, 2-6
Visual Fortran Version 6.0 or 6.1
  installing with, 2-6
Visual Fortran, reinstalling, 4-3
Visual J++, 7-6
Visual Numerics, 7-11
Visual SourceSafe, 2-4
Visual Studio
  tools, 7-6
  installing Visual Fortran with, 2-4
Visual Studio tools, 7-6
VNI_F90_MSG variable, 4-14
VR Reporter
  starting, 11-2

W
Watch window, 7-9
Web site
  Adobe Systems, 8-7
  Canaima Software, 7-12
  Compaq Fortran, 1-x
  Compaq Math Libraries, 7-5
  for Visual Fortran registration, 3-15
  Microsoft Excel, 2-4
  Microsoft Visual Studio, 7-6
  Visual Numerics, 7-11
  Visual SourceSafe, 2-4
  Visual Studio, 7-6
Welcome dialog box
  for Array Viewer, 3-11
  for Array Visualizer, 3-12
Wildcards
  using with search syntax, 9-7
WinDiff, 3-18
Window
  see also Dialog box
  Array Viewer, 7-8
  browse, 6-18
  command-line, 7-4
  Developer Studio, 6-4
  docking, 6-6
  establishing a layout for, 6-16
  floating, 6-6
  HTML Help Viewer, 9-1
  MS-DOS, 7-4
text editor, 6-16
  visual development environment, 6-4
  Visual Fortran Master Setup
    activating, 3-2
  Visual Fortran Master Setup
    using, 3-3
  Watch, 7-9
Windows 2000 systems
  removing environment variable definitions, 4-13
Windows 95 systems
  removing environment variable definitions, 4-13
Windows 98 systems
  removing environment variable definitions, 4-13
Windows Me systems
  removing environment variable definitions, 4-14
Windows NT 4 systems
  removing environment variable definitions, 4-13
WinHelp, 3-17
  Array Viewer documentation, 7-10
  WinHelp documentation, 8-8
Wizard
  COM server, 7-13
  Fortran Module, see Fortran Module Wizard
Workspace, 6-4

Index-7